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About This Guide

This documentation provides information about PlateSpin® Recon.

¢ Chapter 1, “Introduction,” on page 13

¢ Chapter 2, “Overview of PlateSpin Recon Client Views,” on page 23
¢ Chapter 3, “Working with Data Center Explorer,” on page 29

¢ Chapter 4, “PlateSpin Recon Server and Client Tools,” on page 73

¢ Chapter 5, “Generating and Viewing Charts and Reports,” on page 79
¢ Chapter 6, “Server Consolidation,” on page 111

¢ Chapter 7, “IT Chargeback,” on page 145

¢ Chapter 8, “Virtual Infrastructure Management,” on page 155

¢ Appendix A, “Troubleshooting,” on page 159

¢ Appendix B, “Technical Reference,” on page 165

¢ Appendix C, “Schedule Options,” on page 185

+ Appendix D, “Quick Reference to PlateSpin Icons and Commands,” on page 187
+ Appendix E, “Best Practices,” on page 193

¢ Appendix F, “Documentation Updates,” on page 195

Audience

This text is intended for IT staff, such as data center administrators and operators, who use PlateSpin
Recon in the management and planning of the data center.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please take a moment to provide your comments at the Novell
Documentation Web site (http://www.novell.com/documentation/feedback).

Additional Documentation
In addition to this guide, PlateSpin Recon comes with the following documentation:

¢ PlateSpin Recon Getting Started Guide
¢ An online version of the PlateSpin Recon User Guide integrated with the product

* Release Notes

For help with third-party vendor products or documentation, please contact your sales or support
representative for those products.

Documentation Updates

For the most current version of the PlateSpin Recon 3.7 documentation, see the Novell PlateSpin
Recon 3.7 documentation Web site (http://www.novell.com/documentation/ps_recon37/).
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Technical Support
Contact Technical Support by:

¢ Telephone (North America): +1 800 858 4000. This is a toll-free number.
¢ Telephone (global): +1 416 203 4799. This is not a toll-free number.
¢ E-mail: support@platespin.com

You can also visit the PlateSpin Technical Support Web site (http://www.platespin.com/support/) or
Novell Customer Center Web site (http://www.novell.com/center/eservice).

User Forum

You can also visit the user forum (http://forums.novell.com/novell-product-support-forums/
platespin/).

Documentation Conventions

In PlateSpin documentation, a greater-than symbol (>) is used to separate actions within a step and
items in a cross-reference path.

A trademark symbol (®, ™ etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party
trademark.
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Introduction

Novell® PlateSpin® Recon provides intelligence, visual analysis, and forecasting for consolidating
and optimizing the data center. It collects hardware, software, and service inventory data for server
workloads. PlateSpin Recon can remotely gather workload utilization statistics for a clear and
concise picture of the application services running in the data center, and to determine how
resources are being used.

The PlateSpin Recon Consolidation Planning module determines the optimal fit between server
resource supply and workload demand. It helps you visualize the characteristics of server workloads
before and after consolidation, determine the servers required for consolidation, and expedite
projects by automatically generating consolidation plans. You can also protect servers by allocating
them to a suitable virtual recovery environment in case of a service outage.

PlateSpin Recon includes other features such as Virtual Infrastructure Management capabilities, as
well as a resource utilization-based IT chargeback system. These can be used to help cope with the
challenges presented by the virtualization and consolidation of the data center.

¢ Section 1.1, “Recon Features,” on page 13

*

Section 1.2, “Planning Module Features,” on page 14

*

Section 1.3, “Supported Platforms,” on page 14

*

Section 1.4, “Application Scenario,” on page 18

*

Section 1.5, “PlateSpin Recon Terminology,” on page 21

1.1 Recon Features

Remote Data Collection: PlateSpin Recon does not require the installation of agent software,
eliminating the need to physically touch data center servers. All performance and inventory data is
collected via standard OS instrumentation capabilities.

Rich Data Modeling: Helps you make consolidation choices based on sophisticated analysis of
resources, workloads, and utilization trends. Tight integration with VMware* VirtualCenter*
provides greater visibility into virtual infrastructures, thereby improving data center management
and operations.

Custom Report Creation and Delivery: Helps you define resource and workload parameters and
generate custom visual reports for data center assessments and server consolidations. You can
quickly identify consolidation candidates based on resource utilization trends, and compare
workload characteristics before and after consolidation. Scheduled report delivery via e-mail or FTP
ensures easy access to remote data and provides up-to-date information.

Flexible Data Capture and Export: You can export PlateSpin Recon data to a number of formats,
including HTML, PDF, Word, CSV, Excel, or images. Raw data can be extracted directly from the
database and delivered to business intelligence applications for advanced statistical analysis.

Enterprise-Level Scalability: Each instance of PlateSpin Recon can monitor up to 1,500 servers to
ensure enterprise scalability for the world’s largest data centers. Data can be aggregated from
multiple PlateSpin Recon data collectors for centralized data warehousing, analysis, and planning,
or to accommodate larger enterprise implementations.

Introduction
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Multiple-Data Center Support: You can use PlateSpin Recon in different geographical locations
to remotely collect data and provide scheduled updates to a master PlateSpin Recon installation.
This allows for centralized analysis and planning for initiatives such as server or data center
consolidation.

Flexible Chargeback Reporting: Because virtualization creates a shared pool of computing
resources, it can be difficult to manage and monitor virtual resource usage. PlateSpin Recon enables
organizations to effectively allocate and share virtual resources across business units and
departmental owners. Flexible chargeback reporting capabilities improve virtual infrastructure
management and financial accounting by allowing organizations to accurately calculate IT costs
based on actual resource usage.

VM Growth Reporting: You can generate reports to monitor the proliferation of virtual machines
and avoid the administrative headaches associated with virtual infrastructure sprawl.

1.2 Planning Module Features

Planning: You can automatically generate server consolidation and disaster recovery plans based on
detailed workload analysis to ensure the optimal fit between server workloads and virtual resources.
Use forecasted data to plan for and accommodate future growth.

Workload Analysis: The PlateSpin Recon Planning Module automatically analyzes five critical
workload dimensions—processor, memory, disk space, disk 1/0, and network I/O—simultaneously
across thousands of servers, providing consolidation plans that maximize utilization while
minimizing resource contention.

Scenario Modeling: You can use custom scenarios with user-defined target server specifications,
including server templates or existing virtual machine servers to create an optimal consolidation
plan.

Power and Cooling Analysis: You can compare and contrast potential power and cooling cost
savings and ROI derived from different consolidation scenarios. Custom fields (maintained in a
central database) let you input power and cooling requirements for major hardware platforms. This
feature lets organizations analyze and cost-justify green computing initiatives.

Time-Based Analysis: You can stagger multiple workloads evenly across virtual hosts and account
for hourly peaks and valleys inherent in server utilization trends.

Workload and Utilization Forecasting: You can predict future workloads and resource utilization
based on historical trends to better plan for server consolidation and infrastructure growth, as well as
enable more proactive systems management. Forecasting data on CPU, disk, memory, and usage
trends is presented in easy-to-read charts, reports, and plans.

1.3 Supported Platforms

¢ Section 1.3.1, “Supported Inventory and Data Collection,” on page 15

¢ Section 1.3.2, “Supported PlateSpin Portability Suite Consolidation Sources and Targets,” on
page 17

NOTE: For information on PlateSpin Recon Client/Server supported platforms, see “System
Requirements” in the PlateSpin Recon 3.7.1 Getting Started Guide.
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1.3.1 Supported Inventory and Data Collection

PlateSpin Recon supports discovery, inventory, and data collection (monitoring) for the following

operating system families: Microsoft* Windows*, UNIX*/Linux* and Novell Netware®.

+ “Supported Microsoft Windows Platforms” on page 15
+ “Supported UNIX/Linux Platforms” on page 15

+ “Supported Novell NetWare Platforms” on page 16

+ “Supported Hypervisors” on page 16

Supported Microsoft Windows Platforms

Table 1-1 Supported Windows Platforms

Version Bit Spec
Windows Server 2000 (SP0, SP1, SP2, SP3, SP4) 32-bit
Windows Server 2003 (SP0, SP1, SP2) 32-bit, 64-bit
Windows Server 2008 (SP1) 32-bit, 64-bit
Windows Vista* (SPO, SP1) 32-bit, 64-bit
Windows NT* 4.0 Server (SP4, SP6) 32-bit
Windows NT 4.0 Server (SP6a - WMI Core version 1.5 required) 32-bit
Windows XP Professional (SP0O, SP1, SP2, SP3) 32-bit, 64-bit
PlateSpin Recon supports the following localized versions of Windows:

+ French

¢ German

¢ Japanese
Supported UNIX/Linux Platforms
Table 1-2 Supported UNIX/Linux Platforms
Version Bit Spec
Fedora* Core 3,4, 5,6,7,8,9, 10 32-bit, 64-bit
Novell SUSE® Linux Enterprise Server (SLES) 8.0, 9.x, 10.0, 10 SP1 (10.1), 10 SP2 32-bit, 64-bit
(10.2), 11
Novell SUSE Linux 8.0 32-bit
Novell OpenSUSE 10.1, 10.2, 10.3, 11, 11.1 32-bit, 64-bit
RedHat* Linux 7.3, 8.0, 9.0, 9.1, 9.2 32-bit, 64-bit
RedHat Enterprise Linux 2.x AS/ES 32-bit

Introduction
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Version Bit Spec
RedHat Enterprise Linux 3.0 AS/ES, 4.0 AS/ES, 5.0 AS/ES, 5.1 AS/ES 32-bit, 64-bit
Ubuntu* 7.1, 8.04, 8.10 32-bit, 64-bit
CentOS* 2.0 32-bit
Cent0S 3.9,4.6,5.1,5.2 32-bit, 64-bit
Sun* Solaris* 8, 9, 10 (SPARC*/x86) 32-bit, 64-bit
Sun Solaris 7 (SPARC) 32-bit

IBM* AIX*5.2,5.3, 6.1 32-bit, 64-bit
Supported Novell NetWare Platforms

Table 1-3 Supported Novell NetWare Platforms

Version Bit Spec
Novell NetWare 5.1 (SP8) 32-bit, 64-bit
Novell NetWare 6.0 (SP5) 32-bit, 64-bit
Novell NetWare 6.5 (SP6) 32-bit, 64-bit

IMPORTANT: Download and install the following Novell Clients on the PlateSpin Recon server
computer to enable monitoring of NetWare computers. The client downloads are free. When
installing, select Custom Installation and install the Novell Modular Authentication Service

(NMAYS) client.

¢ Novell Client 4.91 SP5 (http://download.novell.com/Download?buildid=qmMAW SRy5q4~)

¢ Novell Client 4.91 Post-SP5 NWFS.SYS (http://download.novell.com/

Download?buildid=m7NbjoMFSxU&donotredirect=true)

Installation of the Novell Client™ impacts the standard Windows logon. See the Novell Client

documentation for more information.

Only the CPU and disk utilization counters are supported for Netware 5.1 and 6.0. Only the CPU,

Disk and memory utilization counters are supported for Netware 6.5 and higher.

Supported Hypervisors

Table 1-4 Supported Hypervisors

Version Bit Spec
Citrix* XenServer* 4.1, 5.0 32-bit, 64-bit
Windows Server 2008 Hyper-V 64-bit

Sun Solaris 10 Zones on Sun Solaris 10 Container 32-bit, 64-bit
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Version Bit Spec

VMware ESX* Server 2.5.3, 2.5.4,2.5.5, 3.0.0, 3.0.1, 3.0.2, 3.0.3, 3.5.0, 3i, 4.0, 4i 32-bit, 64-bit
VMware GSX* Server 3.2 (for Windows) 32-bit, 64-bit
VMware 1.x+ (for Windows) 32-bit, 64-bit

Virtual Server 2005* (version 1.0) All editions.

Virtual Server 2005 R2 (SP1)

VMware Virtual Center 2.0.1, 2.0.2, 2.5, 4

Xen on Novell SLES 10.0, 11 32-bit, 64-bit

1.3.2 Supported PlateSpin Portability Suite Consolidation
Sources and Targets

Consolidation scenarios for workloads with the supported operating systems and targets can be
implemented by using PlateSpin Portability Suite. For detailed information about the Portability
Suite supported source and target operating systems, see the PlateSpin Portability Suite
documentation Web site (http://www.novell.com/documentation/platespin_portabilitysuite 810/).

For more detailed information about source and target operating systems for PlateSpin Portability
Suite conversions, see Knowledge Base article Q20002 (http://support.platespin.com/kb2/
article.aspx?id=20002).

For more information about implementing consolidation scenarios with portability suite, see
Section 6.8, “Implementing Scenarios with Portability Suite,” on page 141.
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1.4 Application Scenario

PlateSpin Recon and PlateSpin Portability Suite combine to form the only suite that automates the
entire capacity planning and server consolidation project from start to finish. The following table
illustrates how to assess, design, and implement a solution for optimizing and consolidating the data
center.

Table 1-5 Data Center Optimization and Consolidation Workflow

Action Process Description Solution

Assess 1. Inventory + Remotely discover server  PlateSpin Recon: Remotely and
hardware and software agentlessly identify server
assets across the data resources and workloads in the
center data center and create a

complete picture of hardware
and software inventory,
utilization levels, and workload
sizes

+ Gather detailed information
for each server such as
operating system, installed
and running applications or
services, patch levels,
CPU, memory, network
and disk resources

¢ Connect to the network,
then select relevant
computers or domains;
data on hardware and
resources is collected in a
centralized database

+ Organize servers by
predefined and user-
defined groupings for
organized analysis
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Action

Process

Description

Solution

Assess

2. Collect

*

Identify workloads and
collect utilization data over
days, weeks or months to
determine workload sizes
and appropriate resource
matching

Create dynamic reports to
identify workload and
resource mismatches and
identify candidate
workloads for consolidation
or resource upgrading

Rank and sort server
workloads by CPU,
network, disk, memory
inventory, and/or
performance

View summary workload
sizing data or drill down to
point-in-time granular
levels

Collect and analyze data
from multiple sites to
create a more complete
picture of the data center

Export the data to third-
party tools or copy visual
graphs to business
presentations

PlateSpin Recon: Remotely and

agentlessly identify server

resources and workloads in the

data center and create a

complete picture of hardware

and software inventory,

utilization levels, and workload

sizes
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Action Process Description Solution

Design 3. Analyze + |dentify virtualization PlateSpin Recon: Generate
candidates consolidation scenario plans to
optimally combine and allocate

+ Create scenarios for .
workloads to new virtual hosts

distributing workloads
across servers to maximize
utilization

+ Balance application
workloads over time and
across hardware resources
to minimize resource
contention

+ Use “what-if” modeling to
determine different
combinations of hardware
and virtual hosts required
for the project

+ Generate consolidation or
disaster recovery plans
with detailed project,
scenario, and workload
assignment reports and
charts

+ Compare different
scenarios based on total
cost of ownership,
consolidation ratio, rack
space, and power needs

Implement 4. Consolidate * Accelerate the server PlateSpin Portability Suite:
consolidation project by Automatically stream data,
streaming physical servers applications, and operating
into virtual environments systems to any physical or
such as VMware ESX virtual platform over the network
Server, VMware Server,
and Microsoft Virtual
Server

+ Automate migrations
between dissimilar physical
servers or from physical
servers to blades

20 PlateSpin Recon 3.7.1 User Guide



Action

Process

Description

Solution

Manage

5. Monitor

6.Chargeback

7. Manage Virtual
Infrastructure

*

Keep track of workload
performance

Identify over- and under-
utilized workloads for
ongoing optimization

Assign customized raters
to machines

Measure resource usage
and bill business owners
for usage

Create reports on usage
and cost
Monitor VM creation

Report on VM growth

PlateSpin Recon

1.5 PlateSpin Recon Terminology

+ Consolidation candidate: A workload on the network that you might want to move to a virtual

machine.

+ Data Center assets: A collective set of physical and virtual machines, and physical and virtual

workloads.

+ Job: A task performed in PlateSpin Recon.

+ Protection candidate: A workload to create standby VM duplicates for disaster recovery.

+ Rater: A metric used to assign a billable charge to the use of a resource or part of a resource
over a set amount of time.

¢ Scheduled job: An activity set to occur at a given time and frequency.

¢ Virtual host: A physical machine that has the virtualization software installed. For example,
VMware ESX.

+ Workload: A physical or virtual machine.

Introduction
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Overview of PlateSpin Recon
Client Views

Novell® PlateSpin® Recon Client provides the following views to help you organize, monitor, view,
and manage information about data center assets:

*

*

*

*

Section 2.1, “Data Center Explorer,” on page 23
Section 2.2, “Report Explorer,” on page 24
Section 2.3, “Projects Explorer,” on page 25
Section 2.4, “Raters Explorer,” on page 25

Section 2.5, “Chart Viewer,” on page 26

Section 2.6, “Job Explorer,” on page 26

Section 2.7, “Scheduled Job Explorer,” on page 27
Section 2.8, “Log Explorer,” on page 27

2.1 Data Center Explorer

The Data Center Explorer is one of several major PlateSpin Recon views. It is used to organize,
monitor, view, and manage information about data center assets. PlateSpin Recon uses information
about them to display dynamic charts, generate performance reports, and generate performance
forecasts.

The Data Center Explorer is the central point for:

*

*

*

Interacting with physical and virtual machines in the data center
Discovering and inventorying hardware and workloads

Adding, monitoring, filtering, grouping, or deleting servers

Overview of PlateSpin Recon Client Views
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Figure 2-1 Data Center Explorer
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For more information about working with Data Center Explorer, see Chapter 3, “Working with Data
Center Explorer,” on page 29.

2.2 Report Explorer

The Report Explorer allows you to organize and generate reports on the inventory and monitoring

data. The Report Explorer hierarchy consists of template nodes that have various types of report
templates.

Figure 2-2 Report Explorer
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For more information about working with Report Explorer, see Chapter 5, “Generating and Viewing
Charts and Reports,” on page 79.
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2.3 Projects Explorer

Projects are displayed in the Project Explorer.

Figure 2-3 Project Explorer Tree
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The project, scenario, and consolidated workloads are arranged hierarchically; that is, workloads are
listed under a server, servers are listed under a scenario, and scenarios are listed under a project. All
selected candidates are listed under workloads inside the project.

For more information about working with Project Explorer, see Chapter 6, “Server Consolidation,”

on page 111.

2.4 Raters Explorer

Allows you to set up a chargeback system.

Overview of PlateSpin Recon Client Views
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Figure 2-4 Raters Explorer
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For more information about working with Raters Explorer, see Section 7.2, “Using Raters,” on
page 145.

2.5 Chart Viewer

Charts provide a graphical representation of workload and utilization data.

To view a chart for a given server, select the server in the Data Center Explorer or click a cell
belonging to the server in a report view.

2.6 Job Explorer

Whenever a task is performed in PlateSpin Recon, a job is created for the task. Information on
running, paused or completed jobs is shown in the Job Explorer, located at the bottom of the
PlateSpin Recon window, by default.

If a job consists of several tasks, you can expand the job to see all of its tasks and the status of each
task by clicking the plus sign next to the job description.

You can also see the steps that make up each task by selecting the task. The steps are displayed in the
panel on the right of the Job Explorer.

Figure 2-5 Task steps displayed in the Job Explorer
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000786 Imventery MyComain com’ () Faded
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0 Robosh brventoned Machines  « Completed  MVIB2008 31853 PM

Messages about the progress of a job are captured in a log file.
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Right-click any running job entry to display a pop-up menu, or use the toolbar buttons, and you can
Pause, Resume, or Abort any running job. The Archive command moves jobs to the Archived Jobs
list. These jobs can be subsequently viewed by selecting Tools > Archived Jobs. You can view the
step logs by right-clicking on a step and selecting View Logs. The Log Viewer dialog is displayed.

NOTE: The default setting is to purge logs and jobs every 14 days. To change this setting, select
Tools > > Options. The Options dialog box is displayed. Double-click Advanced under the
Maintenance category on the Server page.

2.7 Scheduled Job Explorer

A scheduled job is an activity set to occur at a given time and frequency. For example, it is possible
to generate a Network Usage Report every morning at 9:00 AM for the next five days.

A scheduled job is comprised of two components: the action to be performed (the job), and the
schedule for performing the activity. The schedule is a reusable component that can be shared
amongst multiple jobs, such as creating three reports at 9:00 AM. The Scheduled Job Explorer can
be used to view the status of the completed jobs.

Figure 2-6 Job status displayed in the Scheduled Job Explorer

Scheduled Job Explorer ~ I
I A | B S |
Mext Occurrence Description Status
=~ 10/15/2008 1:00:00 AM  Maintenance Purge (Daily 01:00) Q Active
Start Time Duration Diescription Status Completed

10/18/2008 1:00 AM  00:00:15 Maintenance Purge @ Completed 10M18/2008 1:.00 AM
10M17/2008 1:00 AM  00:00:12 Maintenance Purge @ Completed 101772008 1.00 AM
10162008 1:00 AM  00:00:05 Maintenance Purge @ Completed 10/16/2008 1:00 AM
10M15/2008 1:00 AM  00:00:16 Maintenance Purge @ Completed 101572008 1:00 AM
10/14/2008 1:00 AM  00:00:11 Maintenance Purge @ Completed 1014/2008 1.00 AM
10/13/2008 1:00 AM  00:00:05 Maintenance Purge @ Completed 10/13/2008 1:00 AM

Jobs | Scheduled Jobs ] Logs

Errors or warnings, if any, are also displayed. In addition, scheduled jobs can be run manually, or
can have their recurrence changed.

Right-click any running job entry to display a pop-up menu, or use the toolbar buttons, and you can
Suspend, Resume, or Delete any scheduled job. The Edit Recurrence command allows you to create
or edit a scheduled job recurrence pattern. The Run Now command allows you to immediately run
the scheduled job.

2.8 Log Explorer

The Log Explorer allows you to view general information, warnings, or error messages. Messages
that are displayed here are not related to any particular job or server. Right-click any log entry to
display a pop-up menu where you can select commands to View Details of a log entry, Delete a log
entry, or View XML format of a log entry.

To simultaneously delete multiple logs, select the logs using the Shift or Ctrl keys and press the
Delete key or click Delete.

Overview of PlateSpin Recon Client Views
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Figure 2-7 Working with the Log Explorer
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Working with Data Center Explorer

This

section provides information about the Novell® PlateSpin® Recon Data Center Explorer and

the features accessible from it.

*

*

Section 3.1, “Understanding the Data Center Explorer,” on page 29

Section 3.2, “Discovering and Inventorying Data Center Resources,” on page 30

Section 3.3, “Working with Filters,” on page 50

Section 3.4, “Working with Groups,” on page 50

Section 3.5, “Working with Sites,” on page 51

Section 3.6, “Working with PlateSpin Recon Snapshots,” on page 53

Section 3.7, “Working with Remote Data,” on page 58

Section 3.8, “Working with Data Collected by Other PlateSpin Recon Instances,” on page 58

Section 3.9, “Working with Data Collected by Other Performance Monitoring Tools,” on
page 59

Section 3.10, “Using HP Reporter Data with PlateSpin Recon,” on page 64

Section 3.11, “Using Performance Data Import to Import Generic Data into PlateSpin Recon,”
on page 68

3.1 Understanding the Data Center Explorer

The Data Center Explorer is one of several major PlateSpin Recon views. It is used to organize,
monitor, view, and manage information about data center assets. PlateSpin Recon uses information
about them to display dynamic charts, generate performance reports, and generate performance
forecasts.

In the Data Center Explorer, physical and virtual servers are represented in a hierarchical tree

struc

ture.

Table 3-1 Data Center Explorer Nodes

Nodes Description

All Lists all systems

Discovered Lists servers that have been discovered but not yet inventoried

Filters Contains servers listed by built-in criteria, such as domain, operating system, or

monitoring status

Groups Contains manually grouped servers according to any specific data segregation
requirements
Sites Contains servers by data site, including a default local site and others you

create to work with data about servers monitored by other instances of
PlateSpin Recon, or imported from third-party performance monitoring tools

Working with Data Center Explorer
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For more information about the Data Center Explorer icons and commands, see Appendix D,
“Quick Reference to PlateSpin Icons and Commands,” on page 187.

3.2 Discovering and Inventorying Data Center
Resources

PlateSpin Recon gets information about data center assets in two stages.

+ Discover: Discovering machines in the network retrieves information such as hostnames, IP
addresses, MAC addresses, and port information.

¢ Inventory: Inventorying the previously discovered machines retrieves deeper data for each
server, such as operating system, installed applications, services, processor speed, memory,
network, and disk resources.

After machines are inventoried, they can be monitored and included in all report types, regardless of
which method is used for inventory.

¢ Section 3.2.1, “Inventory and Discovery Methods,” on page 30

*

Section 3.2.2, “Inventory Credentials,” on page 41

*

Section 3.2.3, “Inventory Options,” on page 43

*

Section 3.2.4, “Discovery Options,” on page 44

*

Section 3.2.5, “Viewing Inventory Data and Monitoring Servers,” on page 46

PlateSpin identifies a machine through unique attributes such as the IP address. If you change the IP
address of the machine after inventorying a machine, you must reinventory the machine.

For information about ports used by PlateSpin Recon to inventory servers, see Knowledge Base
article Q20571 (http://support.platespin.com/kb2/article.aspx?id=20571).

3.2.1 Inventory and Discovery Methods

A common way to use discovery and inventory is to discover a large number of servers on the
network. These servers appear under the Discovered node in the Data Center Explorer. Next, select
the discovered servers and inventory them. Finally, select which inventoried servers you want to
monitor. It is also possible to discover, inventory, and start monitoring servers in a single step.

You can add servers to the Data Center Explorer by using the Inventory button @ R

There are seven inventory methods available. Each inventory method is unique and has different
requirements.

Table 3-2 Inventory Methods

Discover and Inventory Discover and Optionally Inventory
= Machines (page 31) " Windows Domain (page 35)
= Virtual Center (page 31) IP Range (page 36)

From a CSV File (page 33) =2 Subnet (page 38)

3 SNMP (page 40)
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Machines
To discover and inventory physical and virtual servers:
1 Click the Inventory button @ Y Y > Machines or click the Tools menu > Inventory >
Machines.
The Inventory Machines dialog box is displayed.

2 In Hostname or IP of the machine(s) to inventory, specify the hostname or the IP address of the
machines you want to inventory.

You can specify multiple hostnames or IP addresses separated with a comma; however, they
need to all use the same credentials.

3 Specify credentials for the machines you add in Step 2. For more information on how to specify
a new credential, see Section 3.2.2, “Inventory Credentials,” on page 41.

This enables the Inventory button.

4 (Optional) Start monitoring the servers when they are inventoried and/or add them to existing
groups. For more information, see Section 3.2.3, “Inventory Options,” on page 43.

5 Configure the schedule when you want to perform the inventory.
+ To immediately start the inventory, do one of the following:
¢ Click Now in the Inventory drop-down list.
¢ Click Schedule in the Inventory drop-down list, then click Now > OK.
¢ To perform inventory at a later time, set up a schedule:
1. In the Inventory drop-down list, click Schedule.
The Scheduling Options dialog box is displayed.
2. Select one of the following schedules
¢ “Later” on page 185
¢ “Recurrence” on page 185
3. Fill in the fields.
For details about the fields, click the appropriate schedule listed above.
6 Click Inventory.

Virtual Center

Inventorying a Virtual Center involves collecting information about all the servers and virtual
machines in the Virtual Center. This is much more efficient than discovering and inventorying all the
servers and virtual machines individually.

To discovery and inventory Virtual Center servers:

1 Click the Inventory button @ Y Y > Virtual Center or click the Tools menu > Inventory >
Virtual Center.

The Inventory Virtual Center dialog box is displayed.

Working with Data Center Explorer
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32

Inventory ¥irtual Center

X

Wirtual Center Hostname or |P:

WirualCenter

Inventary
Yirtual Center

Credentialz for lnventary:

< Mew Credential... » v

2 Specify the hostname or the IP address of the Virtual Center you want to inventory.

3 Specify credentials for the machines you add in Step 2. For more information on how to specify
a new credential, see Section 3.2.2, “Inventory Credentials,” on page 41.

This enables the Inventory button.

4 (Optional) Start monitoring the servers when they are inventoried and/or add them to existing
groups. For more information, see Section 3.2.3, “Inventory Options,” on page 43.

5 Configure the schedule when you want to perform the inventory.
+ To immediately start the inventory, do one of the following:
¢ Click Now in the Inventory drop-down list.
¢ Click Schedule in the Inventory drop-down list, then click Now > OK.
¢ To perform inventory at a later time, set up a schedule:
1. In the Inventory drop-down list, click Schedule.
The Scheduling Options dialog box is displayed.
2. Select one of the following schedules
¢ “Later” on page 185
+ “Recurrence” on page 185
3. Fill in the fields.
For details about the fields, click the appropriate schedule listed above.
6 Click Inventory.
Virtual Center contents appear in the Data Center Explorer the same way they are organized in the

Virtual Center, with all nodes, clusters, resource pools, and virtual machine nodes. The machines do
not appear under 4// in the Data Center Explorer until they are inventoried.

When using per core licensing, you must first inventory a Virtual Center before inventorying ESX
Servers that belong to it, or the virtual machines on those ESX Servers. For more information, see
Per Core in the PlateSpin Recon 3.7.1 Getting Started Guide.
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From a CSV File

Inventorying machines from a CSV file allows you to add servers whose information resides in a
comma-separated value file. Use the following format to list the machines in the file:

Address, [Username], [Password], [Description]

Table 3-3 CSV File Requirements

Field Required Description

Address Yes IP address or hostname of the machine.

Username [Optional] Username for the credential. If this is left blank, the default credentials
are used.

Password [Optional] Password of the credential. This is required only when creating a
credential.

Description [Optional] Description for the credential.

[inventory type]  [Optional] Can be any of the following values. Values must match case and

spacing as shown below:

* UNIX

+ VirtualCenter
+ VMwareESX3
* VMwareESX4
+ NetWare

+ CitrixXenServer

+ Windows

If the value is unspecified, Windows and UNIX are the defaults,
determined by the format of the credentials supplied:

+ UNIX - [user]/[password]
+ Windows - [domain]\[user]/password

This field is also expected to be at the end of the CSV file.

To discover and inventory machines from a CSV file:

1 Click the Inventory button @ Y Y > From CSV File or click the Tools menu > Inventory
> From CSV File.

The Inventory Virtual Center dialog box is displayed.

Working with Data Center Explorer
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34

Inventory From CSY File (=]

File containing kst of machines bo lnventony :

~ Defauk Inventory Pasameters
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This machine type will not be inventoried.

Oplions. .. |

erlany | v| Cancel |
4

2 Type the path (or use the adjacent browse button) to locate a CSV file containing servers to
inventory.

3 (Conditional) If the CSV file does not contain the credentials for all the machines, specify the
credentials for the machines in the Default Inventory Parameter panel.

NOTE: The Default Inventory Parameters area is disabled if the CSV file contains credentials
for all its machines.

For more information on how to specify a new credential, see Section 3.2.2, “Inventory
Credentials,” on page 41.

This enables the Inventory button.

4 (Optional) Start monitoring the machine when they are inventoried and/or add them to existing
groups. For more information, see Section 3.2.3, “Inventory Options,” on page 43.

5 Configure the schedule when you want to perform the inventory.
+ To immediately start the inventory, do one of the following:
¢ Click Now in the Inventory drop-down list.
¢ Click Schedule in the Inventory drop-down list, then click Now > OK.
¢ To perform inventory at a later time, set up a schedule:
1. In the Inventory drop-down list, click Schedule.
The Scheduling Options dialog box is displayed.
2. Select one of the following schedules
¢ “Later” on page 185
+ “Recurrence” on page 185
3. Fill in the fields.
For details about the fields, click the appropriate schedule listed above.
6 Click Inventory.
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Windows Domain

Inventorying machines by using the Windows
discovered in the specified Windows Domain.

Domain option allows you to add all the servers

To discover and optionally inventory servers in a specified Windows Domain:

1 Click the Inventory button @ Y Y > Windows Domain or click the Tools menu >

Inventory > Windows Domain.

The Domain Discovery and Inventory dialog box is displayed.

Domain Discovery and Inventory

 Discoveny

=] E3

Entes the name of the \Windows Domain:

Machines to discover: ]A"

Crganizational Unit Fiter: [
~Donain Crederitials -

|< None »
Credentialz vall not be used.

I Invvenitory -

Credentialz for Irventon:

windows | Unix | Vitusl Center | Vhware ESX 3/4 | Novell Netwire | CitisXenServer | ]

Dptians... |

|< Hane »
Thes machine type wil not be imventoried,

=

2 Type a Windows Domain name.

3 In the Machines to Discover drop-down list, select which machines to discover. The available
options are A/l Machines, Servers, or Workstations (NT4 Workstation, Windows XP, Windows

Vista).

4 (Conditional) If you want to discover a specific part of a domain, configure the Organizational
Unit (OU) filter. For more information, see “Domain Discovery:” on page 165.

5 Click the Options button to configure discovery options. For more information, see
Section 3.2.4, “Discovery Options,” on page 44.

If you want to discover machines only, continue with Step 6. If you want to discover and

inventory machine, skip to Step 7.

6 (Conditional) If you want to only discover machines without inventorying machine details:

6a Deselect the Inventory option.

The Inventory option is selected by default.

6b Click Discover.
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7 (Conditional) If you want to discover and inventory machines, additionally configure the
following settings:

7a Specify credentials for the machines you added in Step 3.

For more information on how to specify a new credential, see Section 3.2.2, “Inventory
Credentials,” on page 41.

This enables the Inventory button.

7b (Optional) Start monitoring the machine when they are inventoried and/or add them to
existing groups. For more information, see Section 3.2.3, “Inventory Options,” on
page 43.

7c¢ Configure the schedule when you want to perform the inventory.
+ To immediately start the inventory, do one of the following:
¢ Click Now in the Inventory drop-down list.
¢ Click Schedule in the Inventory drop-down list, then click Now > OK.
¢ To perform inventory at a later time, set up a schedule:
1. In the Inventory drop-down list, click Schedule.
The Scheduling Options dialog box is displayed.
2. Select one of the following schedules
+ “Later” on page 185
+ “Recurrence” on page 185
3. Fill in the fields.
For details about the fields, click the appropriate schedule listed above.

7d Click Inventory.

IP Range

To discovery and optionally inventory servers within a specified IP address range:

Inventory "W

1 Click the Inventory button @ > [P Range or click the Tools menu > Inventory > IP
Range.

The IP Range Discovery and Inventory dialog box is displayed.
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IP Range Discovery and Inventory =]
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2 Configure the following settings in the Discovery pane:
2a Specify the IP address range of the servers to discover.

2b Click the Options button to configure discovery options. For more information, see
Section 3.2.4, “Discovery Options,” on page 44.

If you want to discover machines only, continue with Step 3. If you want to discover and
inventory machine, skip to Step 4.

3 (Conditional) If you want to only discover machines without inventorying machine details:
3a Deselect the Inventory option.
The Inventory option is selected by default.
3b Click Discover.

The numbers that are displayed in the Discover button indicate how many individual IP
addresses are contained within the range you entered

4 (Conditional) If you want to discover and inventory machines, additionally configure the
following settings:

4a Specify credentials for the machines you added in Step 2.

For more information on how to specify a new credential, see Section 3.2.2, “Inventory
Credentials,” on page 41.

This enables the Inventory button.

4b (Optional) Start monitoring the machine when they are inventoried and/or add them to
existing groups. For more information, see Section 3.2.3, “Inventory Options,” on
page 43.

Working with Data Center Explorer
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4c Configure the schedule when you want to perform the inventory.
¢ To immediately start the inventory, do one of the following:
¢ Click Now in the Inventory drop-down list.
¢ Click Schedule in the Inventory drop-down list, then click Now > OK.
¢ To perform inventory at a later time, set up a schedule:
1. In the Inventory drop-down list, click Schedule.
The Scheduling Options dialog box is displayed.
2. Select one of the following schedules
¢ “Later” on page 185
¢ “Recurrence” on page 185
3. Fill in the fields.
For details about the fields, click the appropriate schedule listed above.
4d Click Inventory.

The numbers that are displayed on the /nventory button indicate how many individual IP
addresses are contained within the range you entered.

Subnet

To discovery and optionally inventory servers in a specified subnet:

Inventory "W

1 Click the Inventory button @
The Subnet Discovery and Inventory dialog box is displayed.

> Subnet or click the Tools menu > Inventory > Subnet.

Subnet Discovery and Inventory !El E
-~ Dizcovery
Metvaark. address: I 1.00.0
Mazk bits: IE
Subriet mask: | 255.255.255.0

Optionz. .. |
¥ Ireventony

windoms | Uiz I Virtwal Center | Wiware ESX 374 | Nowell Metw/are I Citrizt =ens erver I

Credentialz for Inventony:

|< Mohe » ;I

Thiz machine tppe will not be inventoried.

Options. .. |

Inventory [256] | v| Cancel |
A

38 PlateSpin Recon 3.7.1 User Guide



2 Configure the following settings in the Discovery pane:
2a Specify the network address and the mask bits of the subnet to be discovered.

2b Click the Options button to configure discovery options. For more information, see
Section 3.2.4, “Discovery Options,” on page 44.

If you want to discover machines only, continue with Step 3. If you want to discover and
inventory machine, skip to Step 4.

3 (Conditional) If you want to only discover machines without inventorying machine details:
3a Desclect the Inventory option.
The Inventory option is selected by default.
3b Click Discover.

The numbers that are displayed in the Discover button indicate how many individual IP
addresses are contained in the subnet you specified.

4 (Conditional) If you want to discover and inventory machines, additionally configure the
following settings in the Inventory pane:

4a Specify credentials for the machines you added in Step 2.

For more information on how to specify a new credential, see Section 3.2.2, “Inventory
Credentials,” on page 41.

This enables the Inventory button.

4b (Optional) Start monitoring the machine when they are inventoried and/or add them to
existing groups. For more information, see Section 3.2.3, “Inventory Options,” on
page 43.

4c Configure the schedule when you want to perform the inventory.
+ To immediately start the inventory, do one of the following:
+ Click Now in the Inventory drop-down list.
¢ Click Schedule in the Inventory drop-down list, then click Now > OK.
¢ To perform inventory at a later time, set up a schedule:
1. In the Inventory drop-down list, click Schedule.
The Scheduling Options dialog box is displayed.
2. Select one of the following schedules
¢ “Later” on page 185
¢ “Recurrence” on page 185
3. Fill in the fields.
For details about the fields, click the appropriate schedule listed above.
4d Click Inventory.

The numbers that are displayed on the /nventory button indicate how many individual IP
addresses are contained in the subnet you specified.
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SNMP

To discovery and optionally inventory servers machines by using Simple Network Management
Protocol:

1 Click the Inventory button @ Y Y > SNMP or click the Tools menu > Inventory > SNMP.
The SNMP Discovery and Inventory dialog box is displayed.

SNMP Discovery and Inventory !El E
~ Discovery
Host Mame I |
Commumity : I public
t aximurn number of hops © m

[ Include Public Subnets

Options... |
W lnwentony

il indions | Uiz I Wirtual Center | Whware ESx 344 | Nowell Metware I Citrie enSerser I

Credentials far Inventary:
|< More > ;I

Thiz machine type will not be inventoried.

Options... |

Invventory | i | Cancel I

A

2 Configure the following settings in the Discovery pane:
2a Specify the hostname.
2b Specify the SNMP community name. By default, it is public.

2¢ In Maximum number of Hops, specify how many hops to make beyond the server from
which the discovery is launched. Select whether to include Public Subnets.

2d Click the Options button to configure discovery options. For more information, see
Section 3.2.4, “Discovery Options,” on page 44.

If you want to discover machines only, continue with Step 3. If you want to discover and
inventory machine, skip to Step 4.

3 (Conditional) If you want to only discover machines without inventorying machine details:
3a Deselect the Inventory option.
The Inventory option is selected by default.
3b Click Discover:

4 (Conditional) If you want to discover and inventory machines, additionally configure the
following settings in the Inventory pane;

4a Specify credentials for the machines you added in Step 2.
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For more information on how to specify a new credential, see Section 3.2.2, “Inventory
Credentials,” on page 41.

This enables the Inventory button.

4b (Optional) Start monitoring the machine when they are inventoried and/or add them to
existing groups. For more information, see Section 3.2.3, “Inventory Options,” on
page 43.

4c Configure the schedule when you want to perform the inventory.
+ To immediately start the inventory, do one of the following:
¢ Click Now in the Inventory drop-down list.
¢ Click Schedule in the Inventory drop-down list, then click Now > OK.
¢ To perform inventory at a later time, set up a schedule:
1. In the Inventory drop-down list, click Schedule.
The Scheduling Options dialog box is displayed.
2. Select one of the following schedules
¢ “Later” on page 185
¢ “Recurrence” on page 185
3. Fill in the fields.
For details about the fields, click the appropriate schedule listed above.
4d Click Inventory.

3.2.2 Inventory Credentials

To inventory discovered machines, select the Inventory check box in the Discovery and Inventory
dialog boxes and then provide login credentials for Windows, UNIX, Virtual Center, VMware ESX,
Novell NetWare®, or Citrix XenServer machines, depending on the type of machines in use.

*

*

*

*

“Specifying Credentials for Windows or VMware ESX 3/4” on page 41
“Specifying Credentials for UNIX or Citrix XenServer” on page 42
“Specifying Credentials for Virtual Center” on page 42

“Specifying Credentials for Novell NetWare” on page 42

For every machine in the list or range, PlateSpin Recon tries each type of credential provided until it
finds one that matches. If the credentials are not valid, the machine is not inventoried.

Specifying Credentials for Windows or VMware ESX 3/4

Do the following in the Discovery and Inventory dialog box:

1

2

In the Inventory panel, click the Windows or VMWare ESX 3/4 tab depending on the type of
machines in use.

In the Credentials for Inventory drop-down list, select credentials.

To add a new credential, click <New Credential>, and configure the Create Stored Credentials
dialog box. For detailed information about adding credentials, see Section 4.2, “Credentials
Manager,” on page 73.
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Specifying Credentials for UNIX or Citrix XenServer
Do the following in the Discovery and Inventory dialog box:
1 In the Inventory panel, click the UNIX or Citrix XenServer tab depending on the type of
machines in use.
2 In the Credentials for Inventory drop-down list, select credentials.

To add a new credential, click <New Credential>, and configure the Create Stored Credentials
dialog box. For detailed information about adding credentials, see Section 4.2, “Credentials
Manager,” on page 73.

3 Select the Use Sudo check box to use super user privileges for connections.

Local policies can sometimes prevent you from establishing an SSH session as a root user. A
user with sudo privileges can get around this restriction by establishing an SSH session as a
non-root user and then using sudo to temporarily “switch” to root user privileges.To do this,
create the credentials using that user’s username and password. PlateSpin Recon uses the sudo
command to perform any operations that require root privileges.

Specifying Credentials for Virtual Center
Do the following in the Discovery and Inventory dialog box:

1 In the Inventory panel, click the Virtual Center tab.
2 In the Credentials for Inventory drop-down list, select credentials.

To add a new credential, click <New Credential>, and configure the Create Stored Credentials
dialog box. For detailed information about adding credentials, see Section 4.2, “Credentials
Manager,” on page 73.

For inventorying a Virtual Center, credentials must have a minimum read-only user status for
the Virtual Center.

Virtual Center automatically includes as users any user with Administrator privileges for the
machine where Virtual Center is installed.

Specifying Credentials for Novell NetWare
1 In Novell eDirectory™ on the NetWare server you want to inventory, create a user with the
same login credentials as the PlateSpin Recon server administrator.
2 Associate the local security policies to the PlateSpin Recon server administrator:
2a On the PlateSpin Recon server, click the desktop Start menu > Settings > Control Panel.
2b Double click Administrative Tools > Local Security Policy.
The Local Security Settings window is displayed.
2c¢c Click Local Policies, then double-click User Rights Assignment.
2d Associate the administrator with following policies:
¢ Act as part of the operating system
¢ Create a token object
¢ Log on as a batch job
+ Logon as a service

¢ Replace a process level token
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3 Ensure that the recommended Novell Client™ is installed on the PlateSpin Recon server.

For more information on the recommended Novell Clients, see “Supported Novell NetWare
Platforms” on page 16.

4 Through the Novell Client, log in to the PlateSpin Recon server as the administrator user
created in Step 1.

5 Launch the PlateSpin Recon Client.

6 In the Inventory drop-down list (located at the top left corner), click Machines.
The Inventory Machines dialog box is displayed.

7 Click the Novell NetWare tab.

8 In the Credentials for Inventory drop-down list, select <New Credential>.
The Create Stored Machines dialog box is displayed.

9 Specify the login credentials of the NetWare administrator, and select Novell NetWare
Inventory as the validation type.

Ensure that you specify the username in the Username.Context format.

Ensure that the administrator has permission to write to the Novell SYS: volume. Also, ensure
that TCP port 524 is open on the firewall. For more information see Section 1.3, “Supported
Platforms,” on page 14.

10 In the Launch Inventory Process as User drop-down list, select <New Credential>.
The Create Stored Machines dialog box is displayed.
11 Fill in the fields:

Username: Specify the administrator username created in Step 1. You must specify the
username either in the hostname\username or the domain\username format. If you choose to
specify the username in the hostname\username format, ensure that the hostname is the local
hostname.

Password: Specify the password of the administrator.

Validation Type: Select Netware LSA.

Hostname or IP of machine to validate against: Specify it as localhost.
12 Click Save.

3.2.3 Inventory Options

If you want to start monitoring immediately after inventory or if you want to copy machines to a
user-defined group, you must configure the Post-Inventory options. The options are available only if
you had selected the /nventory check box in Discovery and Inventory dialog boxes.

To configure the Post-Inventory options:

1 Click the Options button in the Inventory area.
The Post-Inventory Options dialog box is displayed.
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X

Post-Inventory Options

[] Start monitoring machines immediately
Copy to group
& MyGroup

Cahcel

2 Seclect Start monitoring machines immediately to begin monitoring each machine discovered
when the inventory is complete.

To start monitoring later, do not select the option.

3 Select Copy to group, then select a target Group from those displayed in the list box to copy all
the inventoried machines to that group.

4 Click OK.

3.2.4 Discovery Options

you can configure additional discovery options when you choose to discovery and inventory in any
of the following Inventory methods:

¢ Windows Domain
+ IP Range

¢ Subnet

¢+ SNMP

To configure discovery options:

1 In the Discovery pane, click the Options button.
The Discovery Options dialog box is displayed.
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Discovery Options @

Ping attempts €]
Ping timeout (ms) 938
Port subset type Custom hd

Port scan protocols Mone hd

L

4

Port Number Protocol
# |Add .

p |40

TCP

100

UpopP

Discover MAC addresses
Discover computer names

Add offline computers

ok || cancel |

2 Configure the Ping Attempts and Ping Timeout options as desired.

3 1In the Port subset type drop-down list, select one of the following subset types:

¢+ Most Common: Includes ports for common Windows network services.

+ All Standard: Includes ports below 1025 used by standard protocols.

¢ Custom: Includes customized ports that you specify.

To assign individual scan protocols to specific ports:

1.
2.

3.
4.

In the Port Number column, click Add and type the port number.

In the Protocol column, select the protocol type (TCP or UDP) from the drop-down
cell.

Press Enter.

(Optional) If you want to add a new port number, repeat Step 1through Step 3.

4 To find MAC addresses of machines in the same ethernet segment as the PlateSpin Recon
Server, select Discover MAC addresses. The option is selected by default.

5 To include the computer names in the discovery poll, select Discover computer names. The
option is selected by default.

6 To discover computers even if they are currently offline, select Add offline computers.
7 Click OK.
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3.2.5 Viewing Inventory Data and Monitoring Servers

On completion of an inventory operation, you can view inventory data on servers that are listed in
the Data Center Explorer tree. To view dynamic data, servers must be monitored for a period of
time.

¢ “Viewing Properties” on page 46

¢ “Refreshing the Inventory” on page 47

¢ “Collecting Dynamic Data by Monitoring Servers” on page 47

+ “Viewing Dynamic Data” on page 47

+ “Viewing Logs” on page 47

¢ “Custom Fields” on page 47

Viewing Properties

Properties can assist with viewing static data for inventoried servers. To view inventory information,
right-click a server and click Properties.

Figure 3-1 Sample View of the Properties Dialog Box

i
Frocesses I Windows Services | Cusztom Fields | Wi Files
General PfDCESSDfSl Storage I Metwork Adapters | &pplications

Processors: 1

Speed: 26E3MHz

MHormalized Speed: 3365445

Cores Per Processar 1

Manufacturer: Genuinel nkel

todel: Intel Core 2 Duo EEFO0
Huyper-Threading Available: Falze

Huyper-Threading E nabled: Falze

o |

Cancel |

A

The tabs available in the Properties dialog box change based on the type of server being viewed.
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Refreshing the Inventory

To refresh server inventory information in the Data Center Explorer, right-click a server or multiple
servers and click Refresh Inventory on the menu.

Inventory Refresh jobs are scheduled and run in the Job Explorer.

Collecting Dynamic Data by Monitoring Servers

1 To monitor a single server, right-click the inventoried server, then click Start Monitoring.

To monitor multiple servers, select them or their parent group, filter, or site, then click Start
Monitoring.

A job is created in the Job Explorer. For more details, refer to Section 2.6, “Job Explorer,” on
page 26.

2 After data is collected, click the server to view the corresponding chart in the Chart Viewer.
With at least five minutes of data collected, the Chart Viewer can display workloads and
utilization data.

Although PlateSpin Recon might not be currently monitoring a server, it is still possible to view
charts and reports showing the previously collected server data.

You can monitor multiple servers by selecting them individually or by using groups, filters, or sites.

To stop monitoring, right-click the monitored server and select Stop Monitoring. In the confirmation
dialog box, click Yes to confirm or No to exit the dialog box and continue monitoring.

Viewing Dynamic Data

You can view workloads and utilization data in a chart after collecting at least five minutes worth of
data. Analysis Reports require a minimum of one hours worth of data. If there is insufficient data,
the report is displayed without dynamic data. You can view collected data in a chart by selecting a
monitored server.

For more information, see Section 5.1, “Chart Viewer,” on page 79 and Section 5.2, “Report
Explorer,” on page 83

Viewing Logs
Log files reflect the status of data collection for monitored servers.

To inspect a log, right-click a server, click Logs, then click View Logs.

Custom Fields

Custom fields are available for entering server information that cannot be inventoried by PlateSpin
Recon. These non-inventory fields can assist with identifying candidates for planning and
consolidation. The information is stored in the visible table name.

You can specify the custom fields in one of the following ways:

+ “Manually Specifying the Custom Fields” on page 48
¢ “Importing the Custom Fields” on page 49
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Manually Specifying the Custom Fields
To specify custom fields for multiple servers:

1 Select a server or multiple servers in the Data Center Explorer.

2 Right-click the selection and click Properties for a single server, or click Set Custom fields for
multiple servers.

The Properties dialog box is displayed.
3 Click the Custom Fields tab.

4 Select a field to view its definition and parameters.

Properties: DEY |zl@@

General | Processors || Disk Drives | Metwork Adapters | Applications

Processes || Microsoft Virtual Server | Windows Services | Custom Fields

Rack Unitz 2
Energy Consumption () 330
Mormalized Speed 4714753

Heat Dissipation [BTUhr)
Amount of heat generated by a zerver. Heat Dizsipation [BTU hr) = Energy. ..

i Reset Reference Values ]

Compary
Department
Location City
Location State
Location Caountry
Function

Fack.

Billing Code
Usage

Lease Expires

W arranty Expires

Billing Code
Billing code of the server

(ox ) (Coomen )

5 Type or select information in any of the fields, including those already filled with data.
6 Click OK.

If necessary, click Reset Reference Values to return all fields to their default values.

The database is updated for the selected servers. Report templates can filter for particular custom
fields.
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Importing the Custom Fields
PlateSpin recon allows you to import the custom fields for all the servers in the local site.
1 In the Data Center Explorer, click File > Import Machine Properties.

The Import Machine Properties dialog box is displayed.

Import Machine Properties

-~ File: Path
File containing list of machines and custom fields:

I Chvikhbest.cov |

-~ Optionz
Drelimiter: I

¥ Ovenwrite exizting properties

Irnpaort Cancel |

2 Type the path (or use the adjacent browse button) to locate a CSV file containing custom fields.
Ensure to follow these guidelines as you work with the CSV file:

¢ The first line must contain the label of the custom fields separated by a delimiter such as a
comma (,).

¢ The first custom field label on the first line must be Machine. You can list the remaining
custom fields in any order.

+ You must use the following custom field labels only:

Rack Units
Normalized Speed
Company
Department
Location City
Location State
Location Country
Function

Rack

Billing Code
Usage

Lease Expires
Warranty Expires

+ The custom field label names are case sensitive.

¢ The values for the custom fields must be specified subsequent to the first line, and must be
corresponding to the custom fields.

+ Each line must contain the custom fields for a machine.
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+ The value for the Machine custom field can be IP address or the machine name. The
specified machine name must be unique.

¢ The values on each line must be separated by a delimiter such as a comma (,).
A sample CSV file is as follows:

Machine,Rack Units,Company,Lease Expires,Warranty Expires
l.x.x.x,130,Novell, 11/25/2009,1/1/2010

3 Specify the delimiter used in the CSV file. By default, it is a comma (,).

4 (Conditional) If you want to replace the existing custom fields with the values contained in the
CSYV file, select the Overwrite Existing Properties option. By default, the option is selected.

5 Type or select information in any of the fields, including those already filled with data.
6 Click Import.

3.3 Working with Filters

The Filters node contains additional nodes that list inventoried servers organized into logical groups
based on domain, server make and model, operating system, status, subnet mask, virtual machine
servers, and workgroup.

Filters cannot be added or removed, and servers cannot be added to filters.

3.4 Working with Groups

The Groups node contains user-defined collections of servers. Use groups to logically group servers
by location, function, application, and so on. Groups can be created, deleted, and nested. Servers can
belong to more than one group.

¢ Section 3.4.1, “Creating a Group,” on page 50

¢ Section 3.4.2, “Copying Servers to a Group,” on page 50

¢ Section 3.4.3, “Deleting a Server from a Group,” on page 51

3.4.1 Creating a Group

1 In the Data Center Explorer, right-click Groups and click Create Group.
The Create Group dialog box is displayed.

2 Type a Group Name.

3 Click OK.

The group is created and ready for servers to be copied to it.

3.4.2 Copying Servers to a Group

1 In the Data Center Explorer, select one or more servers.
2 Right-click the selection, then click Copy to Group.
3 Click the desired group on the submenu that is displayed.

The server is displayed under the selected group in the Data Center Explorer.
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You can also drag servers from under the All, Filtered or Sites node and drop them on an existing
group to copy them to that group.

3.4.3 Deleting a Server from a Group

1 In the Data Center Explorer, do one of the following:
+ Right-click the server you want to delete, then click Delete.
+ Select the server you want to delete, then press the Delete key.
A confirmation dialog box is displayed.

2 (Optional) To permanently remove the monitoring data for the server when it is deleted from
the group, select Delete <server> and associated monitoring data from the database.

3 Click Delete.

The server is removed from the group in the Data Center Explorer.

3.5 Working with Sites

The Sites node contains logically organized sets of servers for analysis and reporting on data
collected from multiple locations.

Each PlateSpin Recon installation includes a default Loca! site that contains machines that you work
with using the local instance of PlateSpin Recon.

You can work with data external to the local PlateSpin Recon instance, in which case you must first
create a new site of the appropriate site type.

NOTE: Machines imported from a remote site can be viewed in reports and charts after the data has
been synchronized. However, you cannot inventory or monitor the machines. If you want to
inventory or monitor the machines, you must perform the actions at the original remote site and
import the machines again. Subsequently, you need to synchronize the data again.

The following table explains the different types of sites that you can create.

Table 3-4 Site Types

Type Description

Local To work with PlateSpin Recon snapshots (* . prs files) exported from other
instances of PlateSpin Recon. When it is exported from the local instance
of PlateSpin Recon, a snapshot can be imported into the default Local site.
For more information, see Section 3.6, “Working with PlateSpin Recon
Snapshots,” on page 53.

Remote PlateSpin Recon To connect to and work with data collected by a remote PlateSpin Recon
instance. For more information, see Section 3.8, “Working with Data
Collected by Other PlateSpin Recon Instances,” on page 58.
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Type Description

Remote To work with data collected by supported third-party performance
monitoring tools, such as Microsoft Operations Manager 2005, Windows
Performance Monitor (perfmon.exe), HP Reporter, and other generic
performance data gathering tools. For more information, see Section 3.9,
“Working with Data Collected by Other Performance Monitoring Tools,” on
page 59.

Using PlateSpin Recon sites, you can designate a PlateSpin Recon Server as the Master Server and
carry out all analysis and reporting tasks within a single PlateSpin Recon environment.

¢ Section 3.5.1, “Adding a Site,” on page 52

¢ Section 3.5.2, “Deleting a Site,” on page 52

+ Section 3.5.3, “Modifying a Site,” on page 52

3.5.1 Adding a Site

1 Right-click anywhere in the Data Center Explorer and choose Sites > Add Site.
The Add Site dialog box is displayed.

Type a unique name for the site.

In the Type drop-down list, ensure that Local is selected

(Optional) Provide a description for the site.

Ensure that the Run Import Site Snapshot Wizard option is deselected.

Click OK.

The site is created and is displayed under the Sites node in the Data Center Explorer.

o 0~ WODN

For information on adding Remote or Remote PlateSpin Recon sites, see Section 3.7, “Working with
Remote Data,” on page 58.

3.5.2 Deleting a Site

1 In the Data Center Explorer, do one of the following:
+ Right-click the site you want to delete, then click Delete.
+ Select the site you want to delete, then press the Delete key.
A Confirm Delete dialog box is displayed.
2 Click Yes.

PlateSpin Recon removes the selected site and associated resources from the Data Center
Explorer.

3.5.3 Modifying a Site

1 In the Data Center Explorer, right-click the site you want to modify, click Sifes, then click Edit
Site.

The Edit Site dialog box is displayed.
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2 Make the required modifications.
3 Click OK.

3.6 Working with PlateSpin Recon Snapshots

PlateSpin Recon snapshots (* .prs files) contain data about machines, raters, report templates,
generated reports, projects, scenarios, and server templates exported by other instances of PlateSpin
Recon, or from the current instance as a backup.

You can also import snapshots exported from previous versions of PlateSpin Recon. In this case, a
snapshot upgrade is performed before the data is brought into PlateSpin Recon. You need to
consider the following:

+ Importing a large snapshot, for instance if the snapshot was compressed before export, requires
two to five times the size of the old snapshot in disk space.

¢ Snapshots exported from PlateSpin Recon 3.0 and later are supported.

¢ Snapshots from PlateSpin Recon 3.1 are only supported if all hot fixes were applied to
PlateSpin Recon before the snapshot was exported.

You can import a snapshot either into the default Local site, or into a new local site.

¢ Section 3.6.1, “Exporting a PlateSpin Recon Snapshot,” on page 53
¢ Section 3.6.2, “Importing a PlateSpin Recon Snapshot,” on page 56

3.6.1 Exporting a PlateSpin Recon Snapshot

1 Right-click in the Data Center Explorer, click Sites, then click Export Snapshot.
The Export Site Snapshot Wizard is displayed.

2 Select export objects you want to include in the snapshot by enabling the check box next to the
objects.

When a report template is included in the snapshot, its generated reports can also be included.
Similarly, if a project is included in the snapshot, its scenarios can be included.

3 Click Next.

If you selected to export Machines as part of the snapshot, continue with Step 4; else, skip to
Step 6.

4 In the Step 1b dialog box, select summary options for the data to be exported, such as a data
range time frame and whether to include Logs or Credentials.
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Export Site Snapshot

Step 1b of 3: Specify the machines filter
Summary Data Granularity

[] 5 Minute {Used in charts only)
1Hour  (Used in charts, reports, and projects)

Summary Data Range
*) All Data

O Lask | | | |

O Eetween | | |

] Manitor Logs

[] attached Credentials

< Back “ Mext = ][ Cancel

5 Click Next.
The Step 2 dialog box is displayed.

Export Site Snapshot

UNC or File Path on the PlateSpin Recon Server:

Step 2 of 3: Select the file name for the exported snapshot

- B

| c:\snapshots'snapshot. prs|

|[ Browse... ]

Credentials

|r|:n:|t

Compress (file size will be reduced at the cost of slowerimport/export)

3|

|:| Encrypt |

< Back “ Mext =

] [ Cancel
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6 Specify the filename for the exported snapshot:

6a Specify the UNC (\\<server>\<path>\<filename>) or file path
(drive:\directory\ filename) where you want to save the snapshot. You can also click
Browse to browse for and select a location

6b Select or create the appropriate credentials to access the location where you want to save
the exported snapshot. You need write permission to this location.

6¢c Choose whether to Compress the file.

6d Choose whether to Encrypt the file. For an encrypted snapshot file, specify and confirm a
password for decryption.

7 Click Next.
The Step 3 dialog box is displayed.

Export Site Snapshot |Z|EJ El

Step 3 of 3: Choose the delivery types and the schedule for the export joh

Delivery Types

Metwork File [ Metwork File Options. ..

FTr [ FTP Options. ..

[] Delete Saurce File After Delivery
Scheduls

(=) MNow

O Laker:

() Recurrence:

[ < Back “ Export ][ Cancel ]

8 Configure the snapshot delivery type and the delivery schedule:

8a If you want the snapshot delivered to a network or FTP location after it is exported, select
a delivery type. To configure the delivery method options, click the option button next to
the selected delivery method. If you are unsure of the delivery configurations, check with
your System Administrator.

The file path must be accessible to the PlateSpin Recon Server.

8b (Optional) If you want to delete the source snapshot after it is delivered, select the Delete
Source File After Delivery check box.

8c Configure the schedule when you want the snapshot to be delivered.

¢ To immediately deliver the snapshot, select Now.
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¢ To deliver the snapshot at a later time, select one of the following schedules
¢ “Later” on page 185
+ “Recurrence” on page 185
9 Click Export.

The data snapshot is ready to be imported into another instance of PlateSpin Recon.

3.6.2 Importing a PlateSpin Recon Snapshot

1 Determine the type of local site (the default local site or a new local site) you want to import the
required snapshot into. To import into a new local site, you need to create the site before
importing the snapshot.

2 In the Data Center Explorer, right-click the target local site, click Sifes, then click Import
Snapshot.

Or
Right-click in the Data Center Explorer, click Sites, then click Import Snapshot.
The Import Site Snapshot Wizard is displayed.

Import Site Snapshot

Step 1 of 3: Specify the location of the snapshot file to import
UINC or File Path on the PlateSpin Recon Server:

|'n,'n,demo-pcsl'gcs'gsnapshut.prs |[ Browse... ]
Credentials

|r|:n:|t w |

Snapshot Password:

[ Mext = ][ Cancel

3 In the Step 1 dialog box, configure the following:

3a Specify or click Browse to browse for and select the UNC or the local file path of the
snapshot you want to import.

3b Select or add the credentials needed to access the location.

3c Ifthe file was encrypted on export, type the Snapshot Password to decrypt it.
4 Click Next.

The Step 2 dialog box is displayed.

PlateSpin Recon 3.7.1 User Guide



Import Site Snapshot

Step 2 of 3: Select the objects to include in the import
Import objects:

[v] Application

[¥] Application - Exchange Workloads

[v] Application - 5QL Server Workloads

[v] Application Complete

Disk - Peak

Disk - Prime Time Average

Disk - Usage

Hardware - Obsolete (Memary < 600 MB)
Hardware - Obsolete (Processor < 1,000 MHz)
Hardware Inventory

Hardware Utilization - Peak

Hardware Utilization - Prime Time &verage
Memory - Overutilized

Memaory - Peak

3

[ « Back ][ Mext = ][ Cancel

]

5 Select the check boxes next to the objects you want to import.
6 Click Next.

If the imported objects include machines with monitoring data, the Step 2b dialog box is

displayed. Otherwise, proceed to Step 9.

Import Site Snapshot

Step 2b of 3: Specify the machines filter
summary Data Granularity
[] 5 Minute {Used in charts anly)

1 Hour{Used in charts, reports, and projects)

Summary Data Range
Between | 10/15/2006 08:00 PM

v|| and |03/15/2007 08:00PM v

[ « Back ][ Mext = ][ Cancel

7 Specify the data options for the machines filter.
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8 Click Next.
The Step 3 dialog box is displayed.

9 In the Import to Site drop-down list, select the target site you want to import the required
snapshot into.

10 Click Import.

After the data is imported, work with it using the Data Center Explorer under the Sites node.

3.7 Working with Remote Data

Working with performance monitoring and resource utilization data external to the local instance of
PlateSpin Recon allows you to take advantage of the PlateSpin Recon capacity planning, analysis,
reporting and chargeback capabilities, regardless of the source of information. Data can be imported
on a one-time or recurring basis.

3.8 Working with Data Collected by Other
PlateSpin Recon Instances

You can use performance and utilization data collected by other instances of PlateSpin Recon, such
as in a setup where multiple PlateSpin Recon instances handle monitoring and data collection, with
one acting as a central PlateSpin Recon instance for generating reports and developing consolidation
plans.

NOTE: Machines imported from a remote site can be viewed in reports and charts after the data has
been synchronized. However, you cannot inventory or monitor the machines. If you want to
inventory or monitor the machines, you must perform the actions at the original remote site and
import the machines again. Subsequently, you need to synchronize the data again.

To work with data collected by another instance of PlateSpin Recon:

1 Create a new Remote PlateSpin Recon site to connect to the remote PlateSpin Recon instance:
1a Right-click in the Data Center Explorer, click Sites, then click Add Site.
The Add Site dialog box is displayed.
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1b

1c

1d
1e

1f
19

Add Site 53

Mame: Type:
FuSite] Remote PowerRecon v
Description:

PowerRecon Server URL:
http:/localhost/PlateSpin_35/PowerRecon_35
Credentials

MyDomain'Myhame w

Connection Timeout : (300 5 | Query Timeout: (300 3

Encrypt Data Stream

Connection Test

Select Remote PlateSpin Recon as the new site Type and specify the required basic
parameters for the new site, including a name and an optional description.

Specify the URL of the PlateSpin Recon server in the following format:

http://hostname or IP address of the Recon Server|[:port]/
PlateSpin 37/PlateSpin Recon 37

In the Credentials drop-down list, select the appropriate credentials or select <New
Credential> to add new credentials.

If you want the data stream encrypted, ensure that the Encrypt Data Stream check box is
selected.

(Optional) To verify connectivity with the remote server, click Connection Test.
Click OK.

The new site is added to the Sites node in the Data Center Explorer.

2 Right-click the Remote PlateSpin Recon site you created in Step 1, click Sites, then click

Import Machines. The machine nodes are added to the site.

3 Right-click the Remote PlateSpin Recon site again, click Sites, then click Synchronize Data.

3.9 Working with Data Collected by Other
Performance Monitoring Tools

You can import and work with performance and utilization data collected by other performance
monitoring software, such as Microsoft Operations Manager (MOM) 2005, Microsoft Windows
Performance Monitor (perfmon.exe), and HP Reporter. You can also use the PlateSpin Recon

Performance Data Import feature.
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NOTE: Machines imported from other performance monitoring tools can be viewed in reports and
charts after the data has been synchronized. However, you cannot inventory or monitor the
machines. If you want to inventory or monitor the machines, you must perform the actions at the
original remote site and import the machines again. Subsequently, you need to synchronize the data
again.

PlateSpin Recon supports summarization of collected data within 5-minute and 60-minute intervals,
regardless of how the selected connector summarizes and collects data. PlateSpin Recon requires
that data collected by connectors be summarized over intervals of 60 minutes or less. We
recommend importing connector data summarized over 60-minute intervals, especially for systems
whose utilization data covers a period of longer than one month.

For PlateSpin Recon to generate reliable consolidation plans, we recommend that you collect
utilization data for a period of one to three months before importing it into PlateSpin Recon.

For the capability to work with data collected by third-party software, you must:

+ Create a new Remote site of the appropriate type and select an appropriate connector.
¢ Inventory the remote machines.

¢ Synchronize data in the new site with that collected by the remote monitoring tool.

¢ Section 3.9.1, “Required Performance Counters,” on page 60

3.9.1 Required Performance Counters

You must ensure that the required performance and utilization data is actually gathered for PlateSpin
Recon counters in the required categories.

Table 3-5 Required PlateSpin Recon Counters

PlateSpin Recon Counter Expressed in

Processor utilization Percentage of total processor time
Memory utilization Total number of free bytes

Disk 10 Bytes per second

Network IF 1/0 Bytes per second

NOTE: NetWare machines only require two counters (CPU and disk) to be gathered for successful
consolidation. For more information see Section 1.3, “Supported Platforms,” on page 14.

Where required, PlateSpin Recon provides mechanisms for converting third-party performance and
utilization data to the required PlateSpin Recon format.

* “Working with Microsoft Operations Manager (MOM) 2005 Data” on page 61
* “Working with Windows PerfMon Counter Logs” on page 62
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Working

with Microsoft Operations Manager (MOM) 2005 Data

1 Download and install the PlateSpin Management Pack for MOM 2005 (see Knowledge Base

Artic

le Q20903 (http://support.platespin.com/kb2/article.aspx?id=20903)) and collect data by

using MOM.

2 Create a new Remote site for connecting to MOM:

2a

2b

2c
2d

2e

Right-click in the Data Center Explorer, click Sites, then click Add Site.
The Add Site dialog box is displayed.

Add Site X

MName: Type:
| hySite | |Hemote v|
Description:
Connector Type: | Micresoft Operations Manager 2005 b |
Database Connection

Database Hostname : | MyDE |

Database Instance : | CnePoint |

Connection Timeout:  |300 % | Query Timeout: (300 3

Diatzbzse Credentizlz

My Domain'MyMame w |

Select Remote as the Type of the new site and specify the required basic parameters for the
new site, including a name and an optional description.

In the Connector Type drop-down list, select Microsoft Operations Manager 2005.

Type the Database Hostname for the remote server. Database Instance defaults to
OnePoint and must be changed to reflect the Microsoft Operation Manager 2005 database
instance in use.

Select the appropriate credentials or select <New Credential> to add new credentials.

2f (Optional) To verify connectivity with the remote database, click Test Settings
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2g Click OK.
The new site is added to the Sites node in the Data Center Explorer.
3 Inventory the machines:

3a In the Data Center Explorer, right-click the remote site, click Sites, then click Inventory
Machines.

The Inventory Machines dialog box is displayed.

3b Sclect the check boxes next to the machines you want to inventory, specify the required
inventory parameters, then click OK.

4 Synchronize site data:

4a In the Data Center Explorer, right-click the required site and select Sites > Synchronize
Data.

4b Seclect the check boxes next to the required machines. To select all machines in a site,
select the check box next to the site.

4c Select the required data range, scheduling, and recurrence options.
4d Click OK.

Working with Windows PerfMon Counter Logs
1 Set up your Windows Performance Monitor (perfmon.exe) to gather counter data required by
PlateSpin Recon. See Section 3.9.1, “Required Performance Counters,” on page 60.
2 Export the data to a CSV file. For detailed information, see the Windows documentation.
3 Create a new Remote site to work with Windows Performance Monitor logs:
3a Right-click in the Data Center Explorer, click Sites, then click Add Site.
The Add Site dialog box is displayed.

62 PlateSpin Recon 3.7.1 User Guide



Add Site X
Mame: Type:
| My Site | |Hemc:te w |
Description:
Connector Type: | Performance Monitor w |

UNC or File Path on the PowerRecon Server:

|C:".F'erfl"a'lc:unDa'fa".lrr'.[:.c:rt".F'erfI"a'Ic:nSite.-".11—.'ZIIIIIIB.(:5~.r |[ Browse. .. ]
Credentizls
|M~,'Domain".M}rName w |
Test Settings

Cancel

3b Seclect Remote as the Type of the new site and specify the required basic parameters for the
new site, including a name and an optional description.

3¢ In the Connector Type drop-down list, select Performance Monitor.

3d Type the path to (or browse to and select) the CSV file that contains data exported from
Performance Monitor.

3e Select the required credentials or select <New Credential> to add new credentials.
3f (Optional) To verify UNC or local file path access, click Test Settings.
3g Click OK.
The new site is added to Sites node in the Data Center Explorer.
4 Inventory the machines:
4a In the Data Center Explorer, right-click the remote site, click Sites, then click Add Site.
The Inventory Machines dialog box is displayed.

4b Select the check boxes next to the machines you want to inventory, specify the required
inventory parameters, then click OK.
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5 Synchronize site data:

5a In the Data Center Explorer, right-click the required site, click Sites, then click
Synchronize Data.

5b Select the check boxes next to the required machines. To select all machines in a site,
select the check box next to the site.

5¢ Select the required data range, scheduling, and recurrence options.
5d Click OK.

3.10 Using HP Reporter Data with PlateSpin
Recon

PlateSpin Recon features a specialized HP Reporter connector. It enables PlateSpin Recon to
connect to an HP Reporter 3.8 database to import performance and resource utilization data for
charts, reports and consolidation planning.

You can use any HP Reporter-collected data to generate PlateSpin Recon charts and reports.
However, for consolidation planning you must configure Reporter to collect specific utilization data
that correlates to data collected by specific PlateSpin Recon counters. For detailed information, see
Section 3.9.1, “Required Performance Counters,” on page 60.

You need to specify appropriate formulas to transform the data from Reporter-collected metrics to
PlateSpin Recon counters because HP Reporter does not collect data in exactly the same format as
PlateSpin Recon.

¢ Section 3.10.1, “Using Formulas to Convert Metrics to Counters,” on page 64

¢ Section 3.10.2, “Example Formulas,” on page 65

¢ Section 3.10.3, “Working with HP Reporter Data,” on page 66

The HP Reporter data summarization interval is specified during the creation of the HP Reporter
Metric List.

3.10.1 Using Formulas to Convert Metrics to Counters

You can use a formula to provide the following information to the PlateSpin Recon HP Reporter
Connector:

¢ Which Reporter metric list contains metrics required by PlateSpin Recon

¢ How to convert data from measurement units used by Reporter units to those required by
PlateSpin Recon

A valid HP Reporter Connector formula consists of the name of the required HP Reporter metric
list, followed by a dot character, followed by an arithmetic expression that converts the metric into a
PlateSpin Recon counter. Arithmetic expressions can contain any of the collected Reporter metrics,
numeric constants, and arithmetic operations.

NOTE: Only metrics collected by the same metric list can be used in one formula, although
different formulas can use different metric lists.
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For example, PlateSpin Recon requires memory utilization data expressed in the number of free
bytes available to the operating system, while Reporter collects the same data by using two separate
metrics:

¢ Percentage of memory utilized (GBL_MEM_UTIL)

¢ Total size of the memory in gigabytes (GBL_ MEM_PHYYS)

In this case, the appropriate formula for converting collected metric data into the PlateSpin Recon
counter format would be:

GBL_MEM PHYS* (100-GBL_MEM UTIL))*1024*1024*1024/100

3.10.2 Example Formulas

The following are examples of HP Reporter metrics that you can collect using CODA agents, along
with corresponding conversion formulas. Note that To do consolidation planning, PlateSpin Recon
requires data for all four counters. Because HP Reporter can collect metric data with several
different agents, and the same PlateSpin Recon counters can be calculated using different HP
Reporter metrics, this list is not exhaustive and serves only as an example.

Table 3-6 Example HP Reporter Metrics

PlateSpin
Recon HP Reporter Metrics Conversion Formula
Counter
Processor GBL_CPU_TOTAL_UTIL <MetricList>.GBL_CPU_TOTAL_UTIL
Utilization
BYCPU_CPU_TOTAL_UTIL <MetricList>.BYCPU_CPU_TOTAL_UTIL
Memory  GBL_MEM_PHYS and <MetricList>.(GBL_MEM_PHYS*(100-
Utilization GBL_MEM_UTIL))*1024*1024*1024/100
GBL_MEM_UTIL
GBL_MEM_FREE <MetricList>.(GBL_MEM_FREE)*1024*1024
Disk GBL_DISK_PHYS_BYTE_RATE <MetricList>.GBL_DISK_PHYS_BYTE_RATE
Utilization

BYDSK_PHYS_READ_BYTE_RATE <MetricList>.BYDSK_PHYS_READ_BYTE_RATE

Network  BYNETIF_OUT_BYTE_RATE and <MetricList>.BYNETIF_OUT_BYTE_RATE +

Utilization BYNETIF_IN_BYTE_RATE
BYNETIF_IN_BYTE_RATE

Data for certain HP Reporter metrics and PlateSpin Recon counters is collected separately for each
device instance. For example, the BYCPU_CPU_TOTAL UTIL metric gives a separate utilization
figure for each CPU in the system. To distinguish among different device instances, include a metric
with a device identification string in the list when you set up the HP Reporter metric lists.

The PlateSpin Recon HP Reporter connector identifies the following metrics as containing device
instance names:
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Table 3-7 PlateSpin Recon HP Reporter Metrics

Functional Area Metric

Processors BYCPU_ID

Disks BYDSK_DEVNAME or BYDSK_ID

Network Interface Cards BYNETIF_NAME or BYNETIF_ID

File Systems FS_DIRNAME, FS_DEVNAME or FS_DEVNO

3.10.3 Working with HP Reporter Data

1 Configure your HP Reporter to collect data in the required performance and utilization
measurement categories. For more information, see Section 3.9.1, “Required Performance
Counters,” on page 60.

2 (Conditional) If you are using Oracle with HP Reporter, install Oracle client software on the
PlateSpin Recon Server host. For detailed information, see the Oracle documentation.

3 Create a new Remote site for connecting to the HP Reporter database:
3a Right-click in the Data Center Explorer, click Sifes, then click Add Site.
The Add Site dialog box is displayed.
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Add Site X
Mame: Type:
| My Site | |Hemc:te w |
Description:

Connector Type: | HP Reporter w |

Settings | Counters

Database Connection

Server Name | MyServer |
Database Name : | reporter |
Connection Timeout : Query Timeout :
Database Type: | SQL Server 2005 v |
Database Port [ 1433 |
Database Credentials

root hd |

Test Settings By

Cancel

3b Specify a name and, optionally, a description.

3c In the Type drop-down, select Remote.

3d In the Connector Type drop-down list, select HP Reporter.

The HP Reporter-related Settings and Counters fields are displayed.

3e On the Settings tab, provide the following information required to connect to the HP
Reporter database:

*

*

*

Database hostname
Database or database instance name
Connection timeout and the Query timeout.

When you synchronize a large data set from HP Reporter, you might need to set the
Connection timeout and the Query timeout values to 0, which means infinite/
unlimited timeout.

Database type
Port number, if a non-default port number is used

Valid credentials for accessing the database
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3f On the Counters tab, for the four required performance and utilization data categories,
provide counter formulas for the system to use when converting HP Reporter metrics to
PlateSpin Recon counters. For more information, see Section 3.10.1, “Using Formulas to
Convert Metrics to Counters,” on page 64.

3g Click OK.
The new site is added to Sites node in the Data Center Explorer.
4 TInventory the machines:

4a In the Data Center Explorer, right-click the remote site you created in Step 3, click Sites,
then click Inventory Machines.

The Inventory Machines in Site site_name dialog box is displayed.
4b Sclect the check boxes next to the machines you want to inventory.
4c Select the required credentials or select <New Credential> to add new credentials.
4d Click OK.
5 Synchronize site data:

5a In the Data Center Explorer, right-click the required site, click Sites, then click
Synchronize Data.

5b Select the check boxes next to the required machines. To select all machines in a site,
select the check box next to the site.

5¢ Select required data range, scheduling, and recurrence options.
5d Click OK.

For in-depth information about using PlateSpin Recon in conjunction with HP Reporter, see
Knowledge Base article Q21088 (http://support.platespin.com/kb2/article.aspx?id=21088).

3.11 Using Performance Data Import to Import
Generic Data into PlateSpin Recon

PlateSpin has developed a robust Performance Data Import connector for PlateSpin Recon that
allows users to import collected performance data from many third-party tools on the market into
PlateSpin Recon to take advantage of its charting, reporting, and consolidation planning features.

When collected data has been moved from its proprietary location and format into a set of tables in
the PlateSpin Recon monitoring database, PlateSpin Recon can import the data and make use of it
like any other performance data. You can also set up a scheduled or recurring import, so the
PlateSpin Recon analysis does not have to be a one-time thing.

Almost all performance data gathering tools use a different method and format for storing the
gathered data. To enable PlateSpin Recon to successfully import any data, regardless of its original
format, you need to use an Extract, Transform, and Load (ETL) tool. This type of tool takes the data,
reshapes it, and then loads it into the tables where PlateSpin Recon expects to find it. See

Section 3.11.2, “Preparing Data for Import into PlateSpin Recon,” on page 70.

The workloads in the data being imported need to be of the type that PlateSpin Recon can inventory
under normal circumstances. All necessary ports between PlateSpin Recon and the workload being
imported must be open.
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As with other remote data connectors, data to be imported should contain one or more data points
for every hour. Also, to use Consolidation Planning, specific counters need to exist in the data. See
Section 3.9.1, “Required Performance Counters,” on page 60.

¢ Section 3.11.1, “Performance Data Import Tables Data Structure,” on page 69

¢ Section 3.11.2, “Preparing Data for Import into PlateSpin Recon,” on page 70

3.11.1 Performance Data Import Tables Data Structure

There are four tables used for importing of generic performance data:

+ ImportComputer table: Contains information about computers that are to be imported into

PlateSpin Recon.

+ ImportCounter table: Contains information about all counters that were collected for any of
the computers in the ImportComputer table.

+ ImportCounterInstance table: Contains information about named instances of each counter
for each computer. The combination of Computer, Counter and Instance Name must be unique.

+ ImportData table: Contains monitoring data to be imported.

Each table contains one ID field, which acts as a primary key and is automatically generated by the
database server when a new row is inserted into the table.

Table 3-8 ImportComputer Table

Column Name Type Description
ID Integer Generated automatically.
Name varchar(255) Network name of computer.

This is the address or name of the computer. It allows
PlateSpin Recon to address the computer over the network.

Table 3-9 ImportCounter Table

Column Name Type Description
ID Integer Generated automatically.
Name varchar(255) Unique name of the counter.

This is the name of the counter as it will be shown in
PlateSpin Recon charts. Some predefined counter
names exist. See Section 3.9.1, “Required
Performance Counters,” on page 60.

Table 3-10 ImportCounterinstance Table

Column Name Type

Description

ID Integer

Generated automatically.

Working with Data Center Explorer

69



Column Name Type Description

Computer Integer Reference to the ImportComputer table.

Counter Integer Reference to the ImportCounter table.

InstanceName Integer Name of the given counter instance on the specific
computer.

Table 3-11 ImportData Table

Column Name Type Description
ID Integer Generated automatically.
Instance Integer Tells PlateSpin Recon for which computer, counter and

counter instance this data value was collected.
ObservationDate DateTime Time the data was collected.

ObservationValue float Value of the counter.

3.11.2 Preparing Data for Import into PlateSpin Recon

To migrate data from a third-party location and format requires an Extract, Transform and Load
(ETL) tool. There are many such tools on the market:

Open Source: CloverETL, Enhydra* Octopus, Pentaho* Data Integration, and Talend Open Studio.

You can also write proprietary data manipulation scripts, such as SQL queries, although the specifics
of these tasks are beyond the scope of this document. For third-party tools, see the documentation
that accompanies those tools. For scripts, refer to your in-house reference material on the languages
and requirements.

Commercial: Informatica* PowerCenter*, Inaplex* Inaport*, and Altova* MapForce*.
Regardless of the tool you choose, the data transformation workflows are the same:
¢ Retrieve hostnames of the workloads you want to import and write them to the
ImportComputer table

+ Write the names of the required counters to the ImportCounter table
¢ Retrieve and write all performance data related to the above counters
To work with generic imported data:
1 Collect data in the required performance and utilization measurement categories. For more
information, see Section 3.9.1, “Required Performance Counters,” on page 60.

2 Extract, transform, and load the collected performance data into the PlateSpin Recon
Performance Data Import tables.

For more information, see Section 3.11, “Using Performance Data Import to Import Generic
Data into PlateSpin Recon,” on page 68, Section 3.11.1, “Performance Data Import Tables Data
Structure,” on page 69 and Section 3.11.2, “Preparing Data for Import into PlateSpin Recon,”
on page 70.
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3 Create a new Remote site for connecting to the Performance Data Import tables:
3a Right-click in the Data Center Explorer, click Sites, then click Add Site.
The Add Site dialog box is displayed.

Add Site X

Mame: Type:
| My Site | |Remc:te W |
Description:

Connector Type: | Performance Data Import bt

[] Delete temporary data from import tables when job completes?

ok || Cancel

3b Specify a name and, optionally, a description.

3¢ In the Type drop-down, select Remote.

3d In the Connector Type drop-down list, select Performance Data Import.
The Delete data from tables when done? check box is displayed.

3e To empty the Performance Data Import tables of the data loaded in Step 2, select the
Delete data from tables when done? check box.

If you choose not to allow PlateSpin Recon to empty these tables, you must manually do
this before performing another import.

3f Click OK

The new site is added to Sites node in the Data Center Explorer.
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4 TInventory the machines:

4a In the Data Center Explorer, right-click the remote site you created in Step 3, click Sites,
then click Inventory Machines.

The Inventory Machines in Site sitename dialog box is displayed.
4b Seclect the check boxes next to the machines you want to inventory.
4c Select the required credentials or select <New Credential> to add new credentials.
4d Click OK.
5 Synchronize site data:

5a In the Data Center Explorer, right-click the required site, click Sites, then click
Synchronize Data.

5b Select the check boxes next to the required machines. To select all machines in a site,
select the check box next to the site.

5¢c Select required data range, scheduling, and recurrence options.

To perform a recurring import, you need to also set up a matching recurring Extract,
Transform, and Load process to refresh the data in the PlateSpin Recon Performance Data
Import tables. For detailed information, see your software vendor documentation.

5d Click OK.
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PlateSpin Recon Server and Client
Tools

This section provides information about Novell® PlateSpin® Recon utilities which enable you to
better manage login credentials, analyze data center assets, and monitor operations.

¢ Section 4.1, “Server and Client Options,” on page 73
¢ Section 4.2, “Credentials Manager,” on page 73

¢ Section 4.3, “PlateSpin Analyzer,” on page 75

4.1 Server and Client Options

Server and Client settings are available in the Options dialog box (Tools > Options). It is highly
recommended that you leave the Server settings as is and ONLY change their values when directed
to do so by Novell PlateSpin Technical Support.

You can configure some Client settings. For instance, it might be necessary to specify a path for
various external applications or to change the option to check for a software update.

To reset Server and Client options to their default values, click Reset All.

4.2 Credentials Manager

Use the Credentials Manager to create and manage the credentials required to access servers. You
can create new credentials, delete saved credentials, or edit credentials in the Credentials Manager
dialog box.

Figure 4-1 Credentials Manager dialog box

Credentials Manager

Credentials [localsystemadministratar)
dernotAdministrator ~ =
[=) loalhostsadminiztrator Usemame: | localsystemiadministrator
CZWINNT-5PES
b drministrator Password
Iocalsyslem'\.&dm!n!stralor Validation Type: ‘windaws Iventary P
[=) localzpztem'd dministrator
= MHAVT Hostrame ar IP of machine to validate against:
= WFTEST13 .
&= WFTEST14 MH-AC [ Tes O
= WFTEST15
=) WFTEST1E Diescription
= WFTESTTY localzpstemplatespin
= WFTEST18
= WFTEST19
= WFTEST2
= WwFTESTZ0 %
save | [ Close
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4.2.1 Creating a Credential

1 In the PlateSpin Recon Client, click the Tools menu > Credential Manager.
The Credential Manager window is displayed.
2 Click the New icon [33.

3 In the Credentials pane, specify the username and password.

NOTE: If you want to add a Windows Inventory credential, you must specify the domain name
along with the username in any of the following formats: domain _name\username or
username@domain name. For example, platespin\reconuser.

4 1In the Validation Type drop-down list, select the validation type appropriate to the platform.
The available options are Windows Inventory, Unix Inventory, Virtual Center Inventory,
VMware ESX3/4 Inventory, Novell Netware Inventory, NetWare LSA, Citrix XenServer
Inventory, Database or Other.

By default, Other is selected

5 (Optional) Specify the hostname or the IP address of the machine to validate the credentials
against. Click Test to validate the specified credentials.

6 (Optional) To distinguish the credentials from other credentials with identical user names,
specify a description.

7 Click Save to store the credentials.

The credential is stored in Recon, and is listed in the left pane of the Credential Manager.
8 (Optional) To add a new credential, repeat Step 1 through Step 7.
9 Click Close.

4.2.2 Deleting a Credential

You can delete a credential only if it is not assigned to a server.

NOTE: If credentials are assigned to servers, a plus sign (+) is displayed next to them in the left
pane. To see which machines have those credentials assigned to them, click the plus sign or double-
click the credential.

To delete a credential:

1 In the PlateSpin Recon Client, click the Tools menu > Credential Manager.
The Credential Manager window is displayed.
2 Delete the credential in any of the following ways:

« In the left pane, select the credential you want to delete, then click the Delete icon g or
press the Delete key.

¢ In the left pane, right-click the credential you want to delete, then click Delete.
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4.3 PlateSpin Analyzer

The PlateSpin Analyzer quickly analyzes networks and determines whether PlateSpin Recon can
successfully inventory, monitor, or convert the specified Windows and UNIX/Linux servers. It

performs two different types of tests: Inventory and Conversion.

¢ Section 4.3.1, “Using PlateSpin Analyzer,” on page 75

¢ Section 4.3.2, “Inventory and Monitoring Tests,” on page 77

¢ Section 4.3.3, “Conversion Tests,” on page 78

4.3.1 Using PlateSpin Analyzer

1 Click Tools > Analyze Servers.

The PlateSpin Analyzer window is displayed.

2 In the Select Credential drop-down list, you can choose to add a new credential or to use the
credentials and machines specified in a CSV file.

If you choose to create a new credential, continue with Step 3. If you choose to use the CSV

file, skip to Step 4.

3 (Conditional) If you chose to create a new credential in Step 2, do the following:

3a In the Create Stored Credentials dialog box, specify the username and password.

Figure 4-2 Create Stored Credentials dialog box

Create Stored Credentials [

Credentials

Username:

Password:

Walidation Type:

152.168.210.50

Description
CompS0 credentiald

comp50&dministrator

Windows Test w

Hastname or IF of machine to validate against

Test G

[ Save H Cancel ]

NOTE: If you want to analyze Windows machine, you must specify the domain name or
the host name along with the username in the following formats: domain_name\username
or hostname\username.

3b In the Validation Type drop-down box, select Windows Test or Unix Test.
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PlateSpin Analyzer does not support analysis of Unix or Linux servers, but they can be
used for credential validation.

3¢ (Optional) Type a description for the credentials.
3d Click Save.

NOTE: If Save is disabled, verify that the credentials are entered in the correct format.

3e In the Domain Name drop-down list, select one of the available options: Domain Name,
IP/Host Name, IP Range.

3f Type a value in the empty field appropriate for the selection in Step 3e. For example, if
you selected Domain Name, enter your domain name.

3g Continue with Step 5.

4 (Conditional) If you chose to use the credentials and machines specified in a CSV file in Step 2,
type the complete path of the CSV file in the empty field. You can use the adjacent browse
button to browse for and select the file.

Ensure to follow these guidelines as you work with the CSV file:
¢ The values must be specified in the following order:

Hostname or IP address
<Hostname or IP address or domain name>\Username
Password
Description
Platform
TRUE or FALSE

+ [t is mandatory to specify the TRUE or FALSE value for UNIX and Windows platforms in
the CSV file. However, the value is considered only for the UNIX platform, and is ignored
for the Windows platform. If you specify the value as TRUE for a UNIX platform, then
the sudo privileges are assigned to the specified user.

+ FEach line must contain the custom fields for a machine.

+ The value for the Machine custom field can be IP address or the hostname; however, it
must be unique.

¢ The values on each line must be separated by a delimiter such as a comma ().
A sample CSV file is as follows:
DEV-SINISAR, platespin\userl, abc, Description test, Windows, FALSE

5 Click Analyze and wait for the process to complete.
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Figure 4-3 PlateSpin Analyzer - Analysis
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When the analysis is complete, the left pane displays either Passed or Failed. To view result
details, click the 7est Results tab in the right pane. If any of the tests returned a failed result, you
must resolve the cause before PlateSpin Recon can successfully inventory the host. A failed result
typically indicates that there are insufficient permissions a or that the required services are not

running.

4.3.2 Inventory and Monitoring Tests

Inventory tests are divided into three main groups, each containing a subset of tests.

Table 4-1 Inventory Test groups

Main Test Group Test Group Subset

Description

Permission Service Manager Access
File Access

Connection RPC Connection Channel

Service WMI Service

Remote Registry Service

RPC Service

Verifies that the user has permission to open
the Service Manager.

Verifies that the correct access permission is
granted on the System32 directory of the
machine being inventoried.

Determines whether an RPC connection
channel can be established by resolving the
DNS/NETBIOS name.

Determines whether the WMI (Windows
Management Instrumentation) service is
enabled and running on the client machine(s)
being inventoried.

Verifies that the Remote Registry Service is
enabled on the client machine(s).

Verifies that the RPC (Remote Procedure Call)
Service is enabled on the client machine(s).
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Monitoring tests are divided into two main groups, each containing a subset of tests:

Table 4-2 Monitoring test groups

Service RPC Service Verifies that the RPC service is running on the client
machine(s).
DCOM Service Verifies that the DCOM service is running on the client
machine(s).
Port TCP Port 135 Determines whether TCP port 135 and 445 are

available. To obtain more conclusive information,
consider running Port Scanner for all TCP ports above
1024.

TCP Port 445

4.3.3 Conversion Tests
Conversion Tests are similar to those performed by the PlateSpin Portability Suite PlateSpin

Analyzer tool. For more information, refer to Knowledge Base article Q20478 (http://
support.platespin.com/kb2/article.aspx?id=20478).
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Generating and Viewing Charts
and Reports

When PlateSpin® Recon has collected inventory and monitoring data, the data can be displayed for
analysis in charts or customizable reports. The Chart Viewer and the Report Explorer display
collected information in a variety of formats.

¢ Section 5.1, “Chart Viewer,” on page 79

¢ Section 5.2, “Report Explorer,” on page 83

¢ Section 5.3, “Editing Report Templates,” on page 88

¢ Section 5.4, “View Customization,” on page 96

¢ Section 5.5, “Generating Reports,” on page 100

¢ Section 5.6, “Document Viewer,” on page 104

5.1 Chart Viewer

Charts provide a graphical representation of workload and utilization data. To view a chart for a
given server, select the server in the Data Center Explorer or click a cell belonging to the server in a
report view. You can also select several servers in the Data Center Explorer (hold down Ctrl or Shift
while you select the servers) to render charts for multiple servers. In this case, a chart is not
automatically rendered, but a Create Chart button is displayed in the Chart Viewer. Click Create
Chart to render the chart.

Review the following sections to work with charts:

¢ Section 5.1.1, “Chart Controls and Commands,” on page 80
¢ Section 5.1.2, “Expression Types,” on page 81

¢ Section 5.1.3, “Level of Detail,” on page 81

+ Section 5.1.4, “Data Type Statistics,” on page 82

¢ Section 5.1.5, “Server Instance,” on page 82

¢ Section 5.1.6, “Date Range Presets,” on page 82

¢ Section 5.1.7, “Forecasting,” on page 82

All times displayed in the Chart Viewer are local times. Times shown in reports are in UTC time.
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5.1.1 Chart Controls and Commands

Figure 5-1 Chart Controls
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Table 5-1 Chart Viewer Commands

Command Description
3l
=1 Print Preview. Preview chart before printing.

.

Print. Print the chart.

Copy To Clipboard. Copy the chart to the clipboard.

Line. Display straight lines between points of continuous data.
Curve. Display curved lines between points of continuous data.

Candlestick. View the variability of sample data. This button appears only for the candle
chart.

Stacked Bar. View cumulative workload data from multiple servers. This is enabled for
Expression types other than Utilization.

Stacked Area. View cumulative workload data from multiple servers. This is enabled for
Expression types other than Utilization.

M K E EEEDX

Legend Box. Give a visual cue and description for each data object. The legend is very
useful for quickly glancing through the data on a chart.

s Point Labels. Display labels for the values in a chart.
& Zoom. Switch between normal and magnified view.
'ﬁ' G Zoom In/Out. Adjust the granularity of the chart for the collected data. See

Section 5.1.3, “Level of Detail,” on page 81.
K < > Navigate Beginning/Back/Forward/End. Scroll the visible data.

I Historical Data Settings. Select the historical data time range upon which to base
forecasting.
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Command

Description

S

Forecast Settings. Select the forecasting time period and algorithm.

This button is only enabled for daily or weekly Series charts or for Profile charts.

Refresh All Data From Server. Refresh the view.

5.1.2 Expression Types

Expressions are individual data series that can be viewed on the currently displayed chart. Select an
available Type/Expression combination and the chart is rendered to display the new metrics. The list
of available expressions varies depending on the expression type and machine selected.

Table 5-2 Expression types

Type Expressions Available Description

Workload For a complete list of The operating system, applications, and data stack
expressions available for running on a server, with the quantified dimensions
Workload, see Section B.4.3, of Processor Speed, Memory, Disk Space, Network,
“Workload,” on page 174. and Time.

Utilization For a complete list of Characterizes the fit between workload and
expressions available for resources (% utilization).
Utilization, see Section B.4.2,
“Utilization,” on page 172.

Counter Counter values are named for  Primitive measure of performance collected from the

the Windows Performance
Monitor counters used to
retrieve them from Windows
systems. The name consists of
the Performance Monitor
category joined by an
underscore to the counter
name. For example, Memory/
PagesPerSecond becomes
Memory_PagesPerSecond.

For a complete list of the
available counters, see
“Platform Counters” on
page 169.

operating system.

5.1.3 Level of Detail

From the drop-down list, select from the following levels of granularity (in terms of time) for

collected data:

¢ 5 Min: Averages of data collected during five-minute intervals. (Series charts only.)

¢ 1 Hour: Summaries of data collected during one-hour intervals. (Series and Candle charts

only.)
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¢ 1 Day: Characterizes workloads over a day. This comprises 24 values that correspond to each
hour of the day (0 to 23). Each value is calculated by taking the peak value from all values
observed for that hour. (All chart types.)

+ 1 Week: Characterizes workloads over a week. (All chart types.)

5.1.4 Data Type Statistics

The following data type statistics are collected for each hour and are available for selection when a 1
hour or higher zoom level is selected: This option is available only for series charts.

+ AVG: Average of all values.

¢+ MAX: Maximum sustained load.

¢ MIN: Minimum sustained load.

¢ STDEV: Standard deviation.

NOTE: Standard deviation is not calculated for Virtual Center counters.

¢ Peak AVG: : (1 Day or 1 Week only) Peak average represents the averages of the values for the
highest period for each 12-hour interval or each day in the reporting period.

5.1.5 Server Instance

Click the drop-down list to see all the instances of the currently selected resource (expression).
Select each instance to see chart data for that resource. If multiple servers were used to render the
chart, all instances of the resources for all servers are displayed. The instances are displayed as
legends in the Series and Profile charts, and in the drop-down list located in the tool bar for candle
charts.

5.1.6 Date Range Presets

Select from the drop-down list Last 3 days, Last 7 days, Last Month, or All Data. Select <Custom>
to open the Advanced Date Filter Settings dialog box for more specific date range options.

5.1.7 Forecasting

Forecasting is available for series and profile charts, for the 1 day and 1 week level of detail. At least
three days of monitoring data are necessary to use forecasting in charts.

To add forecasting to a chart view:

1 Display a Profile chart.
2 Click the Date Range drop-down list and select a time period to base the forecast on.
3 (Optional) Click Historical Data Settings T for advanced date filter settings.

The Advanced Date Filter Settings dialog box is displayed. Choose any desired settings and
click OK.

4 Click the Forecast Period drop-down list and select a time period for the forecast.

5 (Optional) Click Forecast Settings il for advanced custom forecast settings.
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The Advanced Forecast Settings dialog box is displayed. Choose any desired settings and click
OK.

6 Click the Forecast > Trend drop-down list and select a forecast trend or regression method.

5.2 Report Explorer

The Report Explorer is used to organize and generate reports.

¢ Section 5.2.1, “Report Explorer Template Nodes,” on page 83

*

Section 5.2.2, “Commands,” on page 86

*

Section 5.2.3, “Analysis Reports,” on page 87

*

Section 5.2.4, “Working with Report Templates,” on page 87

5.2.1 Report Explorer Template Nodes

The Report Explorer hierarchy consists of template nodes that have various types of report
templates.
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Table 5-3 Report Explorer Template Nodes

Template Node Report Templates Node Description

Analysis Application - Exchange Workloads  For reporting dynamic data such as hardware
utilization and workload sizes.
Application - SQL Server Workloads
Disk - Average 30 Day Forecast
Disk - Peak

Hardware Utilization - Average 30
Day Forecast

Hardware Utilization - Peak
Memory - Average 30 Day Forecast
Memory - Overutilized

Memory - Peak

Memory - Underutilized

Network -Average 30 Day Forecast
Network - Peak

Processor - Average 30 Day
Forecast

Processor - Overutilized
Processor - Peak

Processor - Underutilized
Resource Utilization Trend
Volume Utilization - Average
Volume Utilization - Peak

Workload Size - Average 30 Day
Forecast

Workload Size - Peak

Chargeback Cost Allocation For reporting the transfer of charges incurred
by the IT department back to the business units
that are using services. See Section 7.4,
“Chargeback Reporting,” on page 151.

Consolidation Project For reporting on projects, scenarios, and
) servers in the Consolidation Planning Module.
Scenario Summary See Section 6.7, “Viewing Consolidation

Reports,” on page 136 for information on how

Workload Assignment to use templates within this node.

84 PlateSpin Recon 3.7.1 User Guide



Template Node

Report Templates

Node Description

Consolidation
Project Samples

Good Consolidation Candidates
Inventory Summary
Poor Consolidation Candidates
Utilization Summary

Workload List with Conditional
Formatting

Commonly used sample consolidation reports.

Diagnostics Error Report For diagnosing errors that cause monitoring
data to be missing from a chart.
Missing Data - Detailed
Missing Data - Summary
Disk Disk Allocation The Disk Allocation report is generated based
on the last collected monitored data.
Disk Inventory
For reporting the size and type of physical
disks on machines.
Inventory Hardware - Obsolete For reporting static data such as operating
system, processor speed, memory, disk space,
Hardware Inventory network, power, and cooling.
Power and Cooling
Virtual Machine Server Candidates
Virtual Machine State
VM Files Report
VM Snapshots Report
VM Sprawl! Report
Reclamation Disk Reclamation For reporting on elements that can be
] reclaimed to ensure efficient use of resources.
Memory Reclamation
Powered On VMs Reclamation
Volume Reclamation
Software Application > Application Inventory  For reporting installed applications, services,

Application Complete > Application
Complete Inventory

Processes > Process Inventory
Service > Service Inventory

Service Complete > Service
Complete Inventory

and running processes.
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Template Node Report Templates Node Description
Virtual Cluster Configuration For reporting on virtual machines and virtual
Infrastructure machine hosts.
Resource Pool Configuration
VI Configuration
VirtualCenter Report
VM Cluster
VM Details Report
VM Resource Pool
VM Virtual Infrastructure
Volume Volume Inventory For reporting the space and file system
associated with each logical volume on
machines.

As shown in Table 5-3 on page 84, within each report node are one or more templates that you can
use as is or that you can customize with sorting, filtering, and view selection options. You can add
additional Analysis, Chargeback, Disk, Inventory, Software, and Volume report templates.

5.2.2 Commands

The following Report Explorer commands are accessible by right-clicking a report template or a

generated report:

Table 5-4 Report Explorer Commands

Commands

Tooltip/Description

-

gl @ Ao

el

Create Report Template. Create a new report template based on the report node
selected.

Copy Report Template. Copy a report template.

Edit Report Template. Edit a report by setting group, views, filters, summaries, and
forecasts for a report template or a report.

Generate Report. Generate a report based on the report template selected.
View Report. View an existing (previously generated) report.

Send Report. Send a generated report via e-mail or to an FTP server or network
location.

Delete. Delete the selected report or template.
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5.2.3 Analysis Reports

Analysis reports use dynamic data such as hardware utilization and workload sizes. To view
workloads or utilization of servers that are being monitored, generate an Analysis report. The report
is displayed with historical data, which is useful for getting a single value (maximum, minimum,
peak, average) for expressions over a specified period of time. Use this data to identify over-utilized
or under-utilized server resources.

NOTE: Data must be collected for at least one hour before Analysis reports are generated. If there is
insufficient data, the report is displayed without dynamic data.

To get detailed historical data for each data point, click the report cell to view the related detailed
chart.

Machines without monitoring data are included in Analysis reports by default to allow complete
analysis of all inventoried machines.

Figure 5-2 Sample Analysis Report

Hardware Utilization - Peak

ot Speet “
S =TI |
13

DEV-YONINAJ Windows YP 2048.0 a3 39900 852

Machine

DEV-PREETS: Windews 2003 2048.0 388 16 5984.0 28 16
DEV-NADERS Windews 2003 2048.0 434 18 39900 38 19
DEV-CYRILM Windows 2005 2040.0 152 14 37400 34 13
DEV-TONYL Windows 2005 35840 613 16 B384.0 253 18
DEV-MICHAELE Windows P 2043.0 941 18 B384.0 122 13
DEV-MRAG Windiows 2003 2048.0 936 19 5984.0 78 19
DEV-EDWiARDC Winciows 2003 2048.0 74 15 39800 18 15
DEV-TONYP Windews 2003 2048.0 852 21 39900 174 18
DEV-MRCEAA Windows 4P 2048.0 s65 20 3994.0 265 16
DEV-ARIG Windows 2003 (54 hit) 4032.0 e 15 53200 33 13
DEV-MILSONT Windows 2005 2048.0 an0e 20 37400 389 10

DEV-GEORGED Windows 2003 30720 732 19 39900 241 13

5.2.4 Working with Report Templates

¢ “Creating a Report Template” on page 87
¢ “Copying a Report Template” on page 88
¢ “Deleting a Report Template” on page 88

Creating a Report Template
1 Right-click the report type node in the Report Explorer for the type of report that you want to
create, then select Create Report Template from the menu.
The Create Report Template dialog box is displayed.

2 Define the template settings, using the procedures and guidelines for editing an existing
template. See Section 5.3, “Editing Report Templates,” on page 88.

3 Click OK.
The new template is displayed under the report type node in the Report Explorer.
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Copying a Report Template
1 Right-click the report template you want to copy in the Report Explorer and select Copy Report
Template from the menu.
The Edit Report Template dialog box is displayed with (copy) added to the template name.
2 (Optional) Edit the template name.
3 Click OK.
The new copy of the template is displayed in the Report Explorer.

Deleting a Report Template
1 Right-click the report template you want to delete in the Report Explorer and select Delete
from the menu.
The Confirm Delete dialog box is displayed.
2 Click OK.
The report template is removed from the Report Explorer.

5.3 Editing Report Templates

PlateSpin Recon includes a library of standard, predefined templates available for generating
reports. Templates specify the content to include in a report and the form in which the content is
presented.

¢ Section 5.3.1, “Report Template Option Tabs,” on page 89

¢ Section 5.3.2, “Chargeback Report Templates,” on page 93

¢ Section 5.3.3, “Consolidation Report Templates,” on page 93

¢ Section 5.3.4, “Consolidation Project Samples Report Templates,” on page 94

¢ Section 5.3.5, “Diagnostics Report Templates,” on page 94

¢ Section 5.3.6, “Disk Report Templates,” on page 94

¢ Section 5.3.7, “Inventory Report Templates,” on page 95

¢ Section 5.3.8, “Reclamation Report Templates,” on page 95

¢ Section 5.3.9, “Software Report Templates,” on page 95

¢ Section 5.3.10, “Virtual Infrastructure Report Templates,” on page 95

¢ Section 5.3.11, “Volume Report Templates,” on page 96
PlateSpin Recon reporting capabilities allow for the customization of most report templates to meet
specific business requirements. You can configure the content and summaries included in most

reports, as well as the time frame, report presentation, and a number of other elements. Users can
save modified templates and generate reports from them.

For all reports except Consolidation reports, you can copy the template and then edit each copy. This
preserves the original. Use the modified templates to generate alternate reports.

To edit a report template, right-click the template and select Edit Report Template from the menu.
The Edit Report Template dialog box is displayed.

88 PlateSpin Recon 3.7.1 User Guide



5.3.1 Report Template Option Tabs

The options available for customizing report templates vary depending on the type of report
template selected.
¢ “Group Tab” on page 89
* “Views Tab” on page 89
¢ “Field Filter Tab” on page 89
¢ “Row Filter Tab” on page 91
¢ “Columns Tab” on page 91
¢ “Time Period Tab” on page 91
¢ “Options Tab” on page 92
¢ “Date Filter Tab” on page 92
¢ “Summaries Tab” on page 92

+ “Forecast Tab” on page 93

Group Tab

Allows you to select filters or groups of servers to include in the report. See Section 3.4, “Working
with Groups,” on page 50 for more information.

Views Tab

This tab displays the views available for the report, including default and previously created views.
Use the arrow buttons to reorder the views. Use the check boxes in the Visible column to determine
which views to display in the report.

To add another view to a report, click Add. To edit an existing view, select it and click Edit. For more
information, see Section 5.4.1, “Creating and Editing Report Views,” on page 96. To delete a view,
select it and click Delete.

Field Filter Tab

You can filter servers based on the constraints you set and use expressions to specify how the
constraints should be used and interpreted to narrow or expand the report contents.
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Figure 5-3 Field Filter Tub
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To add a query statement:

1 Enter query constraints in the fields and drop-down lists at the top of the Field Filter page.

There might not be a units field or drop-down list, depending on the resource selected in the
first drop-down list.

2 Click Add.
The query statement is added to the list of queries.

To edit a query statement:

Select the query statement.
2 Click Edit.

The query settings are copied to the fields at the top of the page.
3 Edit the settings as desired.
4 Click Add.

The selected query statement is updated with the new settings.
To remove a query statement:

1 Select the query statement you want to delete.
2 Click Remove.
The selected query statement is deleted.
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The filter expression determines how the query statements are evaluated.

Filters affect which servers are made available for a report views.

Table 5-5 Filter Expressions

Filter Expression Description

AND All query statements must be true for a server to be added to the gathered
pool of servers. For example, if there are several query statements, the first
one is evaluated to gather some servers. Then the second query statement is
evaluated against the gathered servers, removing any from the pool that
don’t agree with the new query statement. This continues through all the
query statements.

OR All query statements are evaluated individually. For example, if there are
several query statements, the first one is evaluated to gather some servers.
Then the second query statement is evaluated adding any new servers not
gathered by the first statement to the pool of gathered servers. This
continues through all the query statements.

Custom A Custom expression allows you to specify how to evaluate the query
statements. A mixture of OR and AND criteria can be used. You can use
parentheses to control the evaluation. Use the query statement ID numbers
in your expression.

If Custom is selected, the accompanying field cannot be empty.

Select the Filter out empty values check box if you want to exclude machines that have null values
for the fields included in the specified query.

Row Filter Tab

Used to determine which rows are included or excluded from the report. This is different from Field
Filter tabs, which control which machines are included or excluded from the report, but the
guidelines for managing Field Filter criteria can also be applied here See “Field Filter Tab” on
page 89.

This option is available only for the Application Complete and Software Complete reports.

Columns Tab

Allows you to customize the columns displayed in the reports generated, based on these templates.
See Step 1 on page 105 for more information on the settings in this page.

This option is available only for the software report templates.

Time Period Tab

Allows you to specify the time period to use for these reports. The settings on this page are the same
as the top part of the Date Filter page. See “Date Filter Tab” on page 92 and Section 5.3.5,
“Diagnostics Report Templates,” on page 94.

This option is available only for the diagnostic report templates.
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Options Tab

Allows you to specify the counter setting report mode for these reports. See Section 5.3.5,
“Diagnostics Report Templates,” on page 94.

This option is available only for the missing data diagnostic report templates.

Date Filter Tab

Use this tab to set the date and time range for calculating summary data values in a report. For
example, select the Last 1 Month(s) collection range, Monday to Friday, and 9:00 AM to 5:00 PM to
view workload data summarized over business hours for all servers that are monitored:

Figure 5-4 Date Filter Tub
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Summaries Tab

Summarizes average (AVG), maximum (MAX), minimum (MIN) and standard deviation (STDEV)
data types. AVG data can be calculated by Average, Peak Hour, or Total of the data collected.

Calculation types:

¢ Average: Average of all hourly values across business days and business hours.
¢ Peak Hour: A calculation based on the highest hourly value.

¢ Total: Sums all the data points in the time frame. For example, Disk 10s per second, for a 1-
hour period equates to 10 disk 1Os per second X 60 seconds X 60 minutes = 36000. Select the
Summary Rows column in the report to display the columns containing calculated data.
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Forecast Tab

Projects workloads and utilization into the future based on summary data for a historical period.
This lets data center architects anticipate future needs and plan accordingly.

Figure 5-5 Forecast Tab
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5.3.2 Chargeback Report Templates

Edit Chargeback report templates in the same way as Analysis report templates. See Section 5.3.1,
“Report Template Option Tabs,” on page 89 for information about the Group, Views, and Field
Filter tabs.

Chargeback reports support only table views. See “Creating and Editing a Table View” on page 97
for information about table views. See Section 5.2.4, “Working with Report Templates,” on page 87
for information about the Date Filter, Summaries and Forecast tabs.

5.3.3 Consolidation Report Templates

Project, Scenario Summary, and Workload Assignment reports are based on editable templates.
Unlike Inventory and Analysis report templates, there is only one version of a given Consolidation
report template available at a time. Edit the template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.

2 Select the required report columns, data sorting options, and summary rows, then click Save.
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For more detailed information on the other configuration options of the consolidation report
template, see Section 5.6.2, “Customizing Reports,” on page 105.

5.3.4 Consolidation Project Samples Report Templates

Consolidation Project Samples reports are based on editable templates. The templates can be copied
or edited. Edit the template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.

2 Select the required report columns, data sorting options, and summary rows, then click Save.
For information on the option tabs, see Section 5.3.1, “Report Template Option Tabs,” on
page 89.

For more detailed information on the other configuration options of the Consolidation Project
Samples report templates, see Section 5.6.2, “Customizing Reports,” on page 105.

5.3.5 Diagnostics Report Templates

Edit Diagnostics report templates by changing options in the Edit Report Template dialog box. To
access this dialog box, right-click a Diagnostics report template in the Report Explorer, and on the
menu, click Edit Report Template.

The available dialog box tabs depend on the Diagnostics report template selected:

¢ Group: See “Group Tab” on page 89.
¢ Views: See Section 5.4.1, “Creating and Editing Report Views,” on page 96.

¢ Time Period: Select a time period upon which to base the report. Any intervals during that
time period that are missing data are included in the report.

¢ Options: For Missing Data reports only. Select a Report Mode to determine which intervals to
include in the report:

¢ Online: Includes intervals during which all counters are missing data.
¢ CPM: Includes intervals during which CPM counters are missing data.

¢ Full: Includes intervals during which any counter is missing data.

5.3.6 Disk Report Templates

Disk reports are based on editable templates. The templates can be copied or edited. Edit the
template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.

2 Select the required report columns, data sorting options, and summary rows, then click Save.
For more information on the option tabs, see Section 5.3.1, “Report Template Option Tabs,” on
page 89.

For more detailed information on the other configuration options of the Disk report templates, see
Section 5.6.2, “Customizing Reports,” on page 105.
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5.3.7 Inventory Report Templates

Inventory reports are based on editable templates. The templates can be copied or edited. Edit the
template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.

2 Select the required report columns, data sorting options, and summary rows, then click Save.
For more information on the option tabs, see Section 5.3.1, “Report Template Option Tabs,” on
page 89.

For more detailed information on the other configuration options of the Inventory report templates,
see Section 5.6.2, “Customizing Reports,” on page 105.

5.3.8 Reclamation Report Templates

Reclamation reports are based on editable templates. The templates can be copied or edited. Edit the
template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.
2 Select the required report columns, data sorting options, and summary rows, then click Save.

For more detailed information on the other configuration options of the Reclamation report
templates, see Section 5.6.2, “Customizing Reports,” on page 105.

5.3.9 Software Report Templates

Software reports are based on editable templates. The templates can be copied or edited. Edit the
template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.

2 Select the required report columns, data sorting options, and summary rows, then click Save.
For more information on the option tabs, see Section 5.3.1, “Report Template Option Tabs,” on
page 89.

For more detailed information on the other configuration options of the Software report templates,
see Section 5.6.2, “Customizing Reports,” on page 105.

5.3.10 Virtual Infrastructure Report Templates

Virtual Infrastructure reports are based on editable templates. The templates can be copied or edited.
Edit the template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.

2 Select the required report columns, data sorting options, and summary rows, then click Save.
For more information on the option tabs, see Section 5.3.1, “Report Template Option Tabs,” on
page 89.
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For more detailed information on the other configuration options of the Virtual Infrastructure report
templates, see Section 5.6.2, “Customizing Reports,” on page 105.

5.3.11 Volume Report Templates

Volume reports are based on editable templates. The templates can be copied or edited. Edit the
template as desired before viewing the report.

1 In the Report Explorer, right-click the desired report template, then click Edit Report Template.
The appropriate Default Settings dialog box is displayed.

2 Select the required report columns, data sorting options, and summary rows, then click Save.
For more information on the option tabs, see Section 5.3.1, “Report Template Option Tabs,” on
page 89.

For more detailed information on the other configuration options of the Volume report templates, see
Section 5.6.2, “Customizing Reports,” on page 105.

5.4 View Customization

This section discusses the customization of report views, specifically table and chart views.

¢ Section 5.4.1, “Creating and Editing Report Views,” on page 96
¢ Section 5.4.2, “Histogram Charts,” on page 98

¢ Section 5.4.3, “Scatter Charts,” on page 99

¢ Section 5.4.4, “Usage Charts,” on page 100

5.4.1 Creating and Editing Report Views

¢ “Adding a View to a Report” on page 96

+ “Editing a Report View” on page 97

+ “Removing a View from a Report” on page 97

¢ “Creating and Editing a Table View” on page 97
¢ “Creating and Editing a Chart View” on page 97

Adding a View to a Report

1 From the Report Explorer, right-click the report template you want to customize and select Edit
Report Template.
The Edit Report Template dialog box is displayed.

2 Click the Views tab.
The Views page is displayed, showing any default or previously created views.

3 Click Add.
The Create View (Step 1: General Settings) dialog box is displayed.

4 Type a unique Name for the new view.

5 For Chart views, proceed to “Creating and Editing a Chart View” on page 97. For Table views,
proceed to “Creating and Editing a Table View” on page 97.
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Editing a Report View

1 Select a view on the Views page of the Edit Report Template dialog box.
2 Click Edit.
The Create View (Step 2: Customization) page is displayed for the view type selected.

3 For Chart views, proceed to “Creating and Editing a Chart View” on page 97. For Table views,
proceed to “Creating and Editing a Table View” on page 97.

Removing a View from a Report

1 Select a view on the Views page of the Edit Report Template dialog box.

2 To temporarily remove the view, deselect the Visible check box. To permanently remove the
view, click Delete.

3 Click OK.

Creating and Editing a Table View

1 Select Table in the Type area and click Next.
The Step 2: Customization page is displayed.
2 On the General tab, select the column titles to display in the report.

See Section 5.6.2, “Customizing Reports,” on page 105 for information on arranging columns,
conditional formatting, column sorting, and summary rows.

3 Use the Forecast tab to create forecast columns in the report view.

Create forecast columns and display: Clear the check box if forecast columns are not
required. When selected, this option enables the following column options:

¢ Original Values: Displays the original values.

¢ Change (%): Displays the percentage of change from the original values.

¢ Change (Units): Displays the change from original values in units.
Forecasting is only supported in table views.

4 Use the Groups tab to group rows in the table view. For information on report groups, see
“Adding or Modifying Groups” on page 107.

5 Use the Matrix tab to add Matrix columns to the table view. For information on report matrixes,
see “Adding or Modifying Matrixes” on page 107.

6 Click Finish to add the view to the list of available views in the Edit Report Template dialog
box.

Creating and Editing a Chart View

1 Select Chart in the Type area.

2 Select a chart type from the drop-down list (histogram, scatter chart, or usage chart. For
analysis reports only).

3 Select an expression from the drop-down list. The expressions listed vary depending on the
chart type selected.
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4 Click Next to display the view. For the histogram chart type, the Settings dialog box is
displayed. Use it to set various options as described in Section 5.4.2, “Histogram Charts,” on
page 98.

5 Click OK.
The Create View dialog box (Step 2: Customization page) is displayed, showing the view.

+ For a Scatter chart, the Chart View Settings dialog box is also displayed. Use it to set
various data, summary, and sort options as described in Section 5.4.3, “Scatter Charts,” on
page 99.

+ For an Analysis report, the Usage chart type is also available. Select Usage and click Next.
The Usage View Settings dialog box is displayed. Use it to set various options as
described in Section 5.4.4, “Usage Charts,” on page 100.

6 Click Customize to return to the chart-appropriate Settings dialog box and modify the specified
options.

7 Use the various buttons at the top of the chart in the Create View dialog box to print or modify
the chart.

8 Click Finish.

The view is displayed in the list of available views in the Edit Report Template dialog box.

5.4.2 Histogram Charts

In the Create View (Step 2: Customization) dialog box, click Customize to modify the contents of
the histogram.

The Settings dialog box is displayed.

Figure 5-6 Settings Dialog Box

Settings
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The default setting for the histogram includes five bins with a Step size of 1.
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Auto

Select Auto to specify a different number of Bins or Step sizes to be used in the histogram. Click
From palette to automatically generate colors for the histogram bars from the palette. Click Default
color to choose one default color for all histogram bars.

Customize

Select Customize to modify the upper or lower boundaries of any bin needing modification.
Optionally, specify custom labels and colors for the corresponding histogram bars.

Click the Insert button to insert a new bin below the currently highlighted bin. The appropriate Start,
End, and Label columns are automatically adjusted to accommodate the new bin, which can be
customized.

Click the Remove button to remove the currently highlighted bin. The appropriate Start, End, and
Label columns are automatically adjusted.

Select any number of consecutive or non-consecutive bins and click the Group button to group them
together. Enter the group's name in the Group column for any one of the bins. The name is
automatically assigned to all members of the group.

Click the check box to display the grouped bins as a single bin in the chart.

5.4.3 Scatter Charts

In the Create View (Step 2: Customization) dialog box, click the Customize button to modify the
contents of the scatter chart. The Chart View Settings dialog box is displayed.

Figure 5-7 Chart View Settings
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In the Data area, choose how much data to include in the chart. Select A// to include all data, or
select Top or Bottom to limit the chart to the highest or lowest values of data. For Top or Bottom,
specify the number of values, up to 25, to include.
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In the Summary area, select Mean and/or Median to include those lines in the chart. These values are

based on all data, not just displayed values.

In the Sort area, choose to sort the chart in ascending or descending order according to data quantity,

or alphabetically by hostname.
Click OK to display the chart.

5.4.4 Usage Charts

Usage charts are unique to Analysis report templates. In the Create View (Step 2: Customization)
dialog box, click Customize to modify the contents of the usage chart. The Usage View Settings

dialog box is displayed.

Figure 5-8 Usage View Settings
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Use the check boxes to determine which bars to include in the chart. If desired, use the drop-down
lists in the Color section to assign colors to the bars in the chart.

To move a bar to the left or to the right in the report, select it and use the up- or down-arrow. Click

OK to display the chart.

5.5 Generating Reports

1 Select the report template and click Generate
The Generate Report dialog box is displayed.
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Figure 5-9 Generate Report Dialog Box
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2 Select a delivery types for the report. By default, the report is delivered to the Report Explorer.

Other delivery options include:
+ Sending it by e-mail
+ Saving it to a network file
¢ Uploading it to an FTP server
3 Configure delivery options:

+ For the Email delivery option, click Email Options. The Email Delivery Options dialog

box is displayed.

Provide the requested information. Only one recipient is required in the 7o field, although

if you enter more than one, you need to separate the addresses with a semicolon. The CC
and BCC fields can be left blank. Any default values supplied for the Subject and Name
can be changed. The From Address is mandatory, but the Reply To address can be left
blank. The SMTP Server and SMTP Port are mandatory. Credentials are only optional if
they are not required for your SMTP server, which is unlikely.
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Email Delivery Options f'5__<|
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SMTP Port:
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¢ For the FTP and Network File delivery types, use the adjacent option buttons to open
dialog boxes and specify an FTP path or UNC/local folder path. Choose to have later
recurrences overwrite the report saved at that location, or append the date and time to the
specified filename so that previous reports are preserved.
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+ For delivery options other than Report Explorer, the default format for the report is PDF.
Additionally, there are several other available delivery formats.

If desired, select the option to compress the report in a ZIP file. Optionally, the file can be
password-protected.

You can also set options in the Schedule area to specify whether to generate the report
immediately, at a later time, or at a recurring interval. For information about scheduling
options, see Appendix C, “Schedule Options,” on page 185.

Click Generate.

Generating and Viewing Charts and Reports 103



When the report is generated, it is delivered using the delivery types specified. If this includes
Report Explorer, the report is cached for quick viewing at any time. An item is added to the
Report Explorer beneath the report template used to generate the report, named with the date
and time the report was generated.

NOTE: Only reports that have tables are successfully exported to Excel format. Reports that
contain histograms or charts cannot be exported to the Excel format.

To view a report, double-click the generated instance. The report is displayed in the Document
Viewer. For information, see Section 5.5, “Generating Reports,” on page 100. To delete a report,
right-click the report and select Delete Report on the menu.

5.6 Document Viewer

To display a report in the Document Viewer, generate a report from a report template and then
double-click the instance of the report or double-click a report instance you previously generated.
See Section 5.5, “Generating Reports,” on page 100.

Figure 5-10 Report Displayed in the Document Viewer
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A new tabbed page is added to the Document Viewer, showing the report through its first available
view. To switch to a different view, click the Views drop-down list and select a view. For more
information on views, see Section 5.4.1, “Creating and Editing Report Views,” on page 96.

Memory - Peak
Memory - Underutilized
Metwork - Averaae 30 Dav Forecast

¢ Section 5.6.1, “Commands,” on page 104

¢ Section 5.6.2, “Customizing Reports,” on page 105

*

Section 5.6.3, “Viewing Reports,” on page 108

*

Section 5.6.4, “Printing and Exporting Reports,” on page 109

*

Section 5.6.5, “Copying Servers from a Report to a Group,” on page 110

5.6.1 Commands

Table 5-6 Document Viewer Commands

Commands Tooltip/Description

Columns. Select columns content for viewing.

Groups. Add, or modify existing grouping in a report.

Matrix. Add or modify existing matrixes in a report.
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Commands Tooltip/Description

Copy to Group. Copy selected servers to a group.

al - Font Size. Change font size (small, medium, or large).
I !? 1

= =l

Print/Quick Print. Show the Print Options dialog box to allow you to pick a
printer and its settings, or just print the report immediately with the current
default printer and settings.

1 Search. Opens a Find dialog box for searching.

(=1 o --i-; . .
| 100% & i Zoom Out, Zoom Percent, Zoom In. Zoom in or out incrementally/

decrementally, or specify a zoom setting.

] Multiple Pages. Reduce the view zoom setting so you can view multiple pages
of the report simultaneously.

Color Background. Show a dialog box to allow you to set the background
color of the report.

Watermark. Show a dialog box where you can set a watermark for the report,
such as DRAFT, TOP SECRET or an image.

Wl - Export Document. Export to PDF, HTML, Text, CSV, MHT, Excel, RTF, or
Image formats.

=l - Send via Email. Send the report through e-mail as an attachment. The file is
saved locally first and then your default mail client is launched with the saved
file attached. Possible file formats are PDF, MHT, RTF, Excel, CSV, Text, or an
image format.

@ Exit. Close the report preview page.

5.6.2 Customizing Reports

After a report is generated, it can be further adjusted and customized. This includes revising which
columns to include in the report, changing the font, and adding or modifying grouping or matrixes.
These customizations are displayed in the Document Viewer and are included in the report when it is
exported, but are not saved to the template.

¢ “Customizing Columns” on page 105

¢ “Changing Report Font Size” on page 106

¢ “Adding or Modifying Groups” on page 107

+ “Adding or Modifying Matrixes” on page 107

Customizing Columns

1 Click Columns E in the Document Viewer.

The Report Column Selection dialog box is displayed.
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2 Select a column and use the arrow buttons to rearrange how it appears in the report (the higher
the column in the tree hierarchy, the more to the left it appears in the report). Conditional
formatting can be selected for numeric fields. Select custom colors and breakpoints, or use the
default settings.

The report will highlight the following:
+ All the values less than the Low Breakpoint with the Low Color
¢ All the values between the Low and High Breakpoints with the Mid Color
+ All the values greater than the High Breakpoint with the High Color.
Selecting Transparent leaves the values without highlights.

3 Sort the report by selecting a criterion from the Sort by drop-down list. Select Ascending or
Descending order. For grouped reports, this controls the order within the group, because the
whole report is sorted by the grouping column.

Optionally, add summary rows to the table by selecting from the check boxes in the Summary
Rows area. PlateSpin Recon calculates and displays the Count, Sum, Maximum, Average, or
Minimum for numeric columns.

Changing Report Font Size
1 Click Font @l - .in the Document Viewer. A drop-down menu is displayed, showing the
following options:
¢ Small Font
¢ Medium Font
¢ Large Font

Click the desired font size. The changes are applied to the report displayed in the Document
Viewer.
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Adding or Modifying Groups

1 Click Groups 2% in the Document Viewer.

The Report Group Settings dialog box is displayed.

Report Group Settings

Custom MyGroup Bins
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[ ok ][ cancel

2 Click Add next to the upper list box to enter a group name.
3 In the Custom <groupname> Bins area, select the element to group by from the drop-down list.
4 Do either of the following:

+ Select the option Automatically generate bins based on values.

¢ Click Add in the lower area to create and name a custom bin. Define an expression for
each custom bin.

5 Select the desired sorting order for the group.
Select the summary rows to include in the table. These summarize the values for each bin.

7 To modify a group or a bin, select its name and edit it or its associated settings. Alternatively,
click the appropriate Delete button to delete the group or bin.

8 Click OK.

Adding or Modifying Matrixes

1 Click Matrix % in the Document Viewer.
The Report Matrix Settings dialog box is displayed.
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2 In the upper list box, select elements for creating a matrix.
3 For each selected element, enter a Name for its matrix.
4 Do either of the following:
¢ Check Auto generate columns to create a column for each unique value of the element.

¢ Click Add to add custom columns. For each column, specify a name and define an
expression.

5 Check Use cell values from to specify a value to place in the appropriate matrix cells. If this
box is deselected, the values in the matrix columns are either True or False.

6 To remove a matrix from a report, deselect its check box. To modify a matrix, select it and
modify its associated settings. Delete a bin by selecting its name and clicking Delete.
5.6.3 Viewing Reports
+ “Diagnostics Reports” on page 108
¢ “Multiple Report Pages” on page 108
Diagnostics Reports

Click a row in a Missing Data - Summary report to view the corresponding Missing Data - Detailed
and Error reports.

Multiple Report Pages

To view multiple pages at once, click Multiple Pages . Select the number of pages across and the
number of pages vertically to view simultaneously. The more pages viewed, the smaller the text. The
options available are from 1X1 through 5X10 pages.
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5.6.4 Printing and Exporting Reports

Click Print & to open the Print dialog box, or click Quick Print & to immediately print the report,
using the current default printer settings.

Click Export Document L ~ to export data to any one of formats, such as PDF, HTML, Text, CSV,
MHT, Excel, RTF, or an image format. Select the desired format from the drop-down list. Click
Export Document to automatically export data in the format most recently selected in the session. If
a format has not yet been selected in this session, the default format is PDF.

Image Formats
After selecting to export a document as an /mage, the Image Export Options dialog box is displayed.

Figure 5-11 Image Exports Options Dialog Box
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Use this dialog box to select from several image types to export, including bmp, emf, wmf, gif, jpg,
png, and tiff. You can also specify the following options to control the actions output:

Resolution (dpi): Image resolution you want to use, keeping in mind that the higher the resolution,
the bigger the exported file.

Export mode: Allows you to choose how you want to export the image:

+ single file: One long image with a single set of column headers at the top.

+ single file page-by-page: One long image made up of individual pages, each with a set of
column headers at the top.

+ different files: A set of separate files, each with a single page image in it. When this option is
selected, numbers are added to the end of the filename you specify for each separate file,
incrementing until all the pages are exported. For example, if you specified MyImage . bmp for a
two-page report, the two files exported would be named MyImage01.bmp and MyImage02 . bmp.

Page range: Range of pages in the report to export. For example, to export the first five pages and
the tenth page of a 20 page report, specify /-5,10.

Page border color: The color to use for the report page border.

Page border width: The width of the page border.
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5.6.5 Copying Servers from a Report to a Group

Sometimes it is useful to copy the displayed servers from a report to a Data Center Explorer group.
Not all reports display servers, but those types of reports do not display the Copy To Group tool. The
groups must already exist. See Section 3.4, “Working with Groups,” on page 50.

To copy servers to a group:
1 Click the check boxes next to the servers in the report you want to add to a group.

2 Click Copy To Group Bl
The Copy To Group dialog box is displayed.

Copy To Group... |Z|E

Copy the machines to;
Fleaze select a group where the machine should be copied to:

Conzolidation Candidates

& Hardware Inventam

[ OF. H Cancel ]

3 Select the target group and click OK. To exit without copying, click Cancel.
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Server Consolidation

This section provides information about the PlateSpin® Recon Server Consolidation and Protection
features.

*

*

*

*

Section 6.1, “About Server Consolidation,” on page 111

Section 6.2, “Creating Projects,” on page 112

Section 6.3, “Creating and Editing Server Templates,” on page 116
Section 6.4, “Identifying Consolidation Candidates,” on page 124
Section 6.5, “Working with Consolidation Scenarios,” on page 124
Section 6.6, “Generating Inventory Reports,” on page 135

Section 6.7, “Viewing Consolidation Reports,” on page 136

Section 6.8, “Implementing Scenarios with Portability Suite,” on page 141

6.1 About Server Consolidation

The PlateSpin Recon Consolidation Planning Module allows for exploration of scale-up and scale-
out consolidation scenarios with candidate workloads. Scenarios can assist with determining the
minimum number of target servers and balancing workloads across these servers.

The key benefits of the Consolidation Planning Module include:

*

*

*

*

Maximizing server utilization by distributing the number of workloads.

Minimizing resource contention by balancing software workloads across five dimensions:
Processor, Memory, Disk, Network, and Time.

Eliminating the need for extra servers with advanced workload sizing and optimization.

Identifying servers to be protected in a disaster recovery plan.

The following are the key stages to assessing server consolidation:

1

Discover and list servers in the PlateSpin Recon Client. For more information, see Section 3.2,
“Discovering and Inventorying Data Center Resources,” on page 30.

Inventory servers and collect static data. For more information, see Section 3.2, “Discovering
and Inventorying Data Center Resources,” on page 30.

Monitor servers and collect dynamic data. For more information, see Section 3.2.5, “Viewing
Inventory Data and Monitoring Servers,” on page 46.

Create a consolidation project. For more information, see Section 6.2, “Creating Projects,” on
page 112.

Select servers for consolidation. For more information, see Section 6.4, “Identifying
Consolidation Candidates,” on page 124.

Identify the optimal consolidation scenario. For more information, see Section 6.5, “Working
with Consolidation Scenarios,” on page 124.

Server Consolidation
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6.2 Creating Projects

A project can consist of any combination of consolidation candidates, protection candidates,
workloads, and scenarios. Consolidation candidates are workloads on the network that you might
want to move to virtual machines. Protection candidates are workloads you might want to create
standby VM duplicates of for disaster recovery.

You create and compare scenarios in a project. The Project Report consists of scenario comparison
results, which help in determining the best consolidation scenario for the environment.

Before you create a project, identify and group consolidation candidates. The identified candidates
allow you to create and compare consolidation scenarios in a project.

NOTE: Collecting at least 24 hours of data for each workload before starting the project is
recommended.

To create a new project:

1 Do any of the following:

Consolidation W

¢ Click Consolidation
+ In the Project Explorer, click Zg.

, then click New Project.

The Project Wizard (Step 1 of 5: Project Name and Type) is displayed.

Project Wizard |:| @lgl

Step 1 of 5: Project Name and Type

Unique Project Mame:

My Project

Project Type:
() Server Consolidation
() Worklaad Protectian

(%) Both

Mext = ][ Cancel

2 Type a unique project name for the project.
3 Select one of the following project types:

Server Consolidation: The project produces a recommendation for the best placement of
workloads with respect to concurrent execution and CPU and memory headspace requirements.

Workload Protection: The project produces a recommendation for deployment of workloads
for disaster recovery. Specify existing virtual servers or use server templates to build a
scenario.
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Both: The project produces a recommendation for both consolidation and protection. For
example, optimally consolidate servers, and provision the remaining headroom for data
protection.

A workload cannot be provisioned for both consolidation and protection in the same project.
Click Next.

The Step 2 of 5: Workload Selection dialog box is displayed.

Identify the workloads you want to include in the project.

Identify the workloads you want to include in the project, and include them in the Workloads to
Consolidate panel or the Workloads to Protect panel in any of the following ways:

¢ Drag workloads from the tree on the left and drop them into the Workloads to Consolidate
panel or the Workloads to Protect panel on the right.

+ Select servers in the right pane, then click the arrow pointing to the panel to which you
want to add them.

Project Wizard |Z| @]El

Step 2 of 5: Workload Selection

Drag and drop the machines ko be induded in the project,

= DEW-CLAIREKZ (1) A Workloads to consolidate
ﬁ DEY-CLAIREKS ﬁ' DEY-CLAIREKS

= DEV-CYRILM3
F=JOEV-DANS
= DEV-DAVIDK4 :
= DEY-DAVIDTZ -
= DEV-EDWARDC (1)
= DEV-EUGENET (1)
&= DEV-GEDRGED (1)
&= DEV-INVENTORY (1) Workloads to protect
&= DEY-JANKZ = DEV-DANS
= DEV-MATTHEWF (1)
= DEV-MICHAELP
= DEV-MICHAELPZ (1) -
&= DEV-MIRAG2 (1)
= DEV-PREETS
= DEV-PREETSZ L

[ < Back ” Mext = ][ Cancel ]

If the existing virtual hosts have been inventoried by Recon, they can be added to the project as
potential target servers. The existing servers take precedence over the server template that you
provide when generating scenarios. Select any virtual hosts that exist in your environment to be
used for consolidation or protection. Drop the target servers into either the Protection or
Consolidation panel.

NOTE: PlateSpin Recon always considers a Solaris 10 machine as a target server for
consolidation because the machine has the global zone enabled by default. Therefore, you
cannot consider a Solaris 10 machine as a consolidation source.

To remove a server from the Workloads to Consolidate panel or the Workloads to Protect panel,
select the server in the panel, then click the arrow pointing towards the server list.
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Servers cannot be targeted for consolidation and protection within the same project.
7 Click Next.
The Step 3 of 5: Workload Utilization Date and Time Range dialog box is displayed.

Project Wizard |Z| |E| El

Step 3 of 5 : Workload Utilization Date and Time Range

Dake Range
(&) Al Data

{:} Lask | | | |
{:} Bebween | | | |

Business Days
Maonday Tuesday wWednesday Thursday Friday

Saturday sunday

[ < Back ” Mexk = ][ Cancel

8 Set the date and time range to summarize the workload data.

Date Range and Business Days are required for calculating the 24H profile of workloads.
9 (Optional) To manually set workload scaling factors, click Advanced.

The Workload Scaling dialog box is displayed.

10 Use the slide controls to adjust values or type the desired number.

Workload Scaling f5__<|

Workload zcaling can be used to adjust workloads size to account for workloads wariahility
and projected growth. The zcale ranges from peak hour average to bwo times the sum of
peak hour average standard deviation.

Decreaze |ncreasze

Processzar: J AVE + STOEW

Memary: J MG+ STDEY
Disk Space: y, ANV

Disk |- J ENG STDEY
Metwork 10: U EVG STDEY

I Ok l[ Cancel ]
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Workloads can be scaled across five dimensions to account for workload variability and
projected growth. Server resources allocated to workloads on target servers are based on scaled
workloads. By scaling workloads upward, more server resources might be required,
potentially resulting in lower consolidation ratios. When scaling pointers are moved, workload
scaling factors change.

Workloads cannot be scaled below their peak hourly averages.
11 Click OK.
12 Click Next.

The Step 4 of 5: Forecast Options dialog box is displayed.
13 Select forecast options and a trend type.

Workloads can be forecasted to account for future growth.

Project Wizard

Step 4 of 5 : Forecast Options

Periods
90 | | | Day (s) W

30 Day (s)

a0 Day (s)

30 Day (s)

Trend f Regression @ | Linear w
Linear
Logarithmic
Exponential
Power

< Back ” Mext = ]’ Cancel

14 Click Next.
The Step 5 of 5: Power and Cooling dialog box is displayed.

15 Specify the values for the Project Type, or deselect the Enable Power and Cooling check box if
these values are not to be included.

Energy Cost: Cost of energy per kilowatt hour.

Server Derating Factor: Percentage of total energy consumption by the average server. For
example, a server rated at 800 watts uses 400 watts with a server derating factor of 50%.
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Project Wizard

Step 5 of 5: Power and Cooling
Enable Power and Cooling

Project Type:
Energy Cost: 0,11 | [ kwh

Server Derating Factor: 50| %

Power and Cooling uses the Following custom workload Fields:

Heat Dissipation
Energy Consurnption

These custom fields can be set using the Properties window of machines selected in
the Data Center Explorer,

= Back “ Create ][ Cancel

16 Click Create.
The new project is displayed in the Project Explorer.
When creating a project, a 24H Profile of workloads is computed. This includes calculating
Processor Speed (MHz), Memory (MB), Disk Space Used (GB), Disk 10 (MB/s), and Network 10
(MB/s) over a 24-hour period for each workload. The 24H Profile comprises 24 values of workloads

that correspond to each hour of the day (0 to 23). Each value in the 24H Profile is calculated by
taking the peak value from all values observed for that hour.

6.3 Creating and Editing Server Templates

Server templates are used to define servers for use in consolidation scenarios. You create server
templates, each with their own components and utilization thresholds. A common use for server
templates is for scale-up or scale-out consolidation scenarios. The created server templates are used
as target servers for consolidating workloads.

¢ Section 6.3.1, “Creating a New Server Template,” on page 116

¢ Section 6.3.2, “Editing an Existing Server Template,” on page 120
¢ Section 6.3.3, “Copying a Server Template,” on page 123

6.3.1 Creating a New Server Template

1 Click Consolidation % SRR ‘, then click Server Templates [,
The Server Template Manager dialog box is displayed.

2 Click '
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The New Server Template dialog box is displayed.

x)

Mew Server Template

Name | New Server |

Make | HP |

Model [ ProLiant DL580 |

TCO 11000 Rack Units
Power 1163 W

Wirtualization |Microsoﬂ Virtual Server A |

Coc ) Comes

3 On the General page, specify the following:

User Interface Required Description

Name Yes Name of the template to be created.
Make No Server manufacturer.

Model No Server model.

TCO No Total cost of ownership.

Rack Units No Number of rack units.

Power No Power consumption in watts.
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User Interface

Required

Description

Virtualization

Yes

*
*

*

Virtualization platform:

Citrix XenServer
Microsoft Hyper-V*
Microsoft* Virtual Server
None

Solaris 10 Zones
Virtual Iron*
VMware ESX
VMware ESX 3
VMware ESX 4
VMware GSX
VMware Server
SLES XenServer

4 Click the Components tab, then specify the following on the Components page:

NMew Server Template

General |

Settings

Processor Count

Processor Speed

Caores Per Processor

CPU Model

Mormelized Speed

Memory Size

Disk Space () Fixed

Thresholds

Processar
Disk Space m

Memory

) Unlimited

o

ar
£

| 3333 | MHz

|
|
| ]
|

| Care Xeon
[] Hyper-Threzding

41.10

| 22768 |MB

Disk 1O

etk 10

oKk || cancel |
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User Interface Required Description

Settings

Processor Count Yes Total processor count.

Processor Speed Yes Instructions per second the server can execute in
MHz or GHz. The minimum processor speed you
can use is 266 MHz.

Memory Yes Memory size for server in MB or GB.

Cores Per Processor Yes Number of cores per processor.

CPU Model Yes Model of CPU:

+ Pentium* IV

* Core

+ Xeon*

¢ Core Xeon

+ Athlon*

+ Opteron*

¢ Intel* Nehalem

Hyper-Threading No Specifies if hyper-threading is available.

Normalized Speed Readonly A unitless measure of processor capacity. This
provides more realistic comparisons across diverse
processor architectures.

Memory Size Yes The amount of memory to use. The minimum
memory size you can use is 256 MB.

Disk Space Yes Disk space in GB or TB that is required for the
server. Select Unlimited if you are connecting target
servers to a SAN or NAS, where disk space is not a
limiting factor. If you use Fixed, the minimum amount
of disk space you can specify is 1 GB.

Thresholds

Processor No Processor utilization. By default, the utilization is set
to 80%.

Memory No Memory utilization. By default, the utilization is set to
90%.

Disk Space No Maximum disk utilization threshold. By default, the
utilization is set to 85%.

Disk IO No Maximum disk 1/O allowed. By default, the Max 10 is
set to 50 MB/s.

Network 1O No Maximum network 10. By default, the network 1O is

setto 10 MB/s.
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Thresholds specify the level of utilization the Consolidation Planning Module can assume for
the server templates. This affects the outcome of consolidation scenarios; lower utilization
thresholds result in more servers being required to host the workloads of a scenario.

For example: workloads requiring 180 GB of memory can be consolidated onto a server with
200 GB of memory if the utilization threshold is set at 90%. However, if the memory utilization
threshold is set at 50%, only 100 GB of memory can be used, resulting in fewer workloads
being consolidated.

Utilization thresholds are initially set to the defaults listed in the table above and can be
customized for specific needs.

5 Click OK.

The newly created server template is added to the Server Template list.

6.3.2 Editing an Existing Server Template

1 Click Consolidation §8 I ‘, then click Server Templates [0,
The Server Template Manager dialog box is displayed.
2 Do any of the following:
+ Select the server template you want to edit, then click L}
+ Right-click the server template you want to edit, then click [ Edit.
The Edit Server Template dialog box is displayed.
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Edit Server Template

General | Components |

Mame | My Old Server Template

Mzke | Computers Inc.

Model | 4993

o

T —

Virtuzlization | None

]

[ ok || cancel |

3 On the General page, make any desired modifications by using the following information:

User Interface Required Description

Name Yes Name of the template to be created.
Make No Server manufacturer.

Model No Server model.

TCO No Total cost of ownership.

Rack Units No Number of rack units.

Power No Power consumption in watts.
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User Interface Required Description

Virtualization Yes Virtualization platform:
+ Microsoft Virtual Server
¢ Virtual Iron*

+ VMware* ESX

* VMware ESX 3

+ VMware ESX 4

+ VMware GSX

+ VMware Server

+ Citrix XenServer

* Microsoft Hyper-V
+ SLES XenServer

+ None

4 Click the Components tab, then make any desired modifications by using the following

information:

User Interface Required Description

Settings

Processor Count Yes Total processor count.

Processor Speed Yes Instructions per second the server can execute in
MHz or GHz. The minimum processor speed you
can use is 266 MHz.

Memory Yes Memory size for server in MB or GB.

Cores Per Processor Yes Number of cores per processor.

CPU Model Yes Model of CPU:

¢ Pentium IV
+ Core

+ Xeon

¢ Core Xeon
¢ Athlon

¢ Opteron

Hyper-Threading No Specifies if hyper-threading is available.

Normalized Speed Readonly A unitless measure of processor capacity. This
provides more realistic comparisons across diverse
processor architectures.

Memory Size Yes The amount of memory to use. The minimum

memory size you can use is 256 MB.
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User Interface Required Description

Disk Space Yes Disk space in GB or TB that is required for the
server. Select Unlimited if you are connecting target
servers to a SAN or NAS, where disk space is not a
limiting factor. If you use Fixed, the minimum amount
of disk space you can specify is 1 GB.

Thresholds

Processor No Processor utilization. By default, the utilization is set
to 80%.

Memory No Memory utilization. By default, the utilization is set to
90%.

Disk Space No Maximum disk utilization threshold. By default, the
utilization is set to 85%.

Disk 10 No Maximum disk I/O allowed. By default, the Max 10 is
set to 50 MB/s.

Network 10 No Maximum network 10. By default, the network 10 is

set to 10 MB/s.

Thresholds specify the level of utilization the Consolidation Planning Module can assume for
the server templates. This affects the outcome of consolidation scenarios; lower utilization
thresholds result in more servers being required to host the workloads of a scenario.

For example: workloads requiring 180 GB of memory can be consolidated onto a server with
200 GB of memory if the utilization threshold is set at 90%. However, if the memory utilization
threshold is set at 50%, only 100 GB of memory can be used, resulting in fewer workloads

being consolidated.

Utilization thresholds are initially set to the defaults listed in the table above and can be
customized for specific needs.

5 Click OK.

6.3.3 Copying a Server Template

1 Click Consolidation %@ SRR ‘, then click Server Templates [,
The Server Template Manager dialog box is displayed.

2 Do any of the following:

¢ Select the server template you want to copy, then click =18

+ Right-click the server template you want to copy, then click g Copy.

The New Server Template dialog box is displayed with prepopulated template information.

3 Rename the template and make any other required modifications.

4 Click OK.

The template is copied and is displayed in the Server Template Manager listing.
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6.4 Identifying Consolidation Candidates

This activity involves selecting servers for consolidation. This requires you to generate inventory
and analysis reports so you can find a set of servers that meet your consolidation requirements, then
you can select your consolidation candidates from that set of servers. For more information, see
Section 5.5, “Generating Reports,” on page 100.

6.5 Working with Consolidation Scenarios

Scenarios allow the quick creation and evaluation of one or more consolidation alternatives.
Generating multiple scenarios for comparison is recommended. This helps to determine the optimal
consolidation scenario.

There are two types of scenarios:

¢ Determine the minimum number of servers: PlateSpin Recon determines how many of a
specific type of target server are required to balance the workloads. With this type of scenario,
only one server template can be used.

¢ Specify the number of servers: You set the number and type of target servers for
consolidation. PlateSpin Recon calculates the optimal distribution of workloads for the chosen
targets. With this type of scenario, multiple server templates can be used.

Any inventoried machine running any virtualization platform supported by PlateSpin Recon is
considered a target server.

¢ Section 6.5.1, “Determining the Minimum Number of Servers,” on page 124

¢ Section 6.5.2, “Specifying the Number of Servers,” on page 129

*

Section 6.5.3, “Results of Consolidation Scenarios,” on page 133

*

Section 6.5.4, “Editing Scenarios,” on page 134

*

Section 6.5.5, “Deleting Scenarios,” on page 135

6.5.1 Determining the Minimum Number of Servers

The Scenario Wizard (Step 1 of 4: Scenario Properties) is displayed.
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Scenario Wizard |:|@®

Step 1 of 4 : Scenario Properties

Scenario Name

| Server Consolidation

Scenario Goal

(3) Determine the minimum number of servers
() Specify the number of servers

Scenario Type

() Server Consolidation
() Workload Protection
(%) Consolidate and Protect

Scenario Optimization Effort

Quick, J Exhaustive
[ Met = ][ Cancel ]

The available scenario types are determined by the Project Type specified while creating the
project.

Specify a unique name for the scenario.
In the Scenario Goal pane, select Determine the minimum number of servers.

This goal determines the minimum number of a specific type of target servers to balance
workloads. You can use only one server template with this option.

Select a scenario type.

This step is relevant only if the project upon which the scenario is based has the goal
configured as Both (server consolidation and workload protection).

Adjust the Scenario Optimization Effort slider.

Quick is faster but not as intensive, and Exhaustive takes longer but is more thorough.
Click Next.

The Step 2 of 4: Workload Properties dialog box is displayed.
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Scenario Wizard

Step 2 of 4 : Workload Properties

Workload Sizing

(%) Use historical size of workloads

(") Useforecasted size of workloads. Specify forecast period:

Business Hours

[ use the following hour range:

CPU Optimization Method

(") Use processordlock rate to optimize workloads
(3) Use normalized speed to optimize workloads

< Back ][ Met = ][ Cancel

7 Specify Workload Sizing.

+ Use historical size of workloads: Creates the scenario based on the historical size of the
workloads.

+ Use forecasted size of workloads (specify forecast period): Creates the scenario based
on the forecasted size of the workloads after the specified forecast period.

For scenarios based on protection only projects, these values are dimmed.

8 To average workload and utilization expressions over a specified time range, select the Use the
following hour range check box and set the start and end times for the business hours in your
environment.

Hours that you specify here are used for all reports created for this scenario or for any node
under this scenario. Report templates do not have any direct control over business/peak hours.
Consolidation and Planning charts use both the specified business hours and all 24-hour data
points.

9 Specify the CPU optimization method you want to use.

¢ Use processor clock rate to optimize workloads: Optimizes the CPU based on the
actual processor clock.

+ Use normalized speed to optimize workloads: Optimizes the CPU based on a
normalized value. See Section B.6, “CPU Normalization,” on page 179 for more
information.

Consolidation charts based on this scenario differ depending on the method you choose. If
you select normalized speed, the processor utilization and capacity values in consolidation
charts created based on this scenario will also use the normalized values.

In any reports, Normalized Speed columns are not displayed by default, even if it's a
scenario summary or workload assignment report and the optimization method selected is
Use normalized speed to optimize workloads.

For scenarios based on protection only projects, these values are dimmed.
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10 Click Next.
The Step 3 of 4: Workload Selection dialog box is displayed.

Scenario Wizard

Step 3 of 4 : Workload Selection

Select theworkloads to be used inthis scenario

Consolidate | Protect|
\wlorkloads
Name Processor Memory Disk Space Disk 10 Metwork 10
(Normalized) (MB) (GB) (MBis) (MBis)
E M DEV-HEREB i ‘
DEV-MARTINS 3.03 1430.31 3637 0.96 0
< Back ” Mesxk = ] [ Cancel

11 Select workloads or servers, depending on the scenario type.

Scenario Wizard

Step 3 of 4 : Workload Selection

Select the workloads to be used inthis scenario

‘workloads
Name Processor Memory Disk Space Dhsk 1O Network 10
(MHz) (ME) (GE) (MEBEis) (MBis)

{ IT-LAFTEMP : 15.06 : 3036 :0.01 :0.08

= Back ” Mext = l’ Cancel
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12 (Conditional) If the Scenario Type includes server consolidation, select the servers to be

consolidated in this scenario.

By default, all servers specified in the project for consolidation are selected.

13 (Conditional) If the Scenario Type includes workload protection, select workloads on the

Protect tab.

By default, all workloads specified in the project for protection are selected.

14 Click Next.

The Step 4 of 4: Target Server Specification dialog box is displayed.

Scenario Wizard

Step 4 of 4: Target Server Specification

Configure the target servers to be used inthis scenario

Server Templates | Bxisting Target Servers

Utilization

Name Virtualization Processor Memary Disk Space

(%) (%)

Microsoft Virtual Server A

VMware Server
Citrix XenServer
Microsoft Hyper-\

Dell PEE25D None v 20 S0 a5 100

Network 10
(MB=)

20

[ < Back ][

] [ Cancel

15 In the Name drop-down list, select the server template you want to use.

or

Create a new server template by selecting New Server. (You can use only one server template.)

You must specify at least one server template, even if you want to consolidate only to existing

target servers.

16 (Optional) In the Virtualization drop-down list, select the Virtualization platform to use.

17 (Optional) Click the Existing Target Servers tab to use servers included in the project.

If there are no existing target servers specified in the project, this option is unavailable.
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Scenario Wizard

Step 4 of 4: Target Server Specification

Configure the target servers to be used inthis scenario

Server Templates Existing Target Servers

i DEV-MICHAELB

Pinned Workloads

[ < Back ][

Stark

] [ Cancel

]

18 Select the existing target servers to use in the scenario, then select the Pinned Workloads check
box to force workloads currently on a particular target server to remain on that server after

consolidation.
19 Click Start.

The Create Scenario job runs.

You can watch the progress in the Job Explorer window. When the scenario is created, it is
displayed under Scenarios in the base project.

6.5.2 Specifying the Number of Servers

1 Click New Scenario [g.

The Scenario Wizard (Step 1 of 4: Scenario Properties) is displayed.
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Scenario Wizard

Step 1 of 4 : Scenario Properties

Scenario Name

| MyScenario

Scenario Goal

() Determine the minimum number of servers
(%) Specify the number of servers

Scenario Type

() Server Consolidation
() Workload Protection
(%) Consolidate then Protect
() Protect then Consolidate

Scenario Optimization Effort

Quick, J Exhaustive
o> ) [ Gance

Type a unique scenario name.

In the Scenario Goal pane, select Specify the number of servers to set the number and type of
target servers for consolidation.

You can use multiple server templates with this option.
Select a scenario type.

If some workloads must be left unconsolidated because the number of templates specified is
inadequate, the algorithm fits as many of the consolidation workloads onto those templates as it
can if you choose Consolidate then Protect. The reverse is true if you choose Protect then
Consolidate.

Adjust the Scenario Optimization Effort slider.

Quick is faster but not as intensive, and Exhaustive takes longer but is more thorough.
Click Next.

The Step 2 of 4: Workload Properties dialog box is displayed.
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Scenario Wizard

Step 2 of 4 : Workload Properties

< Back ][ Met = ][ Cancel

Workload Sizing

(%) Use historical size of workloads

(") Useforecasted size of workloads. Specify forecast period:

Business Hours

[ use the following hour range:

CPU Optimization Method

(") Use processordlock rate to optimize workloads
(3) Use normalized speed to optimize workloads

7 Specify Workload Sizing.

+ Use historical size of workloads: Creates the scenario based on the historical size of the

workloads.

+ Use forecasted size of workloads (specify forecast period): Creates the scenario based

on the forecasted size of the workloads after the specified forecast period.

For scenarios based on protection only projects, these values are dimmed.

8 To average workload and utilization expressions over a specified time range, select the Use the

following hour range check box and set the start and end times for the business hours in your
environment.

Hours that you specify here are used for all reports created for this scenario or for any node
under this scenario. Report templates do not have any direct control over business/peak hours.

Consolidation and Planning charts use both the specified business hours and all 24-hour data
points.

9 Specify the CPU optimization method you want to use.

9a

9b

Use processor clock rate to optimize workloads: Optimizes the CPU based on the
actual processor clock. For more information, see Section B.6, “CPU Normalization,” on
page 179.

Use normalized speed to optimize workloads: Optimizes the CPU based on a
normalized value.

Consolidation charts based on this scenario differ depending on the method you choose. If
you select normalized speed, the processor utilization and capacity values in consolidation
charts created based on this scenario will also use the normalized values.

In any reports, Normalized Speed related columns are not displayed by default, even ifiit's

a scenario summary/workload assignment report and the optimization method selected is
Use normalized speed to optimize workloads.

For scenarios based on protection only projects, these values are dimmed.
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10 Click Next.
The Step 3 of 4: Workload Selection dialog box is displayed.

Scenario Wizard

Step 3 of 4 : Workload Selection

Select theworkloads to be used inthis scenario

Consolidate | Protect

\Workloads
MName Processor Memory Disk Space Disk 1O Network 10
(Normalized) (MBE) (GB) (MBis) (MBs)
: DEV-HEREB (017 i 676.73 ; :
DEV-MARTING  2.03 1430.31 36.37 096 0 &
B

Haonor utilizationthresholds
(%) Maximize the number of consolidated workloads
(") Consolidate workloadsin theabove order

[ < Back ][ Mext = ][ Canicel ]

11 (Conditional) If the Scenario Type includes server consolidation, select the servers to be
consolidated in this scenario.

By default, all servers specified in the project for consolidation are selected

12 (Conditional) If the Scenario Type includes workload protection, select workloads on the
Protect tab.

By default, all workloads specified in the project for protection are selected.

If you are running a scenario with a set number of target servers, in some cases the set number
of target servers do not have sufficient resources to accommodate all workloads.

By default, Honor utilization thresholds is selected. This maintains the total utilization of a
target server below the set thresholds. The sum of workloads do not violate the utilization
thresholds for a specified server.

13 Define consolidation priorities by selecting one of the following options:

¢ Maximize the number of consolidated workloads: Workloads are selected for
consolidation with the goal of consolidating the largest possible number of workloads.
The order shown is not relevant and the up and down arrows are disabled.

+ Consolidate workloads in the above order: Prioritize workloads for consolidation only,
in the given order. This ensures that certain workloads are consolidated. To move
workloads into the desired order of consolidation priority, use the up and down arrows.

14 Click Next.
The Step 4 of 4: Target Server Specification dialog box is displayed.
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Scenario Wizard

Step 4 of 4: Target Server Specification

Configure the target servers to be used inthis scenario

EEEI:GE.F?EHISI.ﬁ.é;é Existing Target Servers
Utilization
Mame Count Virtualizatio Processor Memory Disk Space Disk 1O Metwerk 10
(%) (%) (%) (MB/=) (MB/s)
Click to Select Server
Dell PEGBED 1 None 80 30 85 100 20
[ < Back ][ Start ] [ Cancel

15 In the Name drop-down list, select the Server template you want to use.
or
Create a new server template by selecting Click to Select Server.

16 Specify the count for each server template.

17 (Conditional) If you want to use the existing server targets specified in the project, click the
Existing Target Servers tab and select the servers.

This option is available only if a project has existing target servers.
18 Click Start.
The Create Scenario job runs.

You can watch the progress in the Job Explorer window. When the scenario is created, it is
displayed under Scenarios in the base project.

6.5.3 Results of Consolidation Scenarios

The result of any scenario depends on the workloads used and the server templates selected. Higher
consolidation ratios are achieved with larger target servers. The created scenario is displayed in the
Project Explorer. For a description of the icons in the graphic below, see the listing of Project
Explorer icons in Table D-6 on page 190.
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Figure 6-1 Project Explorer

ject Explorer
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Virtualization Overhead: If server templates configured with a virtualization platform are selected
as input to the scenario, the overhead related to the selected virtualization platform is shown as an
additional workload under each target server and is named after the virtualization platform.
Virtualization overhead workloads are not movable.

Unconsolidated Workloads: Lists all servers that were not consolidated during the scenario
creation process. Workloads are rejected if they cannot be added to a server without exceeding
utilization thresholds. These servers are listed under Unconsolidated in the scenario. Moving
unconsolidated workloads to a server can result in a violation of utilization thresholds.

Unprotected Workloads: Lists all servers that were not protected during the scenario creation.
Workloads are rejected if they cannot be added to a server without exceeding utilization thresholds.
These servers are listed under Unprotected in the scenario. Moving unprotected workloads to a
server can result in a violation of utilization thresholds.

6.5.4 Editing Scenarios
You can move workloads between target servers or from Unconsolidated or Unprotected to a target

server by dragging and dropping in the Project Explorer. Alternatively, right-click the workload and
click Unconsolidate Workload on the menu.
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6.5.5 Deleting Scenarios

1
2

In the Project Explorer, select a scenario.
Click .

6.6 Generating Inventory Reports

*

*

Section 6.6.1, “Finding Servers That Meet the Consolidation Criteria,” on page 135
Section 6.6.2, “Selecting Candidates for Consolidation,” on page 135

6.6.1 Finding Servers That Meet the Consolidation Criteria

1

0 N O O

In the Report Explorer, right-click the Hardware Inventory Report template under Inventory,
then select Edit Report Template.

The Edit Report Template dialog box is displayed.

Click the Group tab, select a filter or group to use when you generate reports based on this
template.

Click the Views tab and select a view. Use the buttons adjacent to the list to add or edit a view.
See Section 5.4, “View Customization,” on page 96

Click the Field Filter tab. Use the drop-down lists to specify query parameters. See “Field
Filter Tab” on page &9.

Click OK.

In the Report Explorer, right-click Hardware Inventory and select Generate Report.
Schedule the report for Now, and accept the default Delivery Type of the Report Explorer.
Click Generate.

The report instance, shown as the date and time the report was generated, is displayed under the
report template in the Report Explorer and the report is previewed in the Document Viewer,
showing the servers that meet your consolidation requirements.

6.6.2 Selecting Candidates for Consolidation

1

In the Report Explorer, right-click the Analysis report template for Hardware Utilization - Peak
and select Edit Report Template on the menu.

The Edit Report Template dialog box is displayed.

2 On the Group tab, make the same selection you made in Step 1 on page 135.

On the Views tab, select the table view and click Edit.
The Create View dialog box is displayed.

On the General tab, select the Summary Rows (applied to columns containing calculated data)
you want to create in the report.

Click Finish.
The Edit Report Template dialog box is displayed again.

On the Date Filter tab, set the date and time range to view utilization expressions for all servers
that were monitored.
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7 On the Field Filter tab, use the drop-down lists to specify the same query parameters you
selected in Step 1 on page 135.

8 On the Summaries tab, select AVG.

9 Click the Calculation type drop-down list and a type:
* Average: Average of all hourly values across business days and business hours.
¢ Peak Hour: A calculation based on the highest hourly value.

¢ Total: Sums all the data points in the time frame. For example, Disk 10s per second for a
1-hour period equates to 10 disk I1Os per second X 60 seconds X 60 minutes = 36000.
Select the Summary Rows to create in the report of the columns containing calculated data.

10 Click OK.

11 In the Report Explorer, under Analysis, right-click the previously edited Hardware Utilization -
Peak report template and click Generate Report on the menu. Accept the default Delivery Type
of the Report Explorer.

12 Click Generate.

The report instance, shown as the date and time the report was generated, is displayed under the
report template in the Report Explorer and the report is previewed in the Document Viewer.

Comparing and contrasting the two reports generated in Step 1 on page 135 and Step 1 on
page 135 will help you determine your consolidation needs.

To help with this, while viewing a generated report, click a cell to display a customizable chart
for that server/workload metric. For more information see Section 5.1, “Chart Viewer,” on
page 79.

6.7 Viewing Consolidation Reports

Consolidation reports are used for analysis. Unlike other PlateSpin Recon reports, which are
generated through the Report Explorer, consolidation reports are generated through the Project
Explorer. Like other PlateSpin Recon reports, generated consolidation reports are viewed in the
Document Viewer. In addition, consolidation reports cannot be saved and must be generated
whenever necessary.

The following types of consolidation reports are available:

+ Project Report

¢ Scenario Summary Report

*

Workload Assignment Report
¢ Unconsolidated Report
¢ Unprotected Report
Project, scenario summary, and workload assignment reports are template based. You can edit the

templates through the Report Explorer. For information about editing consolidation report
templates, see Section 5.3.3, “Consolidation Report Templates,” on page 93.

For detailed information about the different types of consolidation reports, review the following
sections:

¢ Section 6.7.1, “Project Report,” on page 137

¢ Section 6.7.2, “Scenario Summary Report,” on page 137
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¢ Section 6.7.3, “Workload Assignment Report,” on page 139
¢ Section 6.7.4, “Unconsolidated Workload Report,” on page 140
¢ Section 6.7.5, “Unprotected Workload Report,” on page 140

6.7.1 Project Report

A Project Report provides a comparison of consolidation scenarios.
To view this report, double-click a project. The Project Report is displayed in the Document Viewer.

Figure 6-2 Sample Project Report

Project: Consolidation and Protection

6.7.2 Scenario Summary Report

The Scenario Summary Report helps in assessing the value of using a particular infrastructure for
server consolidation.

Double-click the selected scenario to view the Scenario Summary report in the Document Viewer
and the 24H Profile Stacked Utilization chart in the Chart Viewer.

Figure 6-3 Sample Scenario Summary Report

Scenario Summary: Server Consolidation
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24 Hour Utikzation pommrer. |
1m - 1 New Serven 2
]
i) Torger Servery [FerTER Near]
¥ | Conschidation Faso 151
z |
5 %1 TCO o
5 1 - 7
3w =] \\...ru.:....\.
20 JEeell . Conschdam i
| L | Uncanscbdaind o]
o Ll - ——— e
Processor (Nomakoed)  Mermory Dt Spe Dk 10 stk 10 Tocal

Energy and Space Usage

[ia8] L (L
| o - = [ Source Severs
0 § Targes Servers
@ 4 3
|
30
[ —_— —

W
Sarver Count Rach Uts Aorusl Ensegy Cost

Baseling (Source 100%)

Kaek Unins

Memory (W) Disk Space (%)

Anmus| Energy Energy Use Heat Dissipation
Cast (KWhiyr} BTy

Seurce Serven 3 o 0.00 o o 23 303 1354
Target Serven 2 i 0823 64386 21935626 72 87
Chasge -1 N 0324 64388 2195526 49 218
Change (%) 333 2134 J14

If there are multiple target servers, a summary statistics table is displayed with SUM, AVG, MAX,
and MIN values.
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Figure 6-4 Sample Report Summary Statistics Table

Machine

Memory

Metwork

If you click one of the server cells, the corresponding 24H Profile stack chart with all workloads
assigned to the target server is displayed.

Figure 6-5 Sample 24H Profile Stack Chart
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24H Profile Chart Appearance

Twenty-four hour (24H) Profile charts in the Data Center Explorer and in Consolidation Planning
are slightly different. In the Data Center Explorer, the 24H profile that is shown. select several
monitored machines, click Create Chart and then select Profile as the type of chart) in workload
profile charts is for each individual resource instance separately and shows a different color for each
instance and resource. These values are stacked for each given hour. This gives the maximum value

for every instance for a specific hour over the monitoring period. These stacked values are then
summed.

Figure 6-6 Summed Stack Values
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This highlights the hour with the maximum utilization for a specific instance of the resource. This

approach is particularly useful for determining maximum utilization of any individual resource
instance.

In Consolidation Planning, the 24H chart has the values of the instances and resources summed for
each time moment and then the maximum of this sum for every hour is identified.
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Figure 6-7 Consolidation Planning 24H Chart
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This is needed to determine the summary resource consumption of a workload.

6.7.3 Workload Assignment Report

In the Workload Assignment report, you can see which workloads are assigned to servers and how
workloads are utilized in each of these assigned servers. You can modify workload assignments
according to requirements and consider different kinds of server options while creating a project.

Workload Assignment reports are available for individual target servers or for all target servers
included in a scenario.

¢ “Individual Server” on page 139
+ “All Servers” on page 140
Individual Server

To view the Workload Assignment report and 24H Profile chart, double-click a target server in the
Project Explorer.

NOTE: A 24H Profile cannot be created for workloads when there is no one-hour summary data.

If you click one of the servers in the Assignment report, the corresponding 24H Profile stack chart
with all workloads assigned to the target server is displayed. The utilization values displayed are for
the target servers.

Figure 6-8 Assignment Report Generated 24H Profile Stack Chart
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All Servers
To view the Workload Assignment report for all the servers in the current scenario:

1 Right-click a scenario, select View Report > View Workload Assignment Report from the drop-
down menu

6.7.4 Unconsolidated Workload Report

In the Unconsolidated Workload Report, you can see which of the consolidation candidate
workloads are not included in the consolidation plan, as well as an explanation of the reason why
PlateSpin Recon could not include them.

To view this report, right-click a scenario and select View Report > View Unconsolidated Report.
The Unconsolidated Report is displayed in the Document Viewer.

Figure 6-9 Sample Unconsolidated Report

Unconsolidated Report
B384 Project > B384 Scenario2 > Unconsolidated April 6, 2007

T e

[0 Dev-DaviDT These are net encugh reseurces in any of the available containers
[0 DEV-NADERS There are not encugh resources in any of the available containers
[0 Dev-eORISE There are not encugh rescurces in any of the avaitable containers
[0 pev-DaviDk There are not enough rescurces in any of the available containers

6.7.5 Unprotected Workload Report

In the Unprotected Report, you can see which of the consolidation candidate workloads were not
included in the protection plan, as well as an explanation of the reason why PlateSpin Recon could
not include them.

To view this report, right-click a scenario and select View Report > View Unprotected Report. The
Unconsolidated Report is displayed in the Document Viewer.

Figure 6-10 Sample Unprotected Report

Unprotected Report
Project 2 Protect > Scenario A > Unprotected Monday, April 03, 2007

[0 pev-DseuiLD There are not encugh resources in any of the available containers
[0 FrocBuGz There are not encugh rescurces in any of the available containers
O wmsrca There are not encugh rescurces in any of the available containers
O wmsrRcs There are not encugh rescurces in any of the available containers
O voninavm There are not encugh resources in any of the available containers
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6.8 Implementing Scenarios with Portability

Suite

When there are identified scenarios and servers to deploy, you can implement the consolidation and
protection by using PlateSpin Portability Suite. You can implement an entire scenario, separate

containers within the scenario, or individual servers in the scenario.
PlateSpin Recon 3.7 supports PlateSpin Portability Suite 8.0.0.

To implement a scenario:

1 In the Project Explorer, right-click the scenario, then select Implement using Portability Suite.

The Implementing scenario <name> using Portability Suite Step 1 of 2 dialog box is displayed.

Implementing scenario MyScenario (2] using PortabilitySuite

Step 1 of 2:
PartabilitySuite Settings

Specify the PortabilitySuite Server you will be using for the consolidation.

PartahilitySuite Server URL |http:/flocalhast fPartabilicySuite
Metwork Mame | Defaulk

PortabilitySuite Credential | gsx01\administrator v

Destination

Specify the folder relative to the serverwhere the PortabilitySuite jobs should be saved. Note that the folder should be accessible by the
account assigned to the PlateSpin Recon Service.

Direckary c:ikemp

2 Confirm the Portability Suite Server URL and Network name.

3 Use the drop-down list to select or create the credentials that Portability Suite uses to discover

and convert the servers within the scenario or container.
4 Specify the directory where the Portability Suite jobs must be saved.
5 Click Next.

The Step 2 of 2 dialog box is displayed.
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Implementing scenario MyScenario (2) using PortabilitySuite

Step 2 of 2:

IMap the containers to physical servers by selecting them in the list below,

Container Server
» ‘ Dell PEG850_00 | Not Mapped |
‘ DEV-MICHAELE | Not Mapped |

N

6 Click Not Mapped.
A table drops down where a match column is displayed.

If you are attempting to consolidate multiple containers, the mapping of container to target
server is one-to-one. Unavailable containers that are already mapped to a server are dimmed.
When they are either unmapped or the scenario they are in is deleted, they are once again made
available.

7 Click Start.
When the job is initiated, PlateSpin Recon:
+ Authenticates the servers.
¢ Creates and runs server discoveries for Portability Suite.

+ Creates and saves conversion jobs in the file location specified in Step 1 on page 141. The
default location is c: \ temp.

When the job completes, you can copy the saved conversion jobs to the Portability Suite
machine and load it by using PlateSpin Portability Suite Client window (File > Load Job).

6.8.1 Implementing Phantom or Existing Target Servers

The steps to implement at the “phantom” (server template), or existing target server level, are
identical to implementing a scenario: right-click the phantom or existing target virtual machine
server and select Implement Using Portability Suite.

If a phantom server represents an existing target virtual machine server, you can map it to that
existing server. When the job is created through Portability Suite, the source and target servers are
auto-configured.

To map a phantom to a target virtual machine server and deploy it:

1 Right-click the phantom and select Edit Mapping.

The Server Mapping dialog box is displayed, listing the available servers that contain virtual
machines. Data is listed for each machine, and the match column indicates whether or not the
machine is a match to the phantom.
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Test Results

CPU Failure: The processing power of the destination server is less than the
processing power of the source server.

Warning: The destination server has more processing power than is
necessary. A warning is displayed if the processing power of the destination
server is 500 Mhz greater than the processing power of the source server.

Pass: The CPU match is acceptable.

Disk Failure: The disk space on the destination server is less than the disk space
on the source server.

Warning: The disk space on the destination server is higher than necessary.
A warning is displayed if the destination server has more than 50 GB of
surplus space compared to the source server.

Pass: The disk match is acceptable.
Memory Failure: The destination server has less memory than the source server.

Warning: The destination server has more memory than is necessary. A
warning is displayed if the memory on the destination server is 512 MB
greater than the memory on the source server.

Pass: The memory match is acceptable.

In the Server Mapping dialog box, select the target virtual machine server to map the phantom
to, then click OK.

Right-click the newly mapped phantom and select Implement Using Portability Suite.

4 Complete the Implementing Server Using Portability Suite Wizard as described in “To

implement a scenario:” on page 141.
Click Start.
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IT Chargeback

This section includes information on using the PlateSpin® Recon flexible Chargeback feature.

¢ Section 7.1, “Understanding Chargeback,” on page 145
¢ Section 7.2, “Using Raters,” on page 145

¢ Section 7.3, “Managing Raters,” on page 148

¢ Section 7.4, “Chargeback Reporting,” on page 151

7.1 Understanding Chargeback

The PlateSpin Recon flexible chargeback reporting capabilities allow organizations to accurately
calculate IT costs based on actual and virtualized resource usage. IT departments can then allocate
their costs to different business units and departments.

Even when resources are part of a virtualized pool of computing resources shared across many
workloads, PlateSpin Recon not only allows you to track, assign, and report on used resources, but it
can also generate reports and deliver them to the appropriate business units.

To set up a chargeback system:

1 Create raters to assign appropriate charges for usage.

For more information on how to create a rater, see Section 7.3.1, “Creating a Rater,” on
page 148

2 Attach the raters to particular machines to be tracked.

For more information on how to attach raters to machines, see Section 7.3.4, “Attaching Raters
to Machines,” on page 150

3 Generate Chargeback reports.

For more information on how to generate a Chargeback report, see Section 5.5, “Generating
Reports,” on page 100.

NOTE: It is useful to organize machines using Chargeback into their own group. For more
information, see Section 3.4, “Working with Groups,” on page 50.

7.2 Using Raters

A rater is a metric used to assign a billable charge to the use of a resource—or part of a resource—
over a set amount of time. This converts resource usage data into currency values. There are three
types of raters:

+ Allocation Raters: These raters can only be attached to virtual machines. They take a cost for
a virtual machine server resource and assign an appropriate percentage of that cost to each
virtual machine the rater is attached to, based on the usage of that resource.

+ Flat Raters: These raters assign a value to a resource at a fixed rate. For example, a flat rater
charge for used disk space could be $1 per gigabyte of disk space used per month.
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+ Tiered Raters: These raters assign values to a resource with different flat rates for different
levels of usage. For example, a tiered rater charge for memory used could be $0 for 0-512 MB
and $.05 per MB for use per day above 512 MB.

Review the following sections:

¢ Section 7.2.1, “Rater Resources,” on page 146
¢ Section 7.2.2, “Rater Charges,” on page 147
¢ Section 7.2.3, “Virtual Server Rater Methods,” on page 147

7.2.1 Rater Resources

Raters calculate charges either according to the maximum use of a resource, or according to the
average use during a specific time period. The exception is when they charge against hourly data,
where charges are calculated using the average use only.

Table 7-1 Rater Resources

Resource Description

Uptime (Hours) The charge is based on the number of hours the network entity has
been monitored by PlateSpin Recon during the time specified in the
report.

Measurement and Time Period are dimmed for Flat and Tiered
Raters. Method is also dimmed for Allocation Raters.

VC_ProcessorTime (hour) The hourly average usage is computed and the sum of all the hour
averages during the time specified in the report is used for the
charge.

Measurement and Time Period are dimmed.

Processor (MHz) Selecting the Hour Time Period forces the use of the Average value,
even if Maximum is selected.

Memory Used(MB)

Network (MB/sec)

Disk (MB/sec)

Disk Space Used (GB)

Disk Writes (MB/sec)

Total Processor (Count) Static counter. The charge is made against a static value.

Measurement and Time Period are dimmed.

Total Memory (MB) Static counter. The charge is made against a static value.

Measurement and Time Period are dimmed.

Total Disk (GB) Static counter. The charge is made against a static value.

Measurement and Time Period are dimmed.
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NOTE: Aside from VC ProcessorTime, described in the preceding table, VC_specific counters are
not required nor useful for chargeback, and as a result are not available when creating raters. Use the
standard memory counters (Memory Used and Total Memory) as needed.

7.2.2 Rater Charges

Flat and Tiered raters: Charge represents the amount of cost assigned to a machine for every
measure of usage. For example, for every 3 GB of disk space used per week, apply the charge. For
Tiered raters, a Charge value must be entered for each tier.

Allocation raters: Charge represents the total cost of a virtual machine server resource. For
example, a rater could include a charge of $1000 per month for virtual machine server disk space.
Every virtual machine to which the rater is attached is assigned a percentage of the $1000,
proportional to its usage of the selected resource. For example, based on the above rater, if a virtual
machine server contains 3 virtual machines that use 50%, 25%, and 10% of its disk space,
respectively (either Virtual Server Usage or Virtual Server Capacity), they are assigned $500, $250,
and $100 per month in chargeback costs.

IMPORTANT: When using Chargeback with Solaris Zones, allocation raters calculate utilization
charges against the host, not the zone, using the formula:

+ charge = unit price * (zone total resource / host total resource)

If the zone and the host have the same number of resources—CPU, disk or memory—then the result
is as expected; but if they differ, unexpected results could be seen in the Cost Allocation report.

For example, if the host has two CPUs but the zone only has one and the charge in the rater for the
Processor resource is specified as $1, then with the above formula the resulting charge would be
$0.50.

If the host has a considerably larger number of resources compared to the zone, especially when
looking at memory and disk resources, the resulting charge could be very small. Since the
Chargeback Cost Allocation report displays only two decimal places, the conversion could
theoretically lose these small values and the charge on the report could appear as zero.

7.2.3 Virtual Server Rater Methods

The Virtual Server Rater Method determines whether the cost assigned to any virtual machine the
rater is attached to is calculated based on its percent of usage of the virtual machine server total
Virtual Server Usage for that resource, or based on its percent of usage of the virtual machine server
total Virtual Server Capacity for that resource.

For example, if a virtual machine server has 1000 GB of disk space, but only 800 are actually used,
a virtual machine using 200 GB of disk space is using 20% of Virtual Server Capacity, or 25% of
Virtual Server Usage. For a Charge of $1000/month, the virtual machine would be charged $200 if
Virtual Server Capacity is selected, but $250 if Virtual Server Usage is selected.
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7.3 Managing Raters

The Rater Explorer window is used to manage raters. You can add, edit, or delete raters, as well as
attach or detach raters to or from discovered machines. The Rater Explorer also allows you to view
current raters and their attachments.

A machine can have multiple raters and a rater can be used with multiple machines. Ratings are
performed on a one machine to one rater basis (that is, a rater only considers data from one machine
at a time).

¢ Section 7.3.1, “Creating a Rater,” on page 148

*

Section 7.3.2, “Deleting a Rater,” on page 149

*

Section 7.3.3, “Editing a Rater,” on page 149

*

Section 7.3.4, “Attaching Raters to Machines,” on page 150

*

Section 7.3.5, “Detaching a Rater from a Machine,” on page 151

7.3.1 Creating a Rater

1 In the Rater Explorer, do any of the following:
+ Click the ‘¥ icon.
+ Right-click the Rater type you want to create, then click 2 New.

The New Rater dialog box is displayed.

Fater Tope: () Allocation Fater (3% () Tiered Fater
General
Mame: | &1 Rater
Description:
Meazure
Resource: | Processar [MHz) w |

Measurement: (3 Average () Madimum
Time Period: @ How O Day Oweek O Month

Charge
Charge: | 1.00 | | Canadian Dollar [$) hd

18 l [ Cancel

2 Select a Rater type.

148 PlateSpin Recon 3.7.1 User Guide



The Rater type is automatically selected if you chose to create a new rater by right-clicking the
Rater type in Step 1. For more information on the Rater types, see Section 7.2, “Using Raters,”
on page 145.

3 Specify a name for the Rater.
4 (Optional) Specify a description.
5 In the Resource drop-down list, select a Rater resource.

Resources are also known as counters, because their purpose is to count usage of a resource.
For more information on resources, see Section 7.2.1, “Rater Resources,” on page 146.

6 Select the Measurement and Time Period to use, if they are not dimmed.

For Measurement, selecting Average means that the average value over the 7ime Period is used.
Selecting Maximum means that out of all the averages within the Time Period, the maximum
average is used. For example, there are 24 averages per day for hourly data and the maximum
average out of all the 24 averages is used against the charge value.

7 In the Factor option, specify a factor, which is the multiple of the resource units selected that
you want to use for the charge.

For example, you could charge $2.00 per 3 GB of disk space used. In this case, the Factor
would be 3.

8 In the Charge option, specify the Rater charges (monetary value) and select a currency type
from the drop-down list.

For more information, see Section 7.2.2, “Rater Charges,” on page 147.

9 (Conditional) For Allocation raters (virtual machines only), select a Virtual Server Rater
method in the Method drop-down list.

For more information, see Section 7.2.3, “Virtual Server Rater Methods,” on page 147.
10 Click OK.

The new rater is displayed in the Rater Explorer window under the appropriate rater type.

7.3.2 Deleting a Rater

In the Rater Explorer Window, do any of the following:

+ Select the rater you want to delete, click the Eicon or Press Delete.

+ Right-click the rater you want to delete, then click H Delete.

7.3.3 Editing a Rater

1 In the Rater Explorer, do any of the following:
+ Select the rater you want to edit, then click the 3 icon.
+ Right-click the Rater type you want to edit, then click &5 Edit.
The Edit Rater dialog box is displayed.

2 Edit the rater values as desired.

NOTE: You cannot edit the Rater type. If you want to change a rater type, you must delete the
rater, then create a new rater with the same name and the desired type.

3 Click OK.
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A confirmation prompt window is displayed.
4 Click OK.

If you have changed the rater name, the rater with the old name is removed from the Rater
Explorer window, and the rater with the new name is added to the Rater Explorer window.

Deleting a rater that is attached to a machine does not affect the machine, except to exclude it
from any chargeback calculations unique to the deleted rater.

7.3.4 Attaching Raters to Machines

A machine needs to be inventoried and in most cases monitored to enable a rater to access its
resources. You then need to attach the rater to the machine to have the machine cost calculated and
made available for reporting.

To calculate a charge, PlateSpin Recon must have monitoring data for all counters except Total
Processor, Total Memory, and Total Disk, which use inventory data.

1 In the Rater Explorer, do any of the following:
+ Select the rater you want to attach to a machine, then click the ¥ icon.
+ Right-click the Rater type you want to edit, then click & Attach.
The Select Raters dialog box is displayed.

Select Raters |Z|@@

Select Machines:

CRAIL
=[] Filters
] Demain
[ ] Manufacturer
] Operating System
=[] Status
[] Monitored
[] Nat Monitared
[] Unresponsive
[]\wfarning
] Subnet
[ Virtual Infrastructure Managers
VM Servers
[ ]'wlorkgroup
=[] Groups
& MyGroup
[] Sites

You can also use the Data Center Explorer window to attach a rater to a machine. Right-click
the machine you want to add the rater to, then click Chargeback in the menu. The Raters for
machine_name window is displayed where you can add or remove raters by selecting them and
using the Add and Remove buttons. Adding and removing raters from here is the same as
attaching or detaching them from the Rater Explorer window.

2 Select the check box next to the machine you want to add the rater to.
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You can select more than one machine.

You can attach Raters to groups, sites, or filters by selecting them in the Select Raters dialog
box.

3 Click OK.

The machines you attached the rater to are displayed in the Rater Explorer window beneath that
rater.

7.3.5 Detaching a Rater from a Machine

In the Rater Explorer, do any of the following:

¢ Select the machine you want to detach the rater from, then click the 5 icon.

+ Right-click the machine you want to detach the rater from, then click 5 Detach.

The rater is immediately detached and the machine is no longer displayed beneath the rater in the
Rater Explorer window.

7.4 Chargeback Reporting

Use the Cost Allocation report template under the Chargeback node in the Report Explorer window
to calculate chargeback values for a particular time period and to generate a report that includes
chargeback data. In addition to the columns available for inventory reports, Chargeback reports can
include raters attached to machines, their types, their calculated costs, and a description.

¢ Section 7.4.1, “Generating a Report to Calculate IT Chargeback Cost,” on page 151

¢ Section 7.4.2, “Deriving the Calculated Cost,” on page 151

7.41 Generating a Report to Calculate IT Chargeback Cost

To generate a report that calculates an IT chargeback cost for a particular business unit, ensure that

the Chargeback - Calculated Cost column is included in the report. In the Groups tab of the Create

View dialog box, create a grouping by a column such as Machine - Department or Machine - Billing
Code.

The generated report includes a total chargeback cost for every department, billing code, or any
other column used for grouping.

For more information on generating reports, see Chapter 5, “Generating and Viewing Charts and
Reports,” on page 79.

7.4.2 Deriving the Calculated Cost

The Calculated Cost in the Cost Allocation report is derived based on the Rater a machine is
attached to and the date range specified.

IT Chargeback
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Figure 7-1 Sample Rater
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A machine attached to the above Rater would be charged $1.00 for every week of 1 MHz processor
use.

When the Cost Allocation report is run for this machine, PlateSpin Recon adds the weekly processor
use together for each week in the report and multiplies it by the charge specified in the Rater. The
following figure shows a sample processor use chart and the chargeback Cost Allocation report that
would result.

Figure 7-2 Sample Chart and Correlating Chargeback Report
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The four data points are added together, multiplied by the unit cost, giving you the Calculated Cost.
The slight difference between this calculation and what is shown in the report is due to the chart
rounding values to a single decimal place. In this case:

o (75.8+ 1372+ 165.4 +97.2) * 1.00 = 475.6
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Virtual Infrastructure Management

The PlateSpin® Recon Virtual Infrastructure Management tools facilitate the administration of
Virtual Infrastructure in the data center. These include Virtual Center monitoring and the ability to
set up recurrent inventory jobs to have the most up-to-date information about virtual machines being
managed by a Virtual Center. VM Sprawl reports can also be generated on a one-time or recurrent
basis to provide information such as the age, last modification, and last boot time of the virtual
machines in the data center.

¢ Section 8.1, “Virtual Center Inventory and Monitoring,” on page 155
¢ Section 8.2, “VM Sprawl Reporting,” on page 156
¢ Section 8.3, “Virtual Machine State Reporting,” on page 157

8.1 Virtual Center Inventory and Monitoring

Direct Virtual Center inventory and monitoring enables multiple virtual machines to be more
efficiently inventoried from one single point instead of inventorying them individually.

Monitoring through the Virtual Center provides different information than monitoring a virtual
machine directly, because it is a picture of the virtual machine resource usage as detected by the
Virtual Center and ESX host. This is more accurate than a virtual machine reporting on its own
resource utilization. For example, a virtual machine using 90% of its allotted processing capabilities
reports its processor usage as 90%. In reality, it might have been allocated only 30% of the host
processor capabilities. This difference can only be detected by monitoring through the Virtual
Center, which reports what percentage of the host processor a virtual machine is using.

This difference has become more and more useful as data centers place emphasis on managing and
optimizing virtual machine usage as opposed to merely consolidating physical servers onto virtual
machines.

When a Virtual Center is inventoried, its associated machines are displayed in the Data Center
Explorer in a hierarchy that reflects the VMware Virtual Infrastructure Client hierarchy, including
all data centers, folders, clusters and pools.
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Figure 8-1 Data Center Explorver and VMware Virtual Infrastructure Client Comparison
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Inventorying a Virtual Center discovers all the machines that are part of the Virtual Center, so that
they can then be inventoried and monitored. When a virtual machine is inventoried through the
Virtual Center, it shows up as inventoried both as a node in the Virtual Center, and as an inventoried
machine under All in the Data Center Explorer. Either node can subsequently be used to initiate
monitoring.

You can right-click a cluster in a Virtual Center to view its properties, which are set in the Virtual
Center.

When a virtual machine that is part of a Virtual Center is monitored, certain values, such as
Processor Time, are collected both directly from the virtual machine and through the Virtual Center.
Values that are being collected through the Virtual Center are prefixed with VC, for example
VC_ProcessorTime.

For information about how to inventory a Virtual Center, see “Virtual Center” on page 31

8.2 VM Sprawl Reporting

The VM Sprawl report provides information about all virtual machines found by PlateSpin Recon,
along with information about their servers.

NOTE: If a VM is under a cluster and the parent host ESX machine is not inventoried by PlateSpin
Recon, the VM is displayed under the Cluster group of this report.
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You can use this report to keep track of the number and location of virtual machines resident in the
data center. VM Sprawl report information is obtained from the virtual machines’ host servers.

Citrix XenServer pools can also be inventoried by PlateSpin Recon, and these pools are treated
similarly to a Virtual Center The VM Sprawl report can also be used to report on these pools.

The VM Sprawl Report template is located in the Inventory Reports section of the Reports Explorer.
For more information about Inventory reports, see Section 5.2.4, “Working with Report Templates,”
on page 87.

8.3 Virtual Machine State Reporting

The Virtual Machine State report shows only the machines displayed under the VM Servers filter. It
is found under the Inventory Reports section of the Reports Explorer. For more information about
Inventory reports, see Section 5.2.4, “Working with Report Templates,” on page 87.
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Troubleshooting

This section provide solutions to the issues you might encounter when using Novell® PlateSpin®
Recon:

¢ “Refresh Inventory or Monitoring fails for a machine whose operating system has been
reformatted” on page 159
+ “Disk partitions for Citrix XenServer are not displayed” on page 160

+ “PlateSpin Recon fails to inventory the FC SAN disk connected to a Citrix XenServer 4.0
machine” on page 160

+ “Inventory of Solaris or Linux machines might fail with an error” on page 160

+ “When you manually export a report into the Excel format, the gigabyte values are converted
into bytes or some data might be displayed as System.Err”” on page 160

¢ “Disk IO metrics are not available for ESX 3.0” on page 160

¢ “The Summary Statistics table is not displayed when you export a report to HTML, File, or
RTF file format” on page 161

¢ “The Queue Length metrics are not collected for Virtual Center and ESX” on page 161
¢ “Data for the Partitioned and Unpartitioned counters is not collected for Solaris” on page 161

+ “Monitoring a Windows machine fails with errors related to access to the registry keys” on
page 161

¢ “An AIX machine might hang or slow down when you run the Ispv command” on page 161

¢ “The loop7 partitions of Citrix XenServer are inventoried and monitored as a new disk” on
page 162

¢ “Unable to detect the processor model for a Windows operating system installed on Connoi
hardware” on page 162

+ “Issues when attempting to add servers to the PlateSpin Recon Inventory” on page 162

+ “Importing a machine from PlateSpin Recon snapshot fails” on page 162

Refresh Inventory or Monitoring fails for a machine whose operating system has
been reformatted

Source: PlateSpin Recon; Inventory and Monitoring.

Explanation: Ifyou reformat the operating system of a machine after it has been inventoried,
the Refresh Inventory or Monitoring for the machine fails.

Action: Perform the following tasks in the Data Center Explorer of the PlateSpin
Recon Client:
1 Delete the existing object of the machine whose operating system has
been reformatted.
2 Inventory or monitor the machine.

For more information on how to inventory or monitor a machine, see
Section 3.2, “Discovering and Inventorying Data Center Resources,” on
page 30.
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Disk partitions for Citrix XenServer are not displayed
Source: PlateSpin Recon; Inventory.

Explanation: The disk partitions of an inventoried Citrix XenServer are not displayed in the
Storage tab of the Properties page of the server.

Action: None.

PlateSpin Recon fails to inventory the FC SAN disk connected to a Citrix XenServer
4.0 machine

Source: PlateSpin Recon; Inventory.

Explanation: PlateSpin Recon does not inventory the FC SAN disk attached to a Citrix
XenServer 4.0 machine. Consequently, the disk is not displayed in the Storage
tab of the Properties page of Citrix XenServer.

Action: None.

Inventory of Solaris or Linux machines might fail with an error
Source: PlateSpin Recon; Inventory.
Explanation: The inventory of a Solaris or Linux machine might fail with an error

Possible Cause: The /tmp directory on the Solaris or Linux machine does not have sufficient
free space.

Action: Before inventorying a Solaris or Linux machine, ensure that the /tmp directory
on the machine has a minimum of 50 MB of free space.

When you manually export a report into the Excel format, the gigabyte values are
converted into bytes or some data might be displayed as System.Err

Source: PlateSpin Recon; Reports.

Explanation: If a report contains values expressed in terms of gigabytes (GB), the values
might be converted into bytes when you manually export the report into the
Excel format.

Some data in the report might also be displayed as System.Err.

Action: While manually exporting a report that contains values expressed in terms of
gigabytes into the Excel format, deselect the Export Values Using their Format
option in the XLS Export Options dialog box (Reporting toolbar > Export
Document drop-down list > Excel File).

Disk 10 metrics are not available for ESX 3.0
Source: PlateSpin Recon.

Explanation: The Disk I0% counter is not displayed for ESX 3.0 in the Chart Viewer.

Possible Cause: ESX 3.0 does not support the required counters used in the calculation of Disk
10%.

Action: None.
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The Summary Statistics table is not displayed when you export a report to HTML,
File, or RTF file format

Source: PlateSpin Recon; Reporting.

Explanation: The Summary Statistics table is not displayed when you export a report in any
of the following formats:

¢ HTML File
+ MHT File
¢ RTF File with the export mode as Single File Page-by-Page

Action: None.

The Summary Statistics table is correctly displayed when you export a report
into the RTF File format with the export mode as Single File.

The Queue Length metrics are not collected for Virtual Center and ESX
Source: PlateSpin Recon; Monitoring.

Explanation: The QueuelLength metrics are not collected for any type of storage volumes
(local or shared) for ESX monitored directly or through vCenter.

Possible Cause: Virtual Center and ESX do not support the required counters for the
QueueLength metrics.

Action: None.

Data for the Partitioned and Unpartitioned counters is not collected for Solaris
Source: PlateSpin Recon; Inventory and Monitoring.
Possible Cause: “Partition 2” is not available for a disk on the Solaris machine.

Action: None.

Monitoring a Windows machine fails with errors related to access to the registry
keys

Source: PlateSpin Recon; Monitoring.

Explanation: When monitoring a Windows machine fails, the monitor log contains the
following error:

Access to the registery key key number is denied.
Possible Cause: The registry key is being read by some other application at the same time.

Action: Ignore the errors. PlateSpin Recon automatically collects the data after the
registry key is released by the other application.

An AIX machine might hang or slow down when you run the Ispv command

Source: PlateSpin Recon; Monitoring.
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Explanation: When you run the 1spv monitoring command on an AIX machine, the
machine might hang or slow down. This is a known issue with AIX.
Consequently, the data is not collected for the following counters:

*

PhysicalDisk PartitionedSpaceGB
PhysicalDisk UnpartitionedSpaceGB

*

*

PhysicalDisk PercentPartitionedSpace

*

PhysicalDisk PercentUnpartitionedSpace counters

Additionally, a warning message is displayed in the logs. The warning
message also includes the solution for the issue.

Action: Perform the tasks as suggested in the warning message.

The loop7 partitions of Citrix XenServer are inventoried and monitored as a new disk
Source: PlateSpin Recon; Inventory and Monitoring

Explanation: When you mount the XenServer tools ISO to the DVD drive at /dev/xvd on a
VM of a Citrix XenServer host to install the XenServer tools, the Citrix
XenServer host creates a disk partition with the same size as that of the
mounted ISO. When you inventory or monitor the Citrix XenServer, PlateSpin
Recon considers the disk partition as a new disk, and reports it as loop7 in the
machine properties and charts.

Action: None.
Unable to detect the processor model for a Windows operating system installed on
Connoi hardware

Source: PlateSpin Recon; Inventory and Monitoring.

Action: None.

Issues when attempting to add servers to the PlateSpin Recon Inventory
Source: PlateSpin Recon; Inventory.

Explanation: You might encounter issues when attempting to add servers to the PlateSpin
Recon Inventory, including the following error messages:

Network Path Not found
Access Denied
The RPC Server is unavailable

Failed. The Network location cannot be reached

Action: Refer to Knowledge Base article Q20525 (http://support.platespin.com/kb2/
article.aspx?1d=20525): Troubleshooting problems when adding servers to the
PlateSpin Recon Inventory.

Importing a machine from PlateSpin Recon snapshot fails

Source: PlateSpin Recon; Snapshots.
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Explanation: When attempting to import a machine from a PlateSpin Recon snapshot, you
might encounter the following error message:

Cannot import MachineObject 'MACHINE-NAME [MACHINE-NAME]'

Action: Refer to Knowledge Base article Q20900 (http://support.platespin.com/kb2/
article.aspx?id=20900): Cannot import MachineObject error when importing a
machine from a snapshot.
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Technical Reference

This section contains technical information to help you customize PlateSpin® Recon.

¢ Section B.1, “Features,” on page 165

¢ Section B.2, “How PlateSpin Recon Collects Data,” on page 165

¢ Section B.3, “Data Collection,” on page 167

¢ Section B.4, “Charts and Formulas,” on page 168

¢ Section B.5, “Calculations,” on page 176

¢ Section B.6, “CPU Normalization,” on page 179

¢ Section B.7, “PlateSpin Recon VM CPU Inventory,” on page 180

¢ Section B.8, “Inventory and Monitoring Commands for Linux, Solaris and AIX,” on page 180

This section is for system administrators and virtualization architects who require advanced
knowledge of PlateSpin Recon.

It is assumed that readers of this document are familiar with:

¢ Administration of Windows and Linux operating systems

+ Administration of VMware ESX, VMware Server, and Microsoft Virtual servers

B.1 Features

¢ Hardware and software asset inventory

¢ Secure on-site data collection and analysis

¢ Windows and Linux support

¢ Management reports

¢ Integration with Microsoft Operations Manager 2005 and the remote PlateSpin Recon server
¢ Advanced project and scenario modeling

¢ Integration with the PlateSpin Portability Suite

B.2 How PlateSpin Recon Collects Data

PlateSpin Recon has three sequential stages to its data collection.

¢ Section B.2.1, “Discovery,” on page 165
¢ Section B.2.2, “Inventory,” on page 166
¢ Section B.2.3, “Monitoring,” on page 166

B.2.1 Discovery

Domain Discovery: PlateSpin Recon uses Windows Active Directory* via LDAP to scan the
network for a list of the machines on the specified domain. By default, this includes only online
machines, but there is an option to include offline machines as well.
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An Organizational Unit (OU) filter can also be specified, narrowing the area of the domain that
PlateSpin Recon will poll during discovery. An Organization Unit is a container within a domain
where computers can reside for segmentation. For example, if your domain has OU containers setup
for each department, you can tell PlateSpin Recon to just look for machines within a specific
department within the domain.

PlateSpin Recon only uses OU filters during discovery. Machines discovered in this way are
unaffected during inventory and monitoring should machines be moved out of their previous OU
containers. For more information on Organization Units and if they are in use in your domains,
check with your System Administrator.

Subnet, IP Range Scan: For each machine in the subnet or IP range, PlateSpin Recon pings the
machine. If it replies, it is considered a discovered machine.

Another option is to port scan through TCP, UDP or both. PlateSpin Recon tries to connect to ports
and records which ports are being used. This option must be used with caution because network
security might consider this an attack.

B.2.2 Inventory

¢ “Linux, Solaris, and ESX 2.x” on page 166
¢ “ESX 3.x and Virtual Center” on page 166

* “Microsoft Windows Inventory” on page 166

Linux, Solaris, and ESX 2.x
¢ PlateSpin Recon sends the getplatform script, which returns the architecture and glibc
version of the machine being inventoried.

¢ Based on getplatform, PlateSpin Recon uses the SCP protocol to transfer a platform-specific
inventory binary and libraries to the /tmp directory of the machine being inventoried.

¢ Opver ssh, PlateSpin Recon executes the binary, streaming the command file over stdin.

+ Logs and progress files are streamed back from the inventoried machine to the PlateSpin Recon
Server using stderr while the machine XML is streamed over stdout.

ESX 3.x and Virtual Center

¢ PlateSpin Recon runs the executable locally on the PlateSpin Recon Server.

¢ The executable accesses ESX 3 or Virtual Center Web services, which provide the necessary
inventory data.

Microsoft Windows Inventory

¢ PlateSpin Recon copies an executable onto the machine being inventoried to the directory
within ADMINS and C$. PlateSpin Recon runs the executable through WMI or a remote service.
If you are inventorying a Windows NT machine, it is important to make sure that WMI is
installed.

B.2.3 Monitoring

¢ “Linux, Solaris, AIX, and ESX 2.x” on page 167
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¢ “ESX 3.x and Center” on page 167
¢ “Microsoft Windows” on page 167

Linux, Solaris, AlX, and ESX 2.x
¢ PlateSpin Recon sends a script (1ininfo.sh lininfo.sh, solinfo.sh, aixinfo.sh, or
esxinfo.sh) to the machine being inventoried.
¢ The script is run through ssh.
¢ The ssh server must be enabled for monitoring to function.
+ Logs are streamed back to the PlateSpin Recon Server over stderr.

+ Performance data is streamed back over stdout.

NOTE: PlateSpin Recon currently does not support Sudo monitoring for UNIX machines. If the
monitoring commands for your machine have root privileges, monitoring by using sudo user
credentials will be successful.

ESX 3.xand Center

¢ PlateSpin Recon calls ESX 3 or Virtual Center Web services, which provide the necessary
performance data.

Microsoft Windows

¢ PlateSpin Recon uses the Windows Performance Counter API to retrieve performance data. It
does not use WMI.

¢ The Remote Registry Service must be enabled for Windows monitoring to function.

B.3 Data Collection

By default, every 5 minutes, PlateSpin Recon takes three samples, three seconds apart, from all
counters. The three samples are averaged together to produce the five-minute data that is stored in
the database.

These values can be modified by clicking the Tools menu, then holding down the Ctrl key while
selecting Options from the menu. On the Server tab, expand the Monitoring Service section:

Technical Reference 167



Figure B-1 Options Window
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B.4 Charts and Formulas

¢ Section B.4.1, “Chart Data,” on page 169
¢ Section B.4.2, “Utilization,” on page 172
¢ Section B.4.3, “Workload,” on page 174
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B.4.1 Chart Data

The five-minute data collected as described in Section B.3, “Data Collection,” on page 167 is stored
in the database for thirty days. The one-hour data is a summary of all the five-minute data collected
during a particular hour. It is stored permanently in the database. All other chart data is calculated

from the five-minute and one-hour data.

The twenty-four hour profile chart provides a value for each hour in a twenty-four hour period. This
value is the largest average value calculated for the particular hour over the selected date range. This

produces a utilization profile for the hourCounter.

Counter values are named for the Windows Performance Monitor counters used to retrieve them
from Windows systems. The name consists of the Performance Monitor category joined by an
underscore to the counter name. For example, Memory/PagesPerSecond becomes

Memory PagesPerSecond.

For Windows systems, these values are taken directly from Performance Monitor, but for other

platforms, scripts are used to calculate the values.

¢ “Platform Counters” on page 169

¢ “Collecting Counters for ESX Machines Monitored through the Virtual Center Server for

Consolidated Planning” on page 172

¢ “Prerequisite for Collecting the XEN Counters for VMs Running on SLES with the Xen

Kernel” on page 172

* “Prerequisite for Collecting Counters for Citrix Xen Hosts” on page 172

Platform Counters

The following table lists the counters collected by PlateSpin Recon for the supported platforms:

Table B-1 Platform Counters

Name

Platforms

LogicalDisk_FreeMegabytes

LogicalDisk_UsedMegabytes
LogicalDisk_PercentUsedSpace

LogicalDisk_PercentFreeSpace

Memory_AvailableBytes

Memory_PagesPerSecond
Memory_PercentAvailableMemory

NetworkInterface_BytesTotalPerSecond

NetworkInterface_PacketsPerSecond

All platforms except for ESX 2.5.x, NetWare,
Windows 2000, and Windows NT

All platforms except for ESX 2.5.x and NetWare
All platforms except for ESX 2.5.x and NetWare

All platforms except for ESX 2.5.x, NetWare,
Windows 2000, and Windows NT

Windows, Windows NT, Solaris, Linux, ESX 2.5.x,
ESX 3.x, ESX 4, Citrix XenServer

Windows, Windows NT
ESX 3.x, ESX 4

Windows, Solaris, Linux, ESX 2.5.x, ESX 3.x, ESX
4, Citrix XenServer

Windows, Solaris, Linux, ESX 2.5.x, ESX 3.x, ESX
4
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Name

Platforms

PhysicalDisk_CurrentDiskQueuelLength

PhysicalDisk_DiskBytesPerSecond

PhysicalDisk_DiskTransfersPerSecond
PhysicalDisk_DiskWriteBytesPerSecond

PhysicalDisk_PercentldleTime

PhysicalDisk_TotalSpaceGB
PhysicalDisk_UsedSpaceGB
PhysicalDisk_FreeSpaceGB
PhysicalDisk_PercentUsedSpace
PhysicalDisk_PercentFreeSpace
PhysicalDisk_PartitionedSpaceGB
PhysicalDisk_UnpartitionedSpaceGB
PhysicalDisk_PercentPartitionedSpace
PhysicalDisk_PercentUnpartitionedSpace

Processor_PercentProcessorTime

System_ProcessorQueuelLength

VC_Processor

VC_ProcessorTime

VC_ProcessorPercentReady
VC_ProcessorPercentWait

VC_MemoryPercentUsed

VC_MemoryAvailableBytes

VC_NetBytesTotalPerSecond

VC_NetPacketsPerSecond

VC_DiskBytesPerSecond

VC_MemoryBalloon

All platforms except for ESX 3.x, ESX 4.0, and
NetWare

Windows, Windows NT, Solaris, Linux, ESX 2.5.x,
ESX 3.x, ESX 4, Citrix XenServer

Windows, Windows NT, Solaris, Linux, ESX 2.5.x
Windows

All platforms except for ESX 2.x, ESX 3.0, and
NetWare

All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare
All platforms except for ESX 2.x and NetWare

Windows, Windows NT, Solaris, Linux, ESX 2.5.x,
ESX 3.x, ESX 4, Citrix XenServer

Windows, Windows NT, Solaris, Linux, ESX 2.5.x

All VMs, ESXs, Resource Pool, and clusters
monitored through VMware vCenter.

All VMs and ESXs monitored through VMware
vCenter.

All VMs monitored through VMware vCenter
All VMs monitored through VMware vCenter

All VMs, ESXs, Resource Pool, and clusters
monitored through VMware vCenter.

All VMs, ESXs, and Resource Pool monitored
through VMware vCenter.

All VMs and ESXs monitored through VMware
vCenter.

All VMs and ESXs monitored through VMware
vCenter.

All VMs and ESXs monitored through VMware
vCenter.

All VMs, ESXs, Resource Pool, and clusters
monitored through VMware vCenter.
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Name

Platforms

VC_MemorySwapUsed

VC_EffectiveMemory

VC_EffectiveCPU

VC_DiskReadBytesPerSecond

VC_DiskWriteBytesPerSecond

VC_DiskReadCountPerSecond

VC_DiskWriteCountPerSecond

VC_DiskBytesPerRead

VC_DiskBytesPerWrite

VC_DiskPercentldleTime

VC_DiskTotalSpaceGB
VC_DiskUsedSpaceGB
VC_DiskFreeSpaceGB
VC_DiskPercentUsedSpace
VC_DiskPercentFreeSpace
VC_DiskPartitionedSpaceGB
VC_DiskUnpartitionedSpaceGB
VC_DiskPercentPartitionedSpace
VC_DiskPercentUnpartitionedSpace
VC_LogicalDiskUsedMegabytes
VC_LogicalDiskFreeMegabytes
VC_LogicalDiskPercentUsedSpace
VC_LogicalDiskPercentFreeSpace
Xen_Memory_AvailableBytes

Xen_Processor_PercentProcessorTime

Xen_Networkinterface_ByteTotalPerSecond

All ESXs and clusters monitored through VMware
vCenter.

All clusters enabled with DRS and monitored
through VMware vCenter.

All clusters enabled with DRS and monitored
through VMware vCenter.

All VMs and ESXs monitored through VMware
vCenter.

All VMs and ESXs monitored through VMware
vCenter

All VMs and ESXs monitored through VMware
vCenter

All VMs and ESXs monitored through VMware
vCenter

All VMs and ESXs monitored through VMware
vCenter.

All VMs and ESXs monitored through VMware
vCenter.

ESX 3.5 and later monitored through VMware
vCenter except vCenter 2.0.

All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.
All ESXs monitored through VMware vCenter.

Xen on Novell® SLES 10 and SLES11, Citrix
XenServer

Xen on Novell SLES 10 and SLES 11, Citrix
XenServer

Citrix XenServer
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Name Platforms

Xen_PhysicalDisk_DiskBytesPerSecond Citrix XenServer

Collecting Counters for ESX Machines Monitored through the Virtual Center Server
for Consolidated Planning

ESX machines are inventoried and monitored through the VC Server. However, the data does not
contain all counters of the ESX machine required for consolidated planning because of the
limitations of the VC Server. You need to directly collect additional information from the ESX
machine.

1 In the Data Center Explorer, navigate to Filters > VM Servers > VMware ESX Servers.

2 Right-click the ESX machine whose counters you want to collect, then click Stop Monitoring.

3 Right-click the ESX machine again, then click Attach Credentials.

The Attach Credentials dialog box is displayed.

4 Specify the credentials for the machine, then click OK.

5 Right-click the ESX machine, click Refresh Inventory, then click Now.

6 Right-click the ESX machine, then click Start Monitoring.

Prerequisite for Collecting the XEN Counters for VMs Running on SLES with the Xen
Kernel

If you want to collect the Xen counters for VMs running on SLES with the Xen kernel, do the
following on the SLES host device before you start monitoring it:
1 Edit /etc/xen/xend-config.sxp to add the following line:
(xen-api-server ((9363 none) (unix none)))
2 Restart the Xen daemon by entering the following command:

/etc/init.d/xend restart

Prerequisite for Collecting Counters for Citrix Xen Hosts
To collect counters for the Citrix Xen hosts, you must attach the credential to all the hosts.

1 Ensure that SSH is enabled on port 22 on the Citrix Xen hosts.
2 In the Data Center Explorer, right-click a Citrix Xen host, then click Stop Monitoring.
3 Right-click the Citrix Xen host again, then click Attach Credentials.
The Attach Credentials dialog box is displayed.
4 Specify the credentials for the machine, then click OK.
5 Right-click the Citrix Xen host, then click Start Monitoring.
6 Repeat Step 2 through Step 5 for all the Citrix Xen hosts.

B.4.2 Utilization

Utilization formulas represent the percentage of the available resources being used by a given
workload. The calculations are based on counter data.
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Table B-2 Utilization Formulas

Name

Formula

Platforms

Disk 10 (%)

Disk Space Free (%)

Disk Space Used (%)

Memory Free (%)

Memory Used (%)

Processor (%)

Disk Space Partitioned (%)

Disk Space Unpartitioned (%)

Logical Disk Used Space (%)

Logical Disk Free Space (%)

VC_Memory Free (%)

VC_Memory Used(%)

VC_ProcessorTime (Hour)

VC_Disk 10 (%)

VC_Disk Space Free (%)

VC_Disk Space Partitioned (%)

VC_Disk Space Unpartitioned (%)

MAX(0,(100-
PERF(“PhysicalDisk_Percentldle
Time”)))

PERF(“PhysicalDisk_PercentFre
eSpace”)

PERF(“PhysicalDisk_PercentUse
dSpace”)

100*(PERF(“Memory_AvailableB
ytes”))/INV(“TotalMemory”)

100*(INV(“TotalMemory”)-
PERF(“Memory_AvailableBytes”)
YINV(“TotalMemory”)

PERF(“Processor_PercentProce
ssorTime”)

PERF(“PhysicalDisk_PercentPart
itionedSpace”)

PERF(“PhysicalDisk_PercentUnp
artitionedSpace”)

PERF(“LogicalDisk_PercentUsed
Space”)

PERF(“LogicalDisk_PercentFree
Space”)

100*(PERF(“VC_MemoryAvailabl
eBytes”))/INV(“TotalMemory”)

100*(INV(“TotalMemory”)-
PERF(“VC_MemoryAvailableByt
es”))/INV(“TotalMemory”)

PERF(“VC_ProcessorTime”)

MAX(0,(100-
PERF(“VC_DiskPercentldleTime”
))

PERF(“VC_DiskPercentFreeSpa
ce”)

PERF(“VC_DiskPercentPartitione
dSpace”)

PERF(“VC_DiskPercentUnpartiti
onedSpace”)

All platforms except for
NetWare®, ESX 2.5.x, ESX 3.0.

All platforms except for NetWare,
ESX 2.5.x

All platforms except for NetWare,
ESX 2.5.x

Windows, Solaris, Linux, ESX
2.5.x, ESX 3.x, ESX 4, Citrix
XenServer

Windows, Solaris, Linux, ESX
2.5.x, ESX 3.x, ESX 4, Citrix
XenServer

Windows, Solaris, Linux, ESX
2.5.x, ESX 3.x, ESX 4, Citrix
XenServer

All platforms except for NetWare,
ESX 2.5.x

All platforms except for NetWare,
ESX 2.5.x

All platforms except for NetWare,
ESX 2.5.x

All platforms except for NetWare,
ESX 2.5.x, Windows NT, and
Windows 2000

All

All

All

ESX 3.5 or later monitored
through vCenter 2.5 or later

All ESXs monitored through
vCenter

All ESXs monitored through
vCenter

All ESXs monitored through
vCenter
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Name

Formula

Platforms

VC_Disk Space Used (%)

VC_Logical Disk Used Space (%)

VC_Logical Disk Free Space (%)

PERF(“VC_DiskPercentUsedSpa
ce”)

PERF(“VC_LogicalDisk_Percent
UsedSpace”)

PERF(“LogicalDisk_PercentFree
Space”)

All ESXs monitored through
vCenter

All ESXs monitored through
vCenter

All ESXs monitored through
vCenter

NOTE: Utilization expressions are not available for Virtual Center clusters.

B.4

.3 Workload

Workload formulas measure workload size; that is, the amount of processing power and raw
resources being used for a workload, independent of the total hardware and resources available.

¢ PERF: Dynamic performance data

¢ INV:Static inventory data

Table

B-3 Workload Formulas

Name

Formula

Platforms

Disk (MB/sec)

Disk (Transfers/sec)

Disk Queue Length

Disk Space Free (GB)

Disk Space Used (GB)

Disk Writes (MB/sec)

Logical Disk Used Space (MB)

Logical Disk Free Space (MB)

Memory (Pages/sec)

Memory Free (MB)

(PERF(“PhysicalDisk_DiskByte
sPerSecond”))/(1024*1024)

PERF(“PhysicalDisk_DiskTrans
fersPerSecond”)

PERF(“PhysicalDisk_CurrentDi
skQueuelength”)

PERF(“PhysicalDisk_FreeSpac
eGB”)

PERF(“PhysicalDisk_UsedSpac
eGB”)

(PERF(“PhysicalDisk_DiskWrit
eBytesPerSecond”))/
(1024*1024)

PERF(“LogicalDisk_UsedMega
bytes”)

PERF(“LogicalDisk_FreeMegab
ytes”)

PERF(“Memory_PagesPerSec
ond”)

(PERF(“Memory_AuvailableByte
s”)) /(1024*1024)

All

Windows, Windows NT, Solaris,
Linux, ESX 2.5.x

Windows, Windows NT, Solaris,
Linux, ESX 2.5.x, Citrix
XenServer

All platforms except for
NetWare and ESX 2.5.x

All platforms except for
NetWare and ESX 2.5.x

Windows

All platforms except for
NetWare, ESX 2.5.x

All platforms except for
NetWare, ESX 2.5.x, Windows
NT, and Windows 2000

Windows, Windows NT

All
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Name

Formula

Platforms

Memory Used (MB)

Network (MB/sec)

Network (Packets/sec)

Processor (MHz)

Processor Queue Length

VC_Disk (MB/sec)

VC_MemoryFree (MB)

VC_MemoryUsed (MB)

VC_Network (MB/sec)
VC_Network (Packets/sec)
VC_Processor (MHz)
VC_Disk Space Partitioned
(GB)

VC_Disk Space Used(GB)
Disk Space Partitioned (GB)

VC_Total Disk (GB)

Total Processor (Count)

VC_Processor (Normalized)

Total Memory (MB)

VC_Disk Space Unpartitioned
(GB)

(INV(“TotalMemory”)-
PERF(“Memory_AvailableBytes
")) 1(1024*1024)

(PERF(“NetworkInterface_Byte
sTotalPerSecond”))/
(1024*1024)

PERF(“Networkinterface_Pack
etsPerSecond”)

PERF(“Processor_PercentProc
essorTime”)*INV(“ProcessorCa
pacity”)/100

PERF(“System_ProcessorQue
ueLength”)

(PERF(“PhysicalDisk_DiskByte
sPerSecond”))/(1024*1024)

(PERF(“Memory_AvailableByte
s”)) /(1024*1024)

(INV(“TotalMemory”)-
PERF(“Memory_AvailableBytes
")) /(1024*1024)

(PERF(“VC_NetBytesTotalPerS
econd”))/(1024*1024)

PERF(“VC_NetPacketsPerSec
ond”)

PERF(“VC_Processor”)

PERF(“VC_DiskPartitionedSpa
ceGB”)

PERF(“VC_DiskUsedSpaceGB”
)

PERF(“PhysicalDisk_Partitione
dSpaceGB”)

PERF(“VC_DiskTotalSpaceGB”
)

INV(“ProcessorCount”)

PERF(“VC_Processor”)/
INV(“ProcessorCapacity”)*INV/(*
ProcessorCapacitylnSpecUnits”

)

INV(“TotalMemory”)/
(1024*1024)

PERF(“VC_DiskUnpartitionedS
paceGB”)

All

Windows, Solaris, Linux, ESX
2.5.x, ESX 3.x, Citrix XenServer

Windows, Solaris, Linux, ESX
2.5.x, ESX 3.x, ESX 4

Windows, Windows NT, Linux,
ESX 2.5.x, ESX 3.x, ESX 4,
Citrix XenServer, Solaris

Windows, Windows NT, Solaris,
Linux, ESX 2.5.x

All

All

All

All

All

All

ESX monitored through vCenter

ESX monitored through vCenter

All platforms except for
NetWare and ESX 2.5.x

All ESXs monitored through
vCenter

All ESXs monitored through
vCenter
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Name Formula Platforms

Disk Space Unpartitioned (GB) PERF(“PhysicalDisk_Unpartitio All platforms except for
nedSpaceGB”) NetWare and ESX 2.5.x

Processor (Normalized) PERF(“Processor_PercentProc
essorTime”)* INV(“ProcessorCa
pacitylnSpecUnits”)/100

Total Disk (GB) PERF(“PhysicalDisk_TotalSpac All platforms except for
eGB”) NetWare and ESX 2.5.x

VC_Disk Space Free (GB) PERF(“VC_DiskFreeSpaceGB” All ESXs monitored through
) vCenter

VC_Logical Disk Used Space PERF(“VC_LogicalDiskUsedMe All ESXs monitored through
(MB) gabytes”) vCenter

VC_Logical Disk Free Space PERF(“VC_LogicalDiskFreeMe All ESXs monitored through
(MB) gabytes”) vCenter

NOTE: Workload expressions are not available for Virtual Center clusters.

B.5 Calculations

¢ Section B.5.1, “24-Hour Profile,” on page 176

¢ Section B.5.2, “Dual-Core and Multi-Core Machines,” on page 177
¢ Section B.5.3, “Hyper-Threading,” on page 177

¢ Section B.5.4, “Effective Speed,” on page 178

¢ Section B.5.5, “Power and Cooling,” on page 178

¢ Section B.5.6, “CO2 Emission,” on page 178

B.5.1 24-Hour Profile

The 24-hour profile consists of 24 values that correspond to each hour of the day (0 to 23). Each
value is calculated by taking the peak value for that specific hour over the number of monitoring
days.

Example

Consider a system monitored for 3 days. The following chart presents the data set for its Processor
workload, and the calculated 24-hour profile:

Table B-4 Processor Workload Data Set

Hour Day 1 Day 2 Day 3 24-Hour Profile
0 200 300 500 500
1 300 300 250 300
2 300 400 450 450
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Hour Day 1 Day 2 Day 3 24-Hour Profile

3 700 250 350 750
4 500 500 500 500
5 600 400 500 600
6 500 550 750 750
7 400 600 800 800
8 500 300 250 500
9 450 350 640 640
10 200 240 340 340
11 300 600 +60 650
12 300 - - 300
13 550 340 850 850
14 440 500 600 600
15 800 540 600 800
16 750 260 430 750
17 500 640 450 640
18 600 200 350 600
19 300 250 650 650
20 200 300 200 300
21 250 350 400 400
22 600 250 350 600
23 500 650 750 750

B.5.2 Dual-Core and Multi-Core Machines

PlateSpin Recon considers and treats dual-core or multi-core machine as two-processor or x-
processor machines.

B.5.3 Hyper-Threading

The effect of hyper-threading is controlled by two configuration parameters: Aggregate Instance
Function (SUM, AVG) and Hyper-threading Normalization Factor (1 — 2). The default value for
aggregate instance function is AVG, and the normalization factor is set to 1.25. These values can be
configured in the advanced settings under 7ools > Options.

PlateSpin Recon collects each individual processor instance’s utilization values at a given time and
then calculates the processor utilization based on the aggregate function. If the aggregate function is
SUM, then the physical processor utilization is the sum of all logical processor instances’ utilization.
If the aggregate function is AVG, then the physical processor utilization would be average of all
logical processor instances’ utilization.
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Example

Consider a system with single-core processor with hyper-threading enabled at p MHz speed. For a
given period of time, PlateSpin Recon calculates the percentile utilization values for 24H profile
values of instance X and Y as follows.

{X}= {X1, X2, Xi.....X24}, Xi is the utilization of the processor instance X at hour i.

{Y}=1{Y1, Y2, Yi.....Y24}, Yi is the utilization of the processor instance Y at hour i.

Table B-5 Aggregate Function Calculations

(Aggregate Function,

Normalization Factor) (Sum, f) (AVG, f)

Reports: Peak % Max { X +Y} Max{(X+Y)/2}

Reports: Peak (MHz) Max {X+Y}*(1/100) *p * f Max { (X+Y)/2}* (1/100) *p * f
CPM: Workload calculation {X+Y}* (1/100) *p * f {(X+Y)/2} * (1/100) *p * f

B.5.4 Effective Speed

PlateSpin Recon takes both number of cores and hyper-threading into account when calculating the
effective speed of a machine.

Example:

Server template specification: 2 x 3000 GHz, dual core, and hyper-threading enabled
Number of processors: P=2 *2 =4

Processor capacity: C = 3000 GHz

Hyper-threading normalization factor: n = 1.25 (default value)

Scaling factor: A(p)=P/ {1 +&a(P-1) } , where 4= 0.05

A(p)=4/{1+0.05*3} =3.4782

Effective speed = A(p) * C * n=3.4782 * 3000 * 1.25 = 13043 MHz

B.5.5 Power and Cooling

Energy Use (kWh/yr) = Power Usage (W) x Server Derating Factor x Number of hours in a year
(8760) / 1000

Heat Dissipation (BTU/yr) = Energy Use (kWh/yr) x 3.41

Annual Energy Cost = Energy Cost per kWh x Energy Use (kWh/yr)

B.5.6 CO2 Emission

Energy Use (kWh/yr) = Power Usage (W) x Server Derating Factor x Number of hours in a year
(8760) / 1000
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CO2 Emission (1b/yr) = Energy Use (kWh/yr) x 1.54

The constant factor of 1.54 has been considered as per the standards.

B.6 CPU Normalization

CPU normalization allows the actual speed of a CPU to be considered for operations such as
consolidation planning, instead of relying on the CPU clock frequency, which can be misleading.
Different CPU manufacturers and models provide a wide array of performance results for CPUs
with the same clock frequency. For example, there is a considerable difference between a Core 2 and
a Pentium IV CPU with a clock frequency of 2.0 GHz. CPU normalization uses the SPEC data
industry standard benchmarks to give real-world performance values. This is an important factor in
realistic consolidation planning. See Section B.6.1, “SPEC Data,” on page 179 for more
information.

In consolidation planning, when a scenario is created, the user is given an option to select between
clock frequency and normalized speed as the unit of measurement for processor utilization and
capacity. The consolidation planning algorithms use the appropriate unit of measurement when
assigning workloads to containers, based on these selections. For more information see Section 6.5,
“Working with Consolidation Scenarios,” on page 124.

NOTE: The data required to perform consolidation planning based on normalized speed is actually
produced when a project is created. Projects from a pre-3.5 version of PlateSpin Recon, even if
upgraded, cannot use normalized speed in consolidation planning (the option is disabled in the
scenario creation wizard). To use normalization speeds with these projects, they must be re-created
from scratch.

¢ Section B.6.1, “SPEC Data,” on page 179
¢ Section B.6.2, “Normalization Speed,” on page 179

B.6.1 SPEC Data

PlateSpin Recon CPU normalized speed makes use of SPECint* and SPECp* (98, 2000, 2006)
CPU benchmarking data. The PlateSpin Recon CPU Normalization rating for specific CPUs are an
average of data available from http://www.spec.org (http://www.spec.org) for those CPUs as of June
2008. For the latest SPECt* benchmark results, visit http://www.spec.org (http://www.spec.org).

B.6.2 Normalization Speed

You can change default normalization speed for inventoried machines from the Custom Fields
dialog box. You can also view normalization speed in server templates. Although you can’t directly
change these values, you can change other values and see how the changes affect the normalization
speed. For more information, see Section 6.3, “Creating and Editing Server Templates,” on

page 116.

To view or edit normalization speed for an inventoried machine:

1 In the Data Center Explorer, right-click a machine and select Properties.
The Properties dialog box for that machine is displayed.
2 Click the Custom Fields tab.
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In the top section you can see the default Normalized Speed for the machine.
3 Click the Normalized Speed value and edit as desired.
To reset the value to its default, click Reset Reference Values.
4 Click OK.
CPU Normalization values can also be used as column values in relevant reports, although the
columns are not shown by default. To display normalization-oriented columns, see Section 5.3,

“Editing Report Templates,” on page 88 and Section 5.4.1, “Creating and Editing Report Views,” on
page 96.

B.7 PlateSpin Recon VM CPU Inventory

When PlateSpin Recon inventories Virtual Machines with one or more CPUs allocated to them, the
cores and CPUs are displayed as follows:

Cores: Regardless of the VM guest machine configuration, PlateSpin Recon shows the actual
number of cores from the hardware host. This may contradict with third-party tools, such as CPUID.

CPUs: On ESX hosts, there are three possible virtual CPU configurations (1,2 and 4) for VMs. The
PlateSpin Recon inventory of the CPUs depends on the VM configuration and the cores on the host
machine. ESX allocates as many cores as needed to accommodate the user requirement. PlateSpin

Recon reports the minimum number of CPUs required to provide the indicated number of virtual
CPUs.

The following table shows some example configurations and what PlateSpin Recon reports for each.

Table B-6 Sample Virtual CPU Configurations and What PlateSpin Recon Reports

Host Cores Guest Virtual CPUs PlateSpin Recon Reported Cores PlateSpin Recon Reported CPUs

1 1 1 1

2 1 2
4 1 4
2 1 2 1
2 2 1
4 2 2
4 1 4 1
2 4 1
4 4 1

B.8 Inventory and Monitoring Commands for
Linux, Solaris and AlIX

This section contains lists of commands used by PlateSpin Recon during inventory and monitoring.

¢ Section B.8.1, “Inventory Commands for Solaris,” on page 181

180 PlateSpin Recon 3.7.1 User Guide



*

Section B.8.2, “Inventory Commands for Linux,” on page 181

*

Section B.8.3, “Inventory Commands for AIX,” on page 182

*

Section B.8.4, “Monitoring Commands for Linux and Solaris,” on page 183

*

Section B.8.5, “Monitoring Commands for AIX,” on page 184

*

Section B.8.6, “Text Processing,” on page 184
B.8.1 Inventory Commands for Solaris

Table B-7 Inventory Commands for Solaris

Command Description
kstat Get network connection speed.
chmod Change file access permissions for the inventory script that is placed on the

machine being inventoried.

rm Remove the inventory script that was placed on the machine.
prtdiag Get CPU cache information and machine model for Sparc.
psrinfo Get processor information such as family, model, step, etc., which are related

to x86 mainly.

isainfo Get CPU instruction set information such as sse, sse2, mmx, etc., which are
related to x86 mainly.

prtconf Get configured device information, which is related to L2 cache information of
x86, network adapter resolving, and ACPI support.

ifconfig Get network related information such as IP address, DHCP, net mask, etc.
ndd Get network connection speed.

uname Determine kernel version.

mount Get boot loader.

pkginfo Get installed programs.

ps Get process information.

who Get run level.

hostname Get host name.

B.8.2 Inventory Commands for Linux

Table B-8 Inventory Commands for Linux

Command Description
chkconfig Get service(daemon) information.
df Get size information for the mounted volumes
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Command

Description

mount
e2label
route

ifconfig

egrep
getcfg
rpm

lspci

iwconfig
iwlist
ethtool
dmesg
kudzu
hwinfo
fdisk
runlevel

hostname

Get volume information.
Get disk label.
Get gateway.

Get network related information such as IP address, net address, and so
on.

Get DHCP information.
Get DHCP for SUSE.
Get installed programs.

Get PCI device information such as vendor name, device model in human
readable format.

Get wireless network adapter NIC list.

Get wireless bit rate.

Get speed and link status for network connection.
Get real MAC address.

Get network device information for Redhat Linux.
Get network adapter information for SUSE Linux.
Determine if a partition is active or not.

Get current run level.

Get host name and DNS domain name.

B.8.3 Inventory Commands for AIX

Table B-9 Inventory Commands for AIX

Command Description

rpm Get a list of installed programs.

ps Get service (daemon) information.

mount Get list of mounted volumes.

df Get size information for mounted volumes.

1slv Get SerialNumber and Label for mounted volumes.
hostname Get hostname.

namerslv Get DNS domain name.

getconf Determine whether a 64-bit kernel.

uname Determine OS release version.
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Command Description

ifconfig Get configured network adapters and their IP address.

netstat Get MAC address.

entstat Get speed of network adapter.

prtconf Get processor information and default gateway.

lspv Get list of disks and their partitions.

bootinfo Get disk size.

lscfg Get disk model, manufacturer and type and network adapter model.

lsitab Get daemon information.

getconf Get machine memory and bootloader information.

lsattr Get machine serial number and model,hyperthreading details and subnet
mask.

B.8.4 Monitoring Commands for Linux and Solaris

Table B-10 Monitoring Commands for Linux and Solaris

Command Platform Description

psrinfo Solaris count processor number.

mpstat Solaris Get processor time per cpu instance.

vmstat Solaris Get processor queue length and memory available.
ifconfig Solaris, Linux Get NIC list.

sed Solaris, Linux Edit input stream.

tail Solaris, Linux Edit input stream.

netstat Solaris Get network package transfer rate.

kstat Solaris Get NIC speed.

prtconf Solaris Get module and instance binding for NIC.
iostat Solaris Get disk io information such as queue and speed.
expr Solaris, Linux evaluate express.
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B.8.5 Monitoring Commands for AIX

Table B-11 AIX Monitoring Commands

Command Description

vmstat Get Available Memory in Bytes

ifconfig Get NIC information

entstat Get Network Packets, Bytes Send/Received
mpstat Get Percentage processor time

iostat Get Disk transfer per second, disk idle, disk byte per second
sar Get Disk Queue length, Percentage processor used
1lspv Get Disk partitioned or Unpartitioned space, disk list
bootinfo Get disk size

df Get the volume level information

oslevel Get the version of AIX

B.8.6 Text Processing

grep, cat, cut, awk, 1ls
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Schedule Options

Certain PlateSpin® Recon jobs can be scheduled to occur at a later date, or on a recurring basis.
These can be viewed through the Scheduled Job Explorer. Jobs can include inventorying, report
generation, and snapshot export.

Following are the schedule options:

¢ Section C.1, “Later,” on page 185

¢ Section C.2, “Recurrence,” on page 185

C.1 Later

The Later scheduling option lets you to run the job at a specific date and time. By default, the current
date and time are displayed.

Select Later to run the job at a specific date and time (either typed manually in mm/dd/yyyy hh:mm
AM|PM format, or selected from the pop-up calendar)

To change the date, do any of the following:

¢ Click the drop-down list, then select the desired date in the calender.
¢ Manually enter the date in the mm/dd/yy format.

To change the time, manually specify the time in the hh:mm AM or PM format.

C.2 Recurrence

Select Recurrence to run the job on a recurring basis.

1 From the drop-down list, select a previously entered recurrence schedule, or select <New
Recurrence>.

The Create Recurrence dialog box is displayed.
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Create Recurrence

— [

Recurrence Mame: |

Recunence pattern

© Daiy (#) Every day(z]
Weekl

© eekly () Every weskday

) Manthly

) early

Range of recurence

Stat 20070315 % | [1211:30 2| @ Nopenddate

() End after: I:I OCCUIMences
Oy [y ]

T o

2 Specify a unique name.

This name is used to refer to the recurrence schedule in the Recurrence drop-down list, so that
it can be reused for other jobs.

3 Inthe Recurrence pattern area, select a rate of recurrence, and use options to specify when, and
how often jobs are run.

186 PlateSpin Recon 3.7.1 User Guide



Quick Reference to PlateSpin
Icons and Commands

This section provides a quick reference to the icons and commands used in PlateSpin® Recon Client.

¢ Section D.1, “Data Center Explorer,” on page 187

¢ Section D.2, “Reports Explorer,” on page 189

¢ Section D.3, “Projects Explorer,” on page 189

+ Section D.4, “Raters Explorer,” on page 190

¢ Section D.5, “Chart Viewer,” on page 191

¢ Section D.6, “Job Explorer,” on page 192

¢ Section D.7, “Scheduled Job Explorer,” on page 192
¢ Section D.§, “Log Explorer,” on page 192

D.1 Data Center Explorer

¢ Section D.1.1, “Data Center Icons,” on page 187
¢ Section D.1.2, “Data Center Icon Status Indicators,” on page 187

¢ Section D.1.3, “Data Center Commands and Associated Icons,” on page 188

D.1.1 Data Center Icons

Table D-1 Data Center Explorer Icons

= Physical Server & Virtual Center Folder
= Virtual Machine = Virtual Center Cluster
= Groups [EE Virtual Center Pool
= Virtual Center @  Primary Site

£l Virtual Center Data Center @ Secondary Site

D.1.2 Data Center Icon Status Indicators

Table D-2 Data Center Explorer Icon Status Indicators

= Monitored @ Virtual Machine Powered On
= Monitored virtual machine Z®  Virtual Machine Powered Off
B= Not monitored O Unresponsive/error

Not inventoried virtual machine A Warning
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D.1.3 Data Center Commands and Associated Icons

Table D-3 Data Center Explorer Commands and Associated Icons

Commands

Submenu

Description

= Inventory

Inventories the selected servers. The
selection must be discovered but not yet
inventoried. To inventory servers that have
already been inventoried, use Refresh
Inventory.

" start Monitoring

Monitors the selected servers. The selection
can be a node (All, Filters, Groups, or Sites)
in the Data Center Explorer pane, or a
particular Filter, Group, or Site to monitor all
child servers.

" Stop Monitoring

Stops monitoring the selected servers. The
selection can be a node (All, Filters, Groups,
or Sites) in the Data Center Explorer pane,
or a particular Filter, Group, or Site to stop
monitoring all child servers.

Logs

View Logs

Acknowledge Logs

View logs of selected servers.

If there are some errors associated with a
machine, an error icon is displayed on that
machine. If the errors are acceptable, you
can use Acknowledge Logs to remove the
error icon from the display of the machine.

E Create Group

Create a new group of servers.

E Copy to Group

<group_name>

Copies the selected servers to the
designated group.

F' Rename Group

Renames the selected group.

[f Create Template

Opens the New Server Template dialog box.

@ Attach Credentials

Opens the Attach Credentials dialog box.

Launch

Terminal Services
SSH
VMware Remote Console

VMware Virtual
Infrastructure Client

VMware Web Access

Opens the selected application (if it is
installed). Paths are configurable by
selecting Options from the Tools menu, then
clicking the Client tab.

@ Delete

Delete the server or group of servers.

Chargeback

Opens the Raters for name dialog box.

View XML

Displays the selected machine details as an
XML document. Only the first machine is
displayed if there are multiple selections.
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Commands Submenu Description

Properties Opens a Properties dialog box for the
selected server.

Set Custom Fields Opens a Properties dialog box (Custom
Fields page) for the selected servers when
multiple servers are selected.

To apply Data Center Explorer commands to servers, right-click a server and select the required
command from the menu.

D.2 Reports Explorer

Table D-4 Report Explorer Commands

Commands Tooltip/Description
3 Create Report Template. Create a new report template based on the report node
selected.

Copy Report Template. Copy a report template.

Il-h:l

Edit Report Template. Edit a report by setting group, views, filters, summaries, and
forecasts for a report template or a report.

Generate Report. Generate a report based on the report template selected.

gl &l

View Report. View an existing (previously generated) report.

Send Report. Send a generated report via e-mail or to an FTP server or network
location.

3 Delete. Delete the selected report or template.

D.3 Projects Explorer

¢ Section D.3.1, “Project Explorer Commands,” on page 189

¢ Section D.3.2, “Project Explorer Icons,” on page 190
D.3.1 Project Explorer Commands

Table D-5 Project Explorer Commands

Command Action

Create a new project.
Copy a project

View project settings

§ & W H

Create a new scenario.
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Command Action

ol Copy a scenario

E View report/View Project report/View Workload Assignment report.
ﬁj Delete project/scenario/workload, depending on the selection made.
8

Implement by using the Portability Suite

Edit Mapping

D.3.2 Project Explorer Icons

Table D-6 Project Explorer Icons

Icon Description

=] Consolidation Project
Consolidation Scenarios
E] Server
Existing Target Servers
il Virtual Machine
[l Workloads
huud Virtualization Overhead
&l Server Template is mapped to a Virtual Server in the database
Server is selected for Consolidation
Unconsolidated Server

A

I

@ Server is selected for Protection
) Server is Unprotected

E

Unconsolidated Workloads

D.4 Raters Explorer

Table D-7 Project Explorer Commands

Command Action
| Create a new rater.
Edit a rater.
£ | Delete a rater.
2] Attach a rater to a machine.
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Command

Action

&

Detach a rater from a machine.

View the properties of a rater.

D.5 Chart Viewer

Table D-8 Chart Viewer Commands

Command

Description

EfRZeE

o
aad
E

-

&,

(& ] =]

K € > 2

S

Print Preview. Preview chart before printing.

Print. Print the chart.

Copy To Clipboard. Copy the chart to the clipboard.

Line. Display straight lines between points of continuous data.
Curve. Display curved lines between points of continuous data.

Candlestick. View the variability of sample data. This button appears only for the candle
chart.

Stacked Bar. View cumulative workload data from multiple servers. This is enabled for
Expression types other than Utilization.

Stacked Area. View cumulative workload data from multiple servers. This is enabled for
Expression types other than Utilization.

Legend Box. Give a visual cue and description for each data object. The legend is very
useful for quickly glancing through the data on a chart.

Point Labels. Display labels for the values in a chart.
Zoom. Switch between normal and magnified view.

Zoom In/Out. Adjust the granularity of the chart for the collected data. See
Section 5.1.3, “Level of Detail,” on page 81.

Navigate Beginning/Back/Forward/End. Scroll the visible data.

Historical Data Settings. Select the historical data time range upon which to base
forecasting.

Forecast Settings. Select the forecasting time period and algorithm.
This button is only enabled for daily or weekly Series charts or for Profile charts.

Refresh All Data From Server. Refresh the view.
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D.6 Job Explorer

Table D-9 Job Explorer Toolbar Commands

Commands Tooltip/Description
i Suspend: Suspends a running job.
ol Resume: Resumes a paused job.
& Abort: Abort the currently running job.
Archive: Archives the selected job.
View Logs: Opens a log viewer for the selected step.

D.7 Scheduled Job Explorer

Table D-10 Scheduled Job Explorer Toolbar Commands

Commands Tooltip/Description
i Pause: Pauses an active or scheduled job.
Resume: Resumes a paused job.

| &l

Edit Recurrence: Opens the Create Recurrence dialog box where you can
create or edit a scheduled job recurrence pattern.

Run Now: Runs the scheduled job immediately.
@ Delete: Deletes the scheduled job.

D.8 Log Explorer

Table D-11 Log Explorer Toolbar Commands

Commands Tooltip/Description
View Details: Opens Log Details for the selected log entry.
@3 Delete: Deletes the selected log entry.

To simultaneously delete multiple logs, select the logs using the Shift or Ctrl keys
and press the Delete key or click Delete.

192 PlateSpin Recon 3.7.1 User Guide



Best Practices

These Best Practices are designed for data center operators and administrators who use PlateSpin®
Recon to monitor workloads and do consolidation planning based on collected data. The information
provided here has been compiled by the PlateSpin support team based on experience with hundreds
of Real-Time Consolidation Accelerator users.

Where applicable, guidelines in Best Practices refer to PlateSpin Support Knowledge Base articles.
To access the articles, use your PlateSpin download credentials. If you have forgotten your
password, you can request a password reminder e-mail at: http://www.platespin.com/downloads/
forgotpassword.aspx (http://www.platespin.com/downloads/forgotpassword.aspx).

¢ Section E.1, “Consolidation Planning Workflow,” on page 193

E.1 Consolidation Planning Workflow

Use this generic consolidation planning workflow:

Table E-1 Best Practices Usage

Guideline Knowledge Base Article

Step 1: Inventory the servers.
Step 2: Monitor the servers and collect data.

Step 3: Analyze the collected data and create
consolidation projects and scenarios by using
PlateSpin Recon charts and the Consolidation
Planning Module.

When you have finished, consolidate the servers by
streaming physical servers into virtual
environments by using PlateSpin PowerConvert.

For early detection of potential inventory and Q20825 (http://support.platespin.com/kb2/
monitoring issues, use PlateSpin Recon PlateSpin  article.aspx?id=20825): Using PlateSpin Analyzer
Analyzer to scan your network before starting the  and understanding its results.

inventory.
If possible, use Microsoft Operations Manager Q20903 (http://support.platespin.com/kb2/
(MOM) 2005 and set up PlateSpin Recon to article.aspx?id=20903): PlateSpin Recon with

connect and collect monitoring data directly from it. MOM 2005
This feature allows you to reduce your project
timeline from weeks to days.
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Documentation Updates

This section contains information on documentation content changes that were made in this User
Guide after the initial release of Novell® PlateSpin® Recon 3.7. The information can help you to
keep current on updates to the documentation.

The documentation is provided on the Web in two formats: HTML and PDF. The HTML and PDF
documentation are both kept up-to-date with the documentation changes listed in this section.

If you need to know whether a copy of the PDF documentation you are using is the most recent, the
PDF document contains its publish date on the front title page.

The documentation was updated on the following date:

¢ Section F.1, “August 31, 2010,” on page 195

¢ Section F.2, “August 06, 2010,” on page 196

¢ Section F.3, “July 16, 2010,” on page 196

¢ Section F.4, “May 11, 2010,” on page 196

¢ Section F.5, “March 15, 2010,” on page 196

¢ Section F.6, “February 05, 2010,” on page 197

¢ Section F.7, “January 08, 2010,” on page 197

¢ Section F.§, “November 30, 2009: 3.7.1,” on page 197

F.1 August 31, 2010

Updates were made to the following sections:

Location Update

Appendix B, “Technical Reference,” on page 165  Added Section B.5.6, “CO2 Emission,” on
page 178.

Documentation Updates 195



F.2 August 06, 2010

Updates were made to the following sections:

Location

Update

“Using PlateSpin Analyzer” on page 75

In Step 4 on page 76, added the following guideline
that also has to be followed for specifying
credentials in a CSV file:

It is mandatory to specify the TRUE or FALSE
value for UNIX and Windows platforms in the CSV
file. However, the value is considered only for the
UNIX platform, and is ignored for the Windows
platform. If you specify the value as TRUE for a
UNIX platform, then the sudo privileges are
assigned to the specified user.

F.3 July 16, 2010

Updates were made to the following sections:

Location

Update

“Supported UNIX/Linux Platforms” on page 15

Added SLES 10 SP2 (10.2) to the Table 1-2,
“Supported UNIX/Linux Platforms,” on page 15.

F.4 May 11, 2010

Updates were made to the following sections:

Location

Update

“Importing the Custom Fields” on page 49

Add the following guideline to be followed while
creating a CSV file:

The custom field label names are case sensitive.

F.5 March 15, 2010

Updates were made to the following sections:

Location

Update

“Supported Microsoft Windows Platforms” on
page 15

“Importing the Custom Fields” on page 49

The supported Windows 2008 (SP0) operating
system has been replaced with Windows 2008
(SP1).

Add a new guideline to be followed while creating a
CSV file.
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F.6 February 05, 2010

Updates were made to the following sections:

Location

Update

“Supported Inventory and Data Collection” on
page 15

Consolidated all the supported hypervisors in a
separate section, “Supported Hypervisors” on

page 16.
F.7 January 08, 2010
Updates were made to the following sections:
Location Update

“Supported UNIX/Linux Platforms” on page 15

Added XEN on SLES 10 to the Table 1-2,
“Supported UNIX/Linux Platforms,” on page 15.

F.8 November 30, 2009: 3.7.1

Updates were made to the following sections:

Location

Update

Section 5.2.1, “Report Explorer Template Nodes,”
on page 83

Section B.4.2, “Utilization,” on page 172

Section B.4.3, “Workload,” on page 174

The following new reports have been newly added:

* Volume Utilization - Average
+ Volume Utilization - Peak
+ Disk Allocation
Table B-2 on page 173 has been updated with new

formulas related to the reports newly added in
PlateSpin Recon 3.7.1.

Table B-3 on page 174 has been updated with new
formulas related to the reports newly added in
PlateSpin Recon 3.7.1.
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